
HP ProBook 6545b Notebook PC,
HP ProBook 6540b Notebook PC,
HP ProBook 6445b Notebook PC, and
HP ProBook 6440b Notebook PC
Maintenance and Service Guide

Document Part Number: 570786-003

October 2011

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides 
comprehensive information on identifying computer features, components, and spare parts; troubleshooting 
computer problems; and performing computer disassembly procedures.





© Copyright 2011 Hewlett-Packard Development Company, L.P.

AMD Athlon, AMD Sempron, and AMD Turion are trademarks of Advanced Micro Devices, Inc. Bluetooth is a trademark owned by its 
proprietor and used by Hewlett-Packard Company under license. Intel and Core are U.S. registered trademarks of Intel Corporation. 
Java is a U.S. trademark of Sun Microsystems, Inc. Microsoft, Windows, and Windows Vista are U.S. registered trademarks of 
Microsoft Corporation. SD Logo is a trademark of its proprietor.

The information contained herein is subject to change without notice. The only warranties for HP products and services are set forth in 
the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an 
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

Third Edition: October 2011
Document Part Number: 570786-003



Safety warning notice

Å
WARNING: To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly 
on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, 
such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow 
the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the 
AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1
Product description

Category Description
HP ProBook 6545b 

Notebook PC
HP ProBook 6540b 

Notebook PC
HP ProBook 6445b 

Notebook PC
HP ProBook 6440b 

Notebook PC

Processors ■ AMD® Turion™ II Ultra M620 
2.5-GHz processor (35W, 2-MB L2 
cache)

■ AMD Turion II Ultra M600 2.3-GHz 
processor (35W, 2-MB L2 cache)

■ AMD Turion II M540 2.4-GHz 
processor (35W, 1-MB L2 cache)

■ AMD Turion II M520 2.2-GHz 
processor (35W, 1-MB L2 cache)

■ AMD Athlon™ II M340 2.2-GHz 
processor (35W, 1-MB L2 cache) 

■ AMD Athlon II M320 2.1-GHz 
processor (35W, 1-MB L2 cache) 

■ AMD Sempron™ M120 2.1-GHz 
processor (25W, 512-KB L2 cache) 

■ AMD Sempron M100 1.9-GHz 
processor (25W, 512-KB L2 cache) 

■ Intel Core i7 720QM 1.60-GHz 
processor (turbo up to 2.80-GHz; 
6-MB L3 cache, 8 threads, 45W)

■ Intel Core i7 620M 2.66-GHz 
processor (turbo up to 3.33-GHz; 
4-MB L3 cache, 4 threads, 35 W)

■ Intel Core i5 540M 2.53-GHz 
processor (turbo up to 3.06-GHz; 
3-MB L3 cache, 4 threads, 35W)

■ Intel Core i5 520M 2.40-GHz 
processor (turbo up to 2.93-GHz; 
3-MB L3 cache, 4 threads, 35W)

■ Intel Core i5 430M 2.26-GHz 
processor (turbo up to 2.53-GHz; 
3-MB L3 cache, 4 threads, 35W)

■ Intel Core i3 350M 2.26-GHz 
processor (turbo up to 2.40-GHz; 
3-MB L3 cache, 4 threads, 35W)

■ Intel Core i3 330M 2.13-GHz 
processor (turbo up to 2.33-GHz; 
3-MB L3 cache, 4 threads, 35W)

Chipset Northbridge: AMD RS880M

Southbridge: AMD SB710

Intel Ibex Peak HM57 storage

(Continued)
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Product description
Graphics ATI Mobility Radeon™ HD 4200 
Universal Memory Architecture (UMA) 
graphics

ATI Mobility Radeon HD 4550 discrete 
graphics

Intel Graphics Media Accelerator HD 
UMA graphics

Supports dual-display ports through 
docking station

Panel ■ Supports HP Privacy Filter

■ Supports 16×9 aspect ratio 
display panels

■ 15.6-in, high-definition+ (HD+), 
light-emitting diode (LED), 
WVA (1600×900) with webcam and 
2 WWAN antennas

■ 15.6-in, HD+, LED, WVA 
(1600×900) with 
2 WWAN antennas

■ 15.6-in, HD, LED, WVA (1600×900) 
with webcam and 2 WWAN 
antennas

■ 15.6-in, HD, LED, WVA (1600×900) 
with 2 WWAN antennas

■ 15.6-in, HD+, LED, AntiGlare 
(1366×768) with webcam

■ 15.6-in, HD+, LED, AntiGlare 
(1366×768)

■ 15.6-in, HD, LED, AntiGlare 
(1366×768) with webcam

■ 15.6-in, HD, LED, AntiGlare 
(1366×768)

■ 14.0-in, HD, LED, AntiGlare 
(1366×768) with webcam and 2 
WWAN antennas

■ 14.0-in, HD, LED, AntiGlare 
(1366×768) with webcam

■ 14.0-in, HD, LED, AntiGlare 
(1366×768) with 
2 WWAN antennas

■ 14.0-in, HD, LED, AntiGlare 
(1366×768) with webcam

■ 14.0-in, HD+, LED, SVA, AntiGlare 
(1600×900) with webcam

■ 14.0-in, HD+, LED, SVA, AntiGlare 
(1600×900) with webcam

■ 14.0-in, HD+, LED, SVA, AntiGlare 
(1600×900) with webcam

■ 14.0-in, HD+, LED, SVA, AntiGlare 
(1600×900) with webcam

(Continued)

Category Description
HP ProBook 6545b 

Notebook PC
HP ProBook 6540b 

Notebook PC
HP ProBook 6445b 

Notebook PC
HP ProBook 6440b 

Notebook PC
1–2 Maintenance and Service Guide



Product description
Memory 2 customer-accessible/
upgradable memory module slots (both 
slots are customer-accessible)

Supports the following DDR2, 
PC2-6400 configurations at 800-MHz 
in all supported countries and regions:
■ 8192-MB total system memory 

(4096 × 2)
■ 4096-MB total system memory 

(4096 × 1) 
■ 4096-MB total system memory 

(2048 × 2)
■ 3072-MB total system memory 

(2048 + 1024)
■ 2048-MB total system memory 

(2048 x 1) 
■ 2048-MB total system memory 

(1024 × 2)
■ 1024-MB total system memory 

(1024 × 1)

Mass storage 
devices

Supports 9.50-mm, 6.35-cm (2.50-in) 
hard drives and solid-state drives

Customer-accessible

Supports HP 3D DriveGuard

Supports the following hard drives:
■ 500-GB, 7200-rpm
■ 320-GB, 7200-rpm
■ 250-GB, 7200-rpm
■ 160-GB, 7200-rpm

■ Supports 128-GB solid-state drive

■ Supports 128-GB solid-state drive

Optical drives Single screw removal

Customer-accessible

Supports 12.7-mm, optical drives

Supports no drive option in optical 
drive bay with slot bezel

Supports the following optical drives:
■ Blu-ray ROM with LightScribe 

DVD±RW SuperMulti 
Double-Layer Drive 

■ DVD±RW and CD-RW SuperMulti 
Double-Layer Drive

■ DVD-ROM Drive

Supports a 500-GB, 7200-rpm hard 
drive with cradle

Microphone Integrated dual-array digital 
microphone only on computer models 
equipped with a webcam

Integrated mono digital microphone 
only on computer models not equipped 
with a webcam

Audio IDT 92HD75B high-definition audio

Stereo speakers (2)

(Continued)

Category Description
HP ProBook 6545b 

Notebook PC
HP ProBook 6540b 

Notebook PC
HP ProBook 6445b 

Notebook PC
HP ProBook 6440b 

Notebook PC
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Product description
Webcam Integrated 2-megapixel camera with 
macro focus

Modem 56k v.92 MDC data/fax modem

Modem cable not included

Ethernet Marvell 88E8072 10/100/1000 network 
interface card (NIC)

NIC Power Down technology

S3/S4/S5 wake on LAN (AC mode 
only)

Ethernet cable not included

Wireless Integrated wireless local-area network 
(WLAN) options via half MiniCard:

■ 2 WLAN antennas built into the 
display assembly

■ Broadcom 43224 802.11 a/g/n
■ Broadcom 4312G 802.11 b/g

■ Intel Centrino 
Advanced-N 6200 AGN

■ Intel Wi-Fi Link 1000, 802.11b/g/n

■ Supports no-WLAN option

Integrated wireless wide-area network 
(WWAN) options via Mini PCI module:

■ High-speed packet access (HSPA), 
evolution-data optimized (EV-DO) 
WWAN module

■ WWAN security provided by 
subscriber identity module (SIM), 
user-accessible behind battery

■ 2 WWAN antennas (worldwide, 
5-band) built into the 
display assembly

Integrated wireless personal-area 
network (WPAN) options via 
Bluetooth® module

External media 
cards

ExpressCard/54 slot

Media Card Reader supporting the 
following optional digital card formats:
■ Memory Stick
■ Memory Stick Pro
■ Memory Stick Duo 

(adapter required)
■ Memory Stick Duo Pro (adapter 

required)
■ MultiMediaCard
■ MultiMediaCard Plus
■ Secure Digital (SD) Memory Card
■ Secure Digital (SD) High Capacity 

Memory Card
■ micro Secure Digital (SD) Memory 

Card (adapter required)
■ xD-Picture Card

(Continued)
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Product description
Docking Docking supported through the HP 
Advanced 230W Docking Station, 
HP Advanced 120W Docking Station,
HP 230W Docking Station,
and HP 90W Docking Station

Ports 1394a

Accessory battery connector

DisplayPort (Dsub 15-pin) supporting 
1600 × 1200 external resolution at 75 
Hz

Docking connector

Multi-pin AC power

RJ-11 (modem)

RJ-45 (Ethernet, includes link and 
activity lights)

Serial

Stereo headphone

Stereo microphone

USB v. 2.0

Keyboard/
pointing devices

Full-sized keyboard with 
spill-resistant design and drains

Supports dual-point (pointing stick and 
TouchPad) and TouchPad-only 
configurations

Numeric keypad

Supports 2-way scroll with legend

Taps enabled as default

Power 
requirements

90-W PFC HP Smart Adapter

Supports multi-pin AC connector and 
3-wire plug (with ground pin)

Supports 9-cell Lithium Ion (Li Ion) 
battery (93 WH) and 6-cell Li Ion 
battery (55 WH)

Supports 8-cell Extended Life Battery

Supports 12-cell Ultra Capacity Battery

Supports HP Fast Charge Technology

Security Security cable slot

Trusted platform module (TPM) 1.2 
and TPM enhanced drive lock

Optional HP fingerprint reader

Optional active integrated Smart Card 
Reader (SCM)

Full volume encryption

Preboot authentication (password and 
smart card)

(Continued)
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Product description
Operating 
system

Preinstalled without Microsoft® 
Office:
■ Windows® 7 Home Premium 64
■ Windows 7 Home Premium 32
■ Windows 7 Pro 64
■ Windows 7 Pro 32
■ Windows Vista® Business 32
■ Windows Vista Home Basic 32
■ Windows XP Pro 32 with Windows 

7 Pro downgrade
■ Free DOS

Preinstalled with Microsoft Office:
■ Windows 7 Home Basic 32
■ Windows 7 Home Premium 64
■ Windows 7 Home Premium 32
■ Windows 7 Pro 64
■ Windows 7 Pro 32
■ Windows Vista Home Basic 32
■ Windows Vista Business 32
■ Windows XP Pro 32 with Windows 

7 Pro downgrade

Restore Media (OSDVD):
■ Windows 7 Home Basic 32
■ Windows 7 Home Premium 64
■ Windows 7 Home Premium 32
■ Windows 7 Pro 64
■ Windows 7 Pro 32
■ Windows Vista Business 32
■ Windows Vista Home Basic 32
■ Windows XP Pro 32 with Windows 

7 Pro license

Restore media (DRDVD):
■ Windows 7 DRDVD with Windows 

DVD
■ Windows 7 DRDVD without 

Windows DVD
■ Windows Vista DRDVD
■ Windows XP DRDVD

Office restore media: Microsoft Office 
ready restore DVD

Certified:
■ SuSE Linux
■ Microsoft Logo (Windows 7 and 

Windows Vista Premium)

Web-only support:
■ Windows 7 Enterprise 64
■ Windows 7 Enterprise 32
■ Windows 7 Ultimate 64
■ Windows 7 Ultimate 32
■ Windows Vista Enterprise 32
■ Windows Vista Enterprise 64

(Continued)
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Product description
Serviceability End-user replaceable parts:

AC adapter

Battery (system)

Bluetooth module

Hard drive

Memory module

Optical drive

SIM

Solid-state drive

WLAN module

WWAN module

Category Description
HP ProBook 6545b 

Notebook PC
HP ProBook 6540b 

Notebook PC
HP ProBook 6445b 

Notebook PC
HP ProBook 6440b 

Notebook PC
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2
External component identification

Identifying hardware

Components included with the computer may vary by region and model. The illustrations in this chapter identify 
the standard features on most computer models.

To see a list of hardware installed in the computer, follow these steps:

For Windows 7 and Windows Vista:

1. Select Start > Computer > System Properties.

2. In the left pane, click Device Manager.

You can also add hardware or modify device configurations using Device Manager.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing applications, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

For Windows XP:

1. Select Start > My Computer.

2. In the left pane of the System Tasks window, click View system information.

3. Select Hardware tab > Device Manager.

You can also add hardware or modify device configurations using Device Manager.
Maintenance and Service Guide 2–1



External component identification
Top components

Display components

✎ Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) WWAN antennas (2)* Send and receive wireless signals to communicate with wireless wide-area 
networks (WWAN).

(2) Internal microphones (1 or 2, varying 
by computer model)†

Record sound.

✎ If there is a microphone icon next to each microphone opening, 
your computer has internal microphones.

(3) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless local area 
networks (WLAN).

(4) Webcam light (select models only) On: The webcam is in use.

(5) Webcam (select models only) Records audio and video and captures still photographs.

(6) Internal display switch Turns off the display or initiates the Sleep state (Windows 7 and 
Windows Vista) or Standby (Windows XP) if the display is closed while the 
power is on.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around 
the antennas free from obstructions.

†Only computers equipped with a webcam are equipped with 2 microphones. Computers not equipped with a webcam are 
equipped with only one microphone.
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External component identification
Keys

✎ Refer to the illustration that most closely matches your computer.

Item Component Description

(1) esc key Displays system information when pressed in combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in combination with 
a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in combination with 
the fn key.
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External component identification
Item Component Description

(1) esc key Displays system information when pressed in combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in combination with 
a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in combination with 
the fn key.
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External component identification
Pointing devices

Item Component Description

(1) Pointing stick (select models only)* Moves the pointer and selects or activates items on the screen.

(2) Left pointing stick button (select 
models only)*

Functions like the left button on an external mouse.

(3) TouchPad* Moves the pointer and selects or activates items on the screen.

(4) Left TouchPad button* Functions like the left button on an external mouse.

(5) Right pointing stick button* Functions like the right button on an external mouse.

(6) TouchPad scroll zone Scrolls up or down.

(7) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

■ In Windows 7 and Windows Vista: Select Start > Control Panel > Hardware and Sound > Mouse.

■ In Windows XP: Select Start > Control Panel > Printers and Other Hardware > Mouse.
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External component identification
Buttons and fingerprint reader

✎ Refer to the illustration that most closely matches your computer.

Item Component Description

(1) Power button ■ When the computer is off, press the button to turn on the computer.

■ When the computer is on, press the button to shut down the computer.

■ When the computer is in the Sleep state (Windows 7 and Windows Vista) 
or Standby (Windows XP), press the button briefly to exit Sleep or Standby.

■ When the computer is in Hibernation, press the button briefly to 
exit Hibernation.

If the computer has stopped responding and Windows shutdown procedures 
are ineffective, press and hold the power button for at least 5 seconds to turn 
off the computer.
To learn more about your power settings, select one of the following:

■ In Windows 7 and Windows Vista: select Start > Control Panel > System 
and Maintenance > Power Options.

■ In Windows XP: select Start > Control Panel > Performance and 
Maintenance > Power Options.

(2) QuickLook button ■ When the computer is off, press the button to open HP QuickLook.

■ When the computer is on, press the button to open Software Setup.

✎ If Software Setup is not available, the default Web browser opens.

(3) QuickWeb button ■ When the computer is off, press the button to open HP QuickWeb.

■ When the computer is on, press the button to open the default 
Web browser.

(4) Wireless button Turns the wireless feature on or off but does not establish a 
wireless connection.

(5) Volume mute button Mutes and restores speaker sound.

(Continued)
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External component identification
Buttons and fingerprint reader (continued)

(6) Volume down button Decreases computer volume.

(7) Volume up button Increases computer volume.

(8) Calculator button (select models only) Opens the Windows calculator feature.

(9) Fingerprint reader Allows a fingerprint logon to Windows, instead of a password logon.

Item Component Description

Item Component Description

(1) Power button ■ When the computer is off, press the button to turn on the computer.

■ When the computer is on, press the button to shut down the computer.

■ When the computer is in the Sleep state (Windows 7 and Windows Vista) 
or Standby (Windows XP), press the button briefly to exit Sleep or Standby.

■ When the computer is in Hibernation, press the button briefly to 
exit Hibernation.

If the computer has stopped responding and Windows shutdown procedures 
are ineffective, press and hold the power button for at least 5 seconds to turn 
off the computer.
To learn more about your power settings, select one of the following:

■ In Windows 7 and Windows Vista: Select Start > Control Panel > System 
and Maintenance > Power Options.

■ In Windows XP: Select Start > Control Panel > Performance and 
Maintenance > Power Options.

(2) QuickLook button ■ When the computer is off, press the button to open HP QuickLook.

■ When the computer is on, press the button to open Software Setup.

✎ If Software Setup is not available, the default Web browser opens.

(Continued)
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External component identification
Lights

✎ Refer to the illustration that most closely matches your computer.

Buttons and fingerprint reader (continued)

(3) QuickWeb button ■ When the computer is off, press the button to open HP QuickWeb.

■ When the computer is on, press the button to open the default 
Web browser.

(4) Wireless button Turns the wireless feature on or off but does not establish a 
wireless connection.

(5) Volume mute button Mutes and restores speaker sound.

(6) Volume down button Decreases computer volume.

(7) Volume up button Increases computer volume.

(8) Fingerprint reader Allows a fingerprint logon to Windows, instead of a password logon.

Item Component Description

Item Component Description

(1) Wireless lights (2)* ■ Blue: An integrated wireless device, such as a WLAN device, 
the HP Mobile Broadband Module (select models only), and/or a Bluetooth 
device, is on.

■ Amber: All wireless devices are off.

(2) Power lights (2)† ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state (Windows 7 and Windows 
Vista) or Standby (Windows XP).

■ Off: The computer is off or in Hibernation.

(Continued)
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External component identification
Lights (continued)

(3) Battery light ■ Amber: A battery is charging.

■ Turquoise: A battery is close to full charge capacity.

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly.

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level.

(4) Drive light ■ Blinking turquoise: The hard drive or optical drive (select models only) is 
being accessed.

■ Amber: HP 3D DriveGuard has temporarily parked the hard drive.

(5) QuickLook light ■ On: The computer is on.

■ Off: The computer is off or in the Sleep state (Windows 7 and 
Windows Vista) or Standby (Windows XP) or Hibernation.

(6) QuickWeb light On: The Web browser is in use.

(7) Caps lock light On: Caps lock is on.

(8) Num lock light On: Num lock is on or the embedded numeric keypad is enabled.

(9) Volume mute light ■ Turquoise: Speaker sound is on.

■ Amber: Speaker sound is off.

(10) Volume down light Blinking: The volume down button is being used to decrease the 
speaker volume.

(11) Volume up light Blinking: The volume up button is being used to increase the speaker volume.

(12) Calculator light On: The Windows calculator function is on.

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open. 
The wireless light on the front of the computer is visible whether the computer is open or closed.
†The 2 power lights display the same information. The light on the power button is visible only when the computer is open. 
The power light on the front of the computer is visible whether the computer is open or closed.

Item Component Description
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External component identification
Item Component Description

(1) Wireless lights (2)* ■ Blue: An integrated wireless device, such as a WLAN device, 
the HP Mobile Broadband Module (select models only), and/or a Bluetooth 
device, is on.

■ Amber: All wireless devices are off.

(2) Power lights (2)† ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state (Windows 7 and Windows 
Vista) or Standby (Windows XP).

■ Off: The computer is off or in Hibernation.

(Continued)
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External component identification
Lights (continued)

(3) Battery light ■ Amber: A battery is charging.

■ Turquoise: A battery is close to full charge capacity.

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly.

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level.

(4) Drive light ■ Blinking turquoise: The hard drive or optical drive (select models only) is 
being accessed.

■ Amber: HP 3D DriveGuard has temporarily parked the hard drive.

(5) QuickLook light ■ On: The computer is on.

■ Off: The computer is off or in the Sleep state (Windows 7 and 
Windows Vista) or Standby (Windows XP) or Hibernation.

(6) QuickWeb light On: The Web browser is in use.

(7) Caps lock light On: Caps lock is on.

(8) Num lock light On: Num lock is on or the embedded numeric keypad is enabled.

(9) Volume mute light ■ Turquoise: Speaker sound is on.

■ Amber: Speaker sound is off.

(10) Volume down light Blinking: The volume down button is being used to decrease the 
speaker volume.

(11) Volume up light Blinking: The volume up button is being used to increase the speaker volume.

*The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is open. 
The wireless light on the front of the computer is visible whether the computer is open or closed.
†The 2 power lights display the same information. The light on the power button is visible only when the computer is open. 
The power light on the front of the computer is visible whether the computer is open or closed.

Item Component Description
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External component identification
Front components

Item Component Description

(1) Wireless light ■ Blue: An integrated wireless device, such as a wireless local area network 
(WLAN) device, the HP Mobile Broadband Module (select models only), 
and/or a Bluetooth device, is on.

■ Amber: All wireless devices are off.

(2) Power light ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state (Windows 7 and 
Windows Vista) or Standby (Windows XP).

■ Off: The computer is off or in Hibernation.

(3) Battery light ■ Amber: A battery is charging.

■ Turquoise: A battery is close to full charge capacity.

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly.

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level.

(4) Drive light ■ Blinking turquoise: The hard drive or optical drive (select models only) is 
being accessed.

■ Amber: HP 3D DriveGuard has temporarily parked the hard drive.

(5) Webcam light (select models only) On: The webcam is in use.

(6) Display release latch Opens the computer.

(7) Speakers (2) Produce sound.
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External component identification
Right-side components

✎ Refer to the illustration that most closely matches your computer.

Item Component Description

(1) Media Card Reader Supports the following optional digital card formats:

■ Memory Stick

■ Memory Stick Pro

■ Memory Stick Duo (adapter required)

■ Memory Stick Duo Pro (adapter required)

■ MultiMediaCard

■ MultiMediaCard Plus

■ Secure Digital (SD) Memory Card

■ Secure Digital (SD) High Capacity Memory Card

■ micro Secure Digital (SD) Memory Card (adapter required)

■ xD-Picture Card

(2) Upgrade bay Supports an optical drive or a hard drive.

(3) USB port Connects an optional USB device.

(4) 1394 port Connects an optional IEEE 1394 or 1394a device, such as a camcorder.

(5) Serial port Connects an optional device such as a serial modem, mouse, or printer.
Maintenance and Service Guide 2–13



External component identification
Item Component Description

(1) Media Card Reader Supports the following optional digital card formats:

■ Memory Stick

■ Memory Stick Pro

■ Memory Stick Duo (adapter required)

■ Memory Stick Duo Pro (adapter required)

■ MultiMediaCard

■ MultiMediaCard Plus

■ Secure Digital (SD) Memory Card

■ Secure Digital (SD) High Capacity Memory Card

■ micro Secure Digital (SD) Memory Card (adapter required)

■ xD-Picture Card

(2) Upgrade bay Supports an optical drive or a hard drive.

(3) USB port Connects an optional USB device.

(4) 1394 port Connects an optional IEEE 1394 or 1394a device, such as a camcorder.

(5) RJ-11 (modem) jack Connects a modem cable.

(6) Security cable slot Attaches an optional security cable to the computer.

✎ The security cable is designed to act as a deterrent, but it may not 
prevent the computer from being mishandled or stolen.
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External component identification
Left-side components

✎ Refer to the illustration that most closely matches your computer.

Item Component Description

(1) Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(2) DisplayPort Connects an optional digital display device such as a high-performance 
monitor or projector.

(3) USB ports (3) Connect optional USB devices.

(4) ExpressCard slot Supports optional ExpressCards.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array 
microphone, or monaural microphone.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered stereo speakers, 
headphones, ear buds, a headset, or television audio.

✎ When a device is connected to the headphone jack, the computer 
speakers are disabled.
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External component identification
Item Component Description

(1) Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(2) DisplayPort Connects an optional digital display device such as a high-performance 
monitor or projector.

(3) USB ports (3) Connect optional USB devices.

(4) Smart Card Reader 
(select models only)

Supports optional smart cards and Java™ Cards.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array 
microphone, or monaural microphone.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered stereo speakers, 
headphones, ear buds, a headset, or television audio.

✎ When a device is connected to the headphone jack, the computer 
speakers are disabled.
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External component identification
Rear components

✎ Refer to the illustration that most closely matches your computer.

Item Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

✎ The security cable is designed to act as a deterrent, but it may not 
prevent the computer from being mishandled or stolen.

(2) RJ-11 (modem) jack Connects a modem cable.

(3) RJ-45 (network) jack Connects a network cable.

(4) External monitor port Connects an external VGA monitor or projector.

(5) Power connector Connects an AC adapter.

Item Component Description

(1) RJ-45 (network) jack Connects a network cable.

(2) External monitor port Connects an external VGA monitor or projector.

(3) Power connector Connects an AC adapter.
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External component identification
Bottom components

Item Component Description

(1) Battery bay Holds the battery.

(2) SIM slot Contains a wireless subscriber identity module (SIM) (select models only). 
The SIM slot is located inside the battery bay.

(3) Battery release latch Releases the battery from the battery bay.

(4) Docking connector Connects an optional docking device.

(5) Accessory battery connector Connects an optional accessory battery.

(6) Vents (6) Enable airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(7) Hard drive bay Holds the hard drive.

(8) Memory module compartment Contains an expansion memory module slot.

(9) HP Mobile Broadband Module 
compartment

Contains an HP Mobile Broadband Module (select models only).

✎ To prevent an unresponsive system, replace the wireless module only 
with a wireless module authorized for use in the computer by the 
governmental agency that regulates wireless devices in your country or 
region. If you replace the module and then receive a warning message, 
remove the module to restore computer functionality, and then contact 
technical support through Help and Support.

(10) Bluetooth compartment Contains a Bluetooth device.
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Illustrated parts catalog

Service tag

When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n) This number provides specific information about the product’s 
hardware components. The part number helps a service 
technician determine what components and parts are needed.

(4) Model description This is the alphanumeric identifier used to locate documents, 
drivers, and support for the computer.

(5) Warranty period This number describes the duration of the warranty period for 
the computer.
Maintenance and Service Guide 3–1



Illustrated parts catalog
Computer major components
3–2 Maintenance and Service Guide



Illustrated parts catalog
Item Description Spare part number

(1) Display assembly (includes 3 WLAN antenna transceivers and cables, microphones, nameplate, and logo):

For use only with HP Compaq 6545b computer models:

■ 15.6-in, HD+, LED, WVA display assembly for use only with computer models equipped 
with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)

584230-001

■ 15.6-in, HD+, LED, WVA display assembly for use only with computer models equipped 
with WWAN functionality but not equipped with a webcam (includes 2 WWAN antenna 
transceivers and cables)

584229-001

■ 15.6-in, HD+, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam

583225-001

■ 15.6-in, HD+, LED, AntiGlare display assembly for use only with computer models not 
equipped with a webcam

583222-001

■ 15.6-in, HD, LED, WVA display assembly for use only with computer models equipped 
with a webcam (includes 2 WWAN antenna transceivers and cables)

584228-001

■ 15.6-in, HD, LED, WVA display assembly for use only with computer models not equipped 
with a webcam (includes 2 WWAN antenna transceivers and cables)

584227-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam

583223-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models not 
equipped with a webcam

583220-001

For use only with HP Compaq 6540b computer models:

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna 
transceivers and cables)

594005-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594004-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

593996-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models not 
equipped with a webcam or with WWAN functionality

593995-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
not equipped with a webcam or with WWAN functionality

593999-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594002-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

594003-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna 
transceivers and cables)

594006-001

■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna 
transceivers and cables)

594001-001

(Continued)
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Illustrated parts catalog
(1) Display assembly (continued):

For use only with HP Compaq 6540b computer models (continued):

■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594000-001

■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

593998-001

■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models not 
equipped with a webcam or with WWAN functionality

593997-001

■ 15.6-in, HD, LED, LVDS BrightView display assembly 623182-001

■ 15.6-in, HD, LED, SVA, LVDS AntiGlare display assembly 623181-001

■ 15.6-in, HD+, LED, WVA, LVDS AntiGlare display assembly 624643-001

For use only with HP Compaq 6445b computer models:

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam (includes 2 WWAN antenna transceivers and cables)

584232-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models not 
equipped with a webcam (includes 2 WWAN antenna transceivers and cables)

584231-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam

583228-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models not 
equipped with a webcam

583226-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
not equipped with a webcam

600753-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam

600754-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
with WWAN functionality but not a webcam

617448-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality

617449-001

For use only with HP Compaq 6440b computer models:

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna 
transceivers and cables)

594018-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594014-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

594015-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
not equipped with a webcam or with WWAN functionality

594011-001

(Continued)

Item Description Spare part number
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Illustrated parts catalog
(1) Display assembly (continued):

For use only with HP Compaq 6440b computer models (continued):

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna 
transceivers and cables)

594017-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594016-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

594008-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models not 
equipped with a webcam or with WWAN functionality

594007-001

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna 
transceivers and cables)

594013-001

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594012-001

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

594010-001

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models not 
equipped with a webcam or with WWAN functionality

594009-001

■ 14.0-in, HD, LED, SVA, LVDS BrightView display assembly 592144-001

■ 14.0-in, HD, LED, SVA, LVDS AntiGlare display assembly for use only with HP Compaq 
6440b computer models

623176-001

■ 14.0-in, HD, LED, SVA, LVDS AntiGlare display assembly 624236-001

✎ See “Display assembly subcomponents” on page 3-19 for display assembly internal component spare 
part information.

(2) Switch cover (includes capacitive board and cable):

For use only with HP Compaq 6545b computer models 583268-001

For use only with HP Compaq 6540b computer models 593860-001

For use only with HP Compaq 6445b computer models 583268-001

For use only with HP Compaq 6440b computer models 593861-001

(3) Power button board (includes cable)

For use only with HP Compaq 6545b computer models 583268-001

For use only with HP Compaq 6445b computer models 583267-001

For use only with HP Compaq 6540b and 6440b computer models 593838-001

(4) Keyboard (includes keyboard cable):

For use only with HP Compaq 6545b and 6540b computer models equipped with a pointing stick:

■ For use in Belgium 584234-A41

■ For use in Brazil 584234-201

■ For use in Bulgaria 584234-261

(Continued)

Item Description Spare part number
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Illustrated parts catalog
(4) Keyboard (continued):

For use only with HP Compaq 6545b and 6540b computer models equipped with a pointing stick:

■ For use in Denmark 584234-081

■ For use in the Czech Republic and Slovakia 584234-A81

■ For use in France 584234-051

■ For use in French Canada 584234-121

■ For use in Germany 584234-041

■ For use in Greece 584234-DJ1

■ For use in Hungary 584234-211

■ For use in Iceland 584234-DD1

■ For use in Israel 584234-BB1

■ For use in Italy 584234-061

■ For use in Latin America 584234-161

■ For use in the Netherlands 584234-B31

■ For use in Norway 584234-091

■ For use in Portugal 584234-131

■ For use in Russia 584234-251

■ For use in Saudi Arabia 584234-171

■ For use in Slovenia 584234-BA1

■ For use in Spain 584234-071

■ For use in Sweden and Finland 584234-B71

■ For use in Switzerland 584234-BG1

■ For use in Turkey 584234-141

■ For use in the United Kingdom 584234-031

■ For use in the United States 584234-001

For use only with HP Compaq 6540b computer models equipped with a pointing stick:

■ For use in Japan 584234-291

■ For use in Slovakia 584234-A81

■ For use in South Korea 584234-AD1

■ For use in Thailand 584234-AB1

■ For use in the Czech Republic and Slovakia 584234-281

For use only with HP Compaq 6545b computer models not equipped with a pointing stick:

■ For use in Belgium 583293-A41

■ For use in Brazil 583293-201

■ For use in Bulgaria 583293-261

■ For use in Denmark 583293-081

■ For use in the Czech Republic and Slovakia 583293-A81

■ For use in France 583293-051

(Continued)
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Illustrated parts catalog
(4) Keyboard (continued):

For use only with HP Compaq 6545b computer models not equipped with a pointing stick:

■ For use in French Canada 583293-121

■ For use in Germany 583293-041

■ For use in Greece 583293-DJ1

■ For use in Hungary 583293-211

■ For use in Iceland 583293-DD1

■ For use in Israel 583293-BB1

■ For use in Italy 583293-061

■ For use in Latin America 583293-161

■ For use in the Netherlands 583293-B31

■ For use in Norway 583293-091

■ For use in Portugal 583293-131

■ For use in Russia 583293-251

■ For use in Saudi Arabia 583293-171

■ For use in Slovenia 583293-BA1

■ For use in Spain 583293-071

■ For use in Sweden and Finland 583293-B71

■ For use in Switzerland 583293-BG1

■ For use in Turkey 583293-141

■ For use in the United Kingdom 583293-031

■ For use in the United States 583293-001

For use only with HP Compaq 6540b computer models equipped with a pointing stick:

■ For use in Japan 583293-291

■ For use in Slovakia 583293-A81

■ For use in South Korea 583293-AD1

■ For use in Thailand 583293-AB1

■ For use in the Czech Republic and Slovakia 583293-281

For use only with HP Compaq 6445b and 6440b computer models equipped with a pointing stick:

■ For use in Brazil 584233-201

■ For use in French Canada 584233-121

■ For use in Latin America 584233-161

■ For use in the United States 584233-001

For use only with HP Compaq 6440b computer models equipped with a pointing stick:

■ For use in Belgium 584233-A41

■ For use in Bulgaria 584233-261

■ For use in Denmark 584233-081

■ For use in France 584233-051

(Continued)
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Illustrated parts catalog
(4) Keyboard (continued):

For use only with HP Compaq 6440b computer models equipped with a pointing stick:

■ For use in Germany 584233-041

■ For use in Greece 584233-DJ1

■ For use in Hungary 584233-211

■ For use in Iceland 584233-DD1

■ For use in Israel 584233-BB1

■ For use in Italy 584233-061

■ For use in Japan 584233-291

■ For use in the Netherlands 584233-B31

■ For use in Norway 584233-091

■ For use in Portugal 584233-131

■ For use in Russia 584233-251

■ For use in Saudi Arabia 584233-171

■ For use in Slovakia 584233-221

■ For use in Slovenia 584233-BA1

■ For use in South Korea 584233-AD1

■ For use in Spain 584233-071

■ For use in Sweden and Finland 584233-B71

■ For use in Switzerland 584233-BG1

■ For use in Taiwan 584233-AB1

■ For use in Thailand 584233-281

■ For use in Turkey 584233-141

■ For use in the United Kingdom 584233-031

For use only with HP Compaq 6445b and 6440b computer models not equipped with a pointing stick:

■ For use in Brazil 583292-201

■ For use in French Canada 583292-121

■ For use in Latin America 583292-161

■ For use in the United States 583292-001

For use only with HP Compaq 6440b computer models not equipped with a pointing stick:

■ For use in Belgium 583292-A41

■ For use in Bulgaria 583292-261

■ For use in Denmark 583292-081

■ For use in France 583292-051

■ For use in Germany 583292-041

■ For use in Greece 583292-DJ1

■ For use in Hungary 583292-211

■ For use in Iceland 583292-DD1

(Continued)
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Illustrated parts catalog
(4) Keyboard (continued):

For use only with HP Compaq 6440b computer models not equipped with a pointing stick:

■ For use in Israel 583292-BB1

■ For use in Italy 583292-061

■ For use in Japan 583292-291

■ For use in the Netherlands 583292-B31

■ For use in Norway 583292-091

■ For use in Portugal 583292-131

■ For use in Russia 583292-251

■ For use in Saudi Arabia 583292-171

■ For use in Slovakia 583292-221

■ For use in Slovenia 583292-BA1

■ For use in South Korea 583292-AD1

■ For use in Spain 583292-071

■ For use in Sweden and Finland 583292-B71

■ For use in Switzerland 583292-BG1

■ For use in Taiwan 583292-AB1

■ For use in Thailand 583292-281

■ For use in Turkey 583292-141

■ For use in the United Kingdom 583292-031

(5) Palm rest:

For use only with HP Compaq 6545b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

583285-001

For use only with HP Compaq 6545b and 6540b computer models not equipped with a 
fingerprint reader

583286-001

For use only with HP Compaq 6540b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

593874-001

For use only with HP Compaq 6445b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

583287-001

For use only with HP Compaq 6445b and 6440b computer models not equipped with a 
fingerprint reader

583288-001

For use only with HP Compaq 6440b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

593876-001

(6) Fan 583266-001

(7) Heat sink (includes replacement thermal material):

For use only with HP Compaq 6545b and 6445b computer models 583265-001

For use only with HP Compaq 6540b and 6440b computer models equipped with discrete 
graphics subsystem memory

593879-001

For use only with HP Compaq 6540b and 6440b computer models equipped with UMA 
graphics subsystem memory

593878-001

(Continued)
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Illustrated parts catalog
Plastics Kit:

For use only with HP Compaq 6545b computer models 583279-001

For use only with HP Compaq 6540b computer models 593851-001

For use only with HP Compaq 6445b computer models 583954-001

For use only with HP Compaq 6440b computer models 593852-001

(8a)
(8b)
(8c)
(8d)
(8e)

Includes:
ExpressCard slot bezel
Mass storage device cover
Memory module compartment cover
Bluetooth module compartment cover
Wireless module compartment cover
Optical drive slot bezel (not illustrated)

✎ See “Plastics Kit” on page 3-23 for more Plastics Kit spare part information.

Cable Kit:

For use only with HP Compaq 6545b computer models 583282-001

For use only with HP Compaq 6540b computer models 593853-001

For use only with HP Compaq 6445b computer models 583957-001

For use only with HP Compaq 6440b computer models 593854-001

(9a)
(9b)

Includes:
Bluetooth module cable
Modem module cable (includes RJ-11 connector)
TouchPad board cable (not illustrated)

✎ See “Cable Kit” on page 3-18 for more Cable Kit spare part information.

(10) Processor (includes replacement thermal material):

For use only with HP Compaq 6545b and 6445b computer models:

■ AMD Turion II Ultra M620 2.5-GHz processor (35W, 2-MB L2 cache) 576255-001

■ AMD Turion II Ultra M600 2.3-GHz processor (35W, 2-MB L2 cache) 576254-001

■ AMD Turion II M540 2.4-GHz processor (35W, 1-MB L2 cache) 587257-001

■ AMD Turion II M520 2.2-GHz processor (35W, 1-MB L2 cache) 576253-001

■ AMD Athlon II M340 2.2-GHz processor (35W, 1-MB L2 cache) 587255-001

■ AMD Athlon II M320 2.1-GHz processor (35W, 1-MB L2 cache) 576252-001

■ AMD Sempron M120 2.1-GHz processor (25W, 512-KB L2 cache) 587256-001

■ AMD Sempron M100 1.9-GHz processor (25W, 512-KB L2 cache) 576251-001

(Continued)
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Illustrated parts catalog
(10) Processor (continued):

For use only with HP Compaq 6540b and 6440b computer models:

■ Intel Core i7 720QM 1.60-GHz processor (turbo up to 2.80-GHz; 6-MB L3 cache, 
8 threads, 45W)

603011-001

■ Intel Core i7 620M 2.66-GHz processor (turbo up to 3.33-GHz; 4-MB L3 cache, 
4 threads, 35 W)

603010-001

■ Intel Core i5 540M 2.53-GHz processor (turbo up to 3.06-GHz; 3-MB L3 cache, 
4 threads, 35W)

594646-001

■ Intel Core i5 520M 2.40-GHz processor (turbo up to 2.93-GHz; 3-MB L3 cache, 
4 threads, 35W)

594645-001

■ Intel Core i5 430M 2.26-GHz processor (turbo up to 2.53-GHz; 3-MB L3 cache, 
4 threads, 35W)

595585-001

■ Intel Core i3 350M 2.26-GHz processor (turbo up to 2.40-GHz; 3-MB L3 cache, 
4 threads, 35W)

595586-001

■ Intel Core i3 330M 2.13-GHz processor (turbo up to 2.33-GHz; 3-MB L3 cache, 
4 threads, 35W)

595587-001

(11) TouchPad (includes TouchPad board cable and TouchPad button board cable):

For use only with HP Compaq 6545b computer models 583275-001

For use only with HP Compaq 6540b computer models 593866-001

For use only with HP Compaq 6445b computer models 583276-001

For use only with HP Compaq 6440b computer models 593867-001

(12) Memory modules:

For use only with HP Compaq 6545b and 6445b computer models:

■ 4096-MB (800-MHz, DDR2) 598855-001

■ 2048-MB (800-MHz, DDR2) 598858-001

■ 1024-MB (800-MHz, DDR2) 598861-001

For use only with HP Compaq 6540b and 6440b computer models:

■ 4096-MB (1333-MHz, DDR3) 599092-002

■ 2048-MB (1333-MHz, DDR3) 598856-002

■ 1024-MB (1333-MHz, DDR3) 598859-002

(13) RTC battery (includes cable and double-sided tape):

For use only with HP Compaq 6545b and 6445b computer models 583289-001

For use only with HP Compaq 6540b and 6440b computer models 481089-001

(Continued)

Item Description Spare part number
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(14) Top cover:

For use only with HP Compaq 6545b computer models equipped with a pointing stick 583271-001

For use only with HP Compaq 6545b computer models not equipped with a pointing stick 583272-001

For use only with HP Compaq 6540b computer models equipped with a pointing stick 593862-001

For use only with HP Compaq 6540b computer models not equipped with a pointing stick 593863-001

For use only with HP Compaq 6445b computer models equipped with a pointing stick 583273-001

For use only with HP Compaq 6545b computer models not equipped with a pointing stick 583274-001

For use only with HP Compaq 6440b computer models equipped with a pointing stick 593864-001

For use only with HP Compaq 6540b computer models not equipped with a pointing stick 593865-001

(15) ExpressCard assembly:

For use only with HP Compaq 6545b computer models 583290-001

For use only with HP Compaq 6540b computer models 593868-001

For use only with HP Compaq 6445b computer models 583291-001

For use only with HP Compaq 6440b computer models 593869-001

Smart Card Reader (not illustrated, factory-installed on select models only): 591698-001

(16) Modem module:

For use in all countries and regions except Australia and New Zealand 510100-001

For use only in Australia and New Zealand 510100-011

✎ The modem module spare part kit does not include a modem module cable. The modem module cable is 
included in the Cable Kit, using the following spare part numbers:

❐ 583282-001—for use only with HP Compaq 6545b computer models

❐ 593853-001—for use only with HP Compaq 6540b computer models
❐ 583957-001—for use only with HP Compaq 6445b computer models

❐ 593854-001—for use only with HP Compaq 6440b computer models

✎ See “Cable Kit” on page 3-18 for more Cable Kit spare part information.

(17) Speaker assembly (includes cable):

For use only with HP Compaq 6545b and 6540b computer models 583283-001

For use only with HP Compaq 6445b and 6440b computer models 583284-001

(Continued)

Item Description Spare part number
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(18) System board (includes replacement thermal material):

For use only with HP Compaq 6545b computer models 583257-001

For use only with HP Compaq 6445b computer models 583261-001

For use only with HP Compaq 6540b computer models equipped with discrete graphics 
subsystem memory in all countries and regions except the People’s Republic of China 
and Russia (includes 64-MB of graphics subsystem memory)

593839-001

For use only with HP Compaq 6545b and 6540b computer models equipped with UMA 
graphics subsystem memory in the People’s Republic of China and Russia (includes 64-MB 
of graphics subsystem memory; includes replacement thermal material)

603189-001

For use only with HP Compaq 6540b computer models equipped with discrete graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of 
graphics subsystem memory)

603190-001

For use only with HP Compaq 6540b computer models equipped with UMA graphics 
subsystem memory in all countries and regions except the People’s Republic of China 
and Russia (includes 64-MB of graphics subsystem memory)

593840-001

For use only with HP Compaq 6540b computer models equipped with UMA graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of 
graphics subsystem memory)

603192-001

For use only with HP Compaq 6440b computer models equipped with discrete graphics 
subsystem memory in all countries and regions except the People’s Republic of China 
and Russia (includes 64-MB of graphics subsystem memory)

593841-001

For use only with HP Compaq 6440b computer models equipped with discrete graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of 
graphics subsystem memory)

603191-001

For use only with HP Compaq 6440b computer models equipped with UMA graphics 
subsystem memory in all countries and regions except the People’s Republic of China 
and Russia (includes 64-MB of graphics subsystem memory)

593842-001

For use only with HP Compaq 6440b computer models equipped with UMA graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of 
graphics subsystem memory)

603193-001

(19) Optical drive connector board:

For use only with HP Compaq 6545b computer models 583252-001

For use only with HP Compaq 6540b computer models 593873-001

(20) Serial connector (includes cable)

For use only with HP Compaq 6545b and 6445b computer models 583277-001

For use only with HP Compaq 6540b and 6440b computer models 593872-001

(21) Card reader/USB board (includes cable):

For use only with HP Compaq 6545b computer models 583960-001

For use only with HP Compaq 6540b computer models 593870-001

For use only with HP Compaq 6445b computer models 583961-001

For use only with HP Compaq 6440b computer models 593871-001

(Continued)
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(22) Base enclosure (includes 7 rubber feet):

For use only with HP Compaq 6540b and 6545b computer models 598205-001

For use only with HP Compaq 6440b and 6445b computer models 598206-001

Battery Latch Kit, includes: 583239-001

(23a) Battery eject arm spring

(23b) Battery eject arm

(23c) Battery eject latch

Rubber Kit (not illustrated, includes 7 rubber feet, 2 base enclosure screw covers, and 
8 display bezel screw covers)

583280-001

(24) Battery:

9-cell, 93-WH battery for use with all computer models 586031-001

6-cell, 55-WH battery for use only with HP Compaq 6545b and 6445b computer models 482962-001

For use only with HP Compaq 6540b and 6440b computer models:

■ 6-cell, 55-WH battery 486296-001

■ 6-cell, 47-WH battery 486295-001

(25) Optical drive (includes bezel and bracket):

Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive 583248-001

DVD±RW and CD-RW SuperMulti Double-Layer Drive 583250-001

DVD-ROM Drive 583249-001

MultiBay hard drive carrier (not illustrated) 583251-001

MultiBay hard drive carrier - halogen free (not illustrated) 614947-001

(26) Mass storage device:

Hard drive (includes bracket):

■ 500-GB, 7200-rpm 583246-001

■ 500-GB, 7200-rpm for use only with HP Compaq 6545b and 6445b models 614952-001

■ 500-GB, 7200-rpm for use only with HP Compaq 6540b and 6440b models 614953-001

■ 320-GB, 7200-rpm for use only with HP Compaq 6540b and 6440b models 615595-001

■ 250-GB, 7200-rpm 583244-001

■ 160-GB, 7200-rpm 583243-001

Solid-state drive (includes bracket):

■ 160-GB, 2.5-in solid-state drive—for use only with HP Compaq 6540b and 6440b 
computer models

598089-001

■ 128-GB, 2.5-in solid-state drive—for use with all computer models 583247-001

(Continued)

Item Description Spare part number
3–14 Maintenance and Service Guide



Illustrated parts catalog
(27) Bluetooth module 537921-001

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module cable is 
included in the Cable Kit, using the following spare part numbers:

❐ 583282-001—for use only with HP Compaq 6545b computer models

❐ 593853-001—for use only with HP Compaq 6540b computer models
❐ 583957-001—for use only with HP Compaq 6445b computer models

❐ 593854-001—for use only with HP Compaq 6440b computer models

✎ See “Cable Kit” on page 3-18 for more Cable Kit spare part information.

(28) HSPA EV-DO WWAN module 531993-001

(29) WLAN module:

802.11 a/g/n WLAN module:

■ Broadcom 43224 802.11 a/g/n WLAN module for use in Antigua and Barbuda, Barbados, 
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, 
the U.S. Virgin Islands, and the United States

518434-001

■ Broadcom 43224 802.11 a/g/n WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, 
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People’s Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, 
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, 
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, 
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, 
Zambia, and Zimbabwe

518434-002

(Continued)
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(29) WLAN module (continued):

802.11 b/g WLAN module:

■ Broadcom 4312G 802.11 b/g WLAN module for use in Canada, the Cayman Islands, 
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

■ Broadcom 4312G 802.11 b/g WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, 
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People’s Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, 
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, 
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, 
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, 
Zambia, and Zimbabwe

504593-004

■ Intel Wi-Fi Link 1000, 802.11b/g WLAN module for use only with Russia and Ukraine for 
use in HP Compaq 6440b and 6540b computer models

585984-001

802.11 a/g/n WLAN modules for use only in HP Compaq 6440b and 6540b models:

■ Intel Centrino Advanced-N 6200 AGN WLAN module for use in Andorra, Antigua and 
Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, 
Belgium, Bermuda, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, 
Cayman Islands, Chile, the People's Republic of China, Colombia, Costa Rica, Croatia, 
Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, 
Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece, 
Guadeloupe, Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, 
Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, 
Kyrgyzstan, Latvia, Lebanon, Martinique, Liechtenstein, Lithuania, Luxembourg, Malawi, 
Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, 
the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, 
Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, 
Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, 
Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, 
Tunisia, Turkey, the United Arab Emirates, the United Kingdom, the United States, 
Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam

572509-001

■ Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Antigua and Barbuda, 
Aruba, the Bahamas, Barbados, Belize, Canada, Guam, Guinea, Haiti, Jamaica, the 
Nether Antilles, Puerto Rico, St. Kitts and Nevis, St. Lucia, St. Vincent and the 
Grenadines, Suriname, the US Virgin Islands, and the United States

582564-001

(Continued)
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(29) WLAN module (continued):

802.11 a/g/n WLAN modules for use only in HP Compaq 6440b and 6540b models:

■ Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Albania, Algeria, 
Andorra, Angola, Argentina, Armenia, Australia, Austria, Azerbaijan, Bahrain, Belarus, 
Belgium, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Cayman Islands, Central African Republic, Chad, Chile, 
People's Republic of China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, 
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, 
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji Finland, 
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, 
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Honduras, Hong Kong, 
Hungary, Iceland, India, Ireland, Italy, Ivory Coast, Japan, Jordan, Kazakhstan, Kenya, 
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, 
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia Maldives, Mali, 
Malta, Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, 
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, Netherlands, 
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New 
Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Qatar, Republic of Moldova, 
Romania, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, 
Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, 
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, Swaziland, 
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and 
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, United Arab Emirates, United 
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, 
and Zimbabwe

582564-002

802.11 a/b/g WLAN module for use only in HP Compaq 6440b and 6540b models:

■ Intel Centrino Advanced-N 6200 ABG WLAN module for use in Pakistan, Russia, and 
Ukraine

572510-001

802.11 b/g/n WLAN module for use only in HP Compaq 6440b and 6540b models:

■ Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and 
Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados, 
Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman 
Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic, 
Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, 
France, French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, 
Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, 
Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique, 
Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, 
New Zealand, Nicaragua, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the 
Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia, 
Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, 
Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, United 
Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, 
Venezuela, and Vietnam

572520-001

Item Description Spare part number
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Cable Kit

Item Description Spare part number

Cable Kit:

For use only with HP Compaq 6545b computer models 583282-001

For use only with HP Compaq 65405b computer models 593853-001

For use only with HP Compaq 6445b computer models 583957-001

For use only with HP Compaq 6440b computer models 593854-001

Includes:

(1) TouchPad board cable

(2) Bluetooth module cable

(3) Modem module cable (includes RJ-11 connector)
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Display assembly subcomponents
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Item Description Spare part number

(1) Display bezel:

For use only with HP Compaq 6545b computer models equipped with a webcam 583235-001

For use only with HP Compaq 6545b computer models not equipped with a webcam 583236-001

For use only with HP Compaq 6540b computer models equipped with a webcam 593847-001

For use only with HP Compaq 6540b computer models not equipped with a webcam 593848-001

For use only with HP Compaq 6445b computer models equipped with a webcam 583237-001

For use only with HP Compaq 6445b computer models not equipped with a webcam 583238-001

For use only with HP Compaq 6440b computer models equipped with a webcam 593849-001

For use only with HP Compaq 6440b computer models not equipped with a webcam 593850-001

(2) Webcam module 583219-001

(3) Display Hinge Kit (includes left and right hinges)

For use only with HP Compaq 6545b and 6540b computer models 583232-001

For use only with HP Compaq 6445b and 6440b computer models 583959-001

Display Cable Kit:

For use only with HP Compaq 6545b and 6540b computer models equipped with an 
HD+ display assembly

583956-001

For use only with HP Compaq 6545b and 6540b computer models equipped with an 
HD display assembly

583230-001

For use only with HP Compaq 6445b and 6440b computer models equipped with an 
HD+ display assembly

593990-001

For use only with HP Compaq 6445b and 6440b computer models equipped with an 
HD display assembly

583231-001

Includes:

(4) Display panel cable and webcam cable

(5) WLAN antenna transceivers and cables

(6) Microphones and cables

(7) WWAN antenna transceivers and cables

(8) Display enclosure (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers 
and cables)

For use only with HP Compaq 6545b computer models equipped with two microphones 583278-001

For use only with HP Compaq 6545b computer models equipped with one microphone 583233-001

For use only with HP Compaq 6540b computer models equipped with two microphones 593843-001

For use only with HP Compaq 6540b computer models equipped with one microphone 593844-001

For use only with HP Compaq 6445b computer models equipped with two microphones 583955-001

For use only with HP Compaq 6445b computer models equipped with one microphone 583234-001

For use only with HP Compaq 6440b computer models equipped with two microphones 593845-001

For use only with HP Compaq 6440b computer models equipped with one microphone 593846-001
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Battery Latch Kit

Item Description Spare part number

Battery Latch Kit, includes: 583239-001

(1) Battery eject arm

(2) Battery eject arm spring

(3) Battery eject latch
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Mass storage devices

Item Description Spare part number

(1) Hard drive (includes bracket):

500-GB, 7200-rpm 583246-001

500-GB, 7200-rpm for use only with HP Compaq 6545b and 6445b models 614952-001

500-GB, 7200-rpm for use only with HP Compaq 6540b and 6440b models 614953-001

320-GB, 7200-rpm for use only with HP Compaq 6540b and 6440b models 615595-001

250-GB, 7200-rpm 583244-001

160-GB, 7200-rpm 583243-001

(2) Solid-state drive (includes bracket):

160-GB, 2.5-in solid-state drive—for use only with HP Compaq 6540b and 6440b 
computer models

598089-001

128-GB, 2.5-in solid-state drive—for use with all computer models 583247-001

(3) Optical drive (includes bezel and bracket):

Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive 583248-001

DVD±RW and CD-RW SuperMulti Double-Layer Drive 583250-001

DVD-ROM Drive 583249-001

MultiBay hard drive carrier (not illustrated) 583251-001

MultiBay hard drive carrier - halogen free (not illustrated) 614947-001
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Plastics Kit

Item Description Spare part number

Plastics Kit:

For use only with HP Compaq 6545b computer models 583279-001

For use only with HP Compaq 6540b computer models 593851-001

For use only with HP Compaq 6445b computer models 583954-001

For use only with HP Compaq 6440b computer models 593852-001

(1) ExpressCard slot bezel

(2) Mass storage device cover (includes 2 captive screws)

(3) Memory module compartment cover (includes 1 captive screw)

(4) Bluetooth module compartment cover (includes 1 captive screw)

(5) Wireless module compartment cover (includes 2 captive screws)

(6) Optical drive slot bezel
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Miscellaneous parts

Description Spare part number

AC adapter:

90-W HP Smart Adapter for use only with HP Compaq 6545b and 6445b computer models 
with discrete graphics

463955-001

90-W PFC HP Smart Adapter for use only with HP Compaq 6540b and 6440b 
computer models with discrete graphics

535593-001

90-W Slimline PFC AC adapter (RC/V) for use in computers with discrete graphics 613153-001

65-W PFC HP Smart Adapter for use only with HP Compaq 6540b and 6440b 
computer models with discrete graphics

577170-001

65-W HP Smart Adapter for use only with HP Compaq 6540b and 6440b computer models 463958-001

65-W AC adapter (RC/V) for use in only HP Compaq 6440b and 6540b models with UMA 
graphics

613152-001

65-W AC adapter (RC/V EM) for use in only HP Compaq 6440b and 6540b models with 
UMA graphics

613160-001

65-W AC adapter (RC/V) for use in only HP Compaq 6440b and 6540b models with UMA 
graphics in the Asia/Pacific region 

613161-001

Power cord:

For use in Argentina 490371-D01

For use in Brazil 490371-201

For use in Denmark 490371-081

For use in Europe, the Middle East, and Africa 490371-021

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in South Africa 490371-AR1

For use in Switzerland 490371-111

For use in the United Kingdom and Singapore 490371-031

For use in Canada, Mexico, and the United States 490371-001

Screw Kit:
Hex HM5.0×10.0 screw lock
Phillips PM3.0×3.0 screw
Phillips PM2.5×13.0 captive screw
Phillips PM2.5×11.0 captive screw
Phillips PM2.5×9.0 captive screw
Phillips PM2.5×6.0 screw
Phillips PM2.0×6.0 captive screw
Phillips PM2.0×5.0 screw
Phillips PM2.0×3.0 screw
Slotted Torx T8M2.5×11.0 screw
Slotted Torx T8M2.5×7.0 screw

583281-001
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Sequential part number listing

Spare part number Description

463955-001 90-W PFC HP Smart Adapter

463958-001 65-W HP Smart Adapter for use only with HP Compaq 6540b and 6440b computer models

481089-001 RTC battery for use only with HP Compaq 6540b and 6440b computer models (includes cable and 
double-sided tape)

482962-001 6-cell, 55-WH battery for use only with HP Compaq 6445b and 6545b computer models

486295-001 6-cell, 47-WH battery for use only with HP Compaq 6540b and 6440b computer models

486296-001 6-cell, 55-WH battery for use only with HP Compaq 6540b and 6440b computer models

490371-001 Power cord for use in Canada, Mexico, and the United States

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom and Singapore

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

504593-003 Broadcom 4312G 802.11 b/g WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504593-004 Broadcom 4312G 802.11 b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, 
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, 
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, 
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, 
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, 
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, 
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, 
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy, the Ivory Coast, 
Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, 
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, 
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, 
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, 
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, 
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of China, Peru, 
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, 
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, 
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, 
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, 
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe
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510100-001 Modem module for use in all countries and regions except Australia and New Zealand

✎ The modem module spare part kit does not include a modem module cable. The modem 
module cable is included in the Cable Kit, using the following spare part numbers:

❐ 583282-001—For use only with HP Compaq 6545b computer models

❐ 593853-001—For use only with HP Compaq 6540b computer models
❐ 583957-001—For use only with HP Compaq 6445b computer models

❐ 593854-001—For use only with HP Compaq 6440b computer models

510100-011 Modem module for use only in Australia and New Zealand

✎ The modem module spare part kit does not include a modem module cable. The modem 
module cable is included in the Cable Kit, using the following spare part numbers:

❐ 583282-001—For use only with HP Compaq 6545b computer models

❐ 593853-001—For use only with HP Compaq 6540b computer models
❐ 583957-001—For use only with HP Compaq 6445b computer models

❐ 593854-001—For use only with HP Compaq 6440b computer models

518434-001 Broadcom 43224 802.11 a/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, 
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, 
and the United States

518434-002 Broadcom 43224 802.11 a/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, 
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, 
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, 
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, 
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, 
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, 
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, 
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Italy, the Ivory Coast, 
Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, 
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, 
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, 
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, 
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, 
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People’s Republic of China, Peru, 
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, 
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, 
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, 
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, 
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

531993-001 HSPA EV-DO WWAN module

535593-001 90-W PFC HP Smart Adapter for use only with HP Compaq 6540b and 6440b computer models

537921-001 Bluetooth module

✎ The Bluetooth module spare part kit does not include a Bluetooth  module cable. The Bluetooth 
module cable is included in the Cable Kit, using the following spare part numbers:

❐ 583282-001—For use only with HP Compaq 6545b computer models

❐ 593853-001—For use only with HP Compaq 6540b computer models

❐ 583957-001—For use only with HP Compaq 6445b computer models
❐ 593854-001—For use only with HP Compaq 6440b computer models
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572509-001 Intel Centrino Advanced-N 6200 AGN WLAN module for use in Andorra, Antigua and Barbuda, 
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, 
Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the 
People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, 
Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French Guiana, Georgia, 
Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, 
Kyrgyzstan, Latvia, Lebanon, Martinique, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, 
Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New 
Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines, Poland, 
Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, 
Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, 
Thailand, Trinidad and Tobago, Tunisia, Turkey, the United Arab Emirates, the United Kingdom, the 
United States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam for use in 6440b and 6540b 
models

572510-001 Intel Centrino Advanced-N 6200 ABG WLAN module for use in Pakistan, Russia, and Ukraine for use 
in 6440b and 6540b models

572520-001 Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, 
Argentina, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados, Belgium, Bolivia, Bosnia 
and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, Colombia, Costa 
Rica, Croatia, Cyprus, the Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El 
Salvador, Estonia, Finland, France, French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, 
Greece, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, 
Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, 
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, 
Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico, 
Qatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, 
South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and 
Tobago, Turkey, United Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. 
Virgin Islands, Venezuela, and Vietnam for use in 6440b and 6540b models

576251-001 AMD Sempron M100 1.9-GHz processor for use only with HP Compaq 6545b and 6445b computer 
models (25W, 512-KB L2 cache, includes replacement thermal material)

576252-001 AMD Athlon II M320 2.1-GHz processor for use only with HP Compaq 6545b and 6445b computer 
models (35W, 1-MB L2 cache, includes replacement thermal material)

576253-001 AMD Turion II M520 2.2-GHz processor for use only with HP Compaq 6545b and 6445b computer 
models (35W, 1-MB L2 cache, includes replacement thermal material)

576254-001 AMD Turion II Ultra M600 2.3-GHz processor for use only with HP Compaq 6545b and 6445b 
computer models (35W, 2-MB L2 cache, includes replacement thermal material)

576255-001 AMD Turion II Ultra M620 2.5-GHz processor for use only with HP Compaq 6545b and 6445b 
computer models (35W, 2-MB L2 cache, includes replacement thermal material)

577170-001 65-W PFC HP Smart Adapter for use only with HP Compaq 6540b and 6440b computer models

582564-001 Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Antigua and Barbuda, Aruba, the 
Bahamas, Barbados, Belize, Canada, Guam, Guinea, Haiti, Jamaica, the Nether Antilles, Puerto 
Rico, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, the US Virgin Islands, 
and the United States for use in 6445b and 6545b models
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582564-002 Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Albania, Algeria, Andorra, Angola, 
Argentina, Armenia, Australia, Austria, Azerbaijan, Bahrain, Belarus, Belgium, Benin, Bermuda, 
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, 
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Cayman Islands, Central 
African Republic, Chad, Chile, People's Republic of China, Colombia, Comoros, Congo, Costa Rica, 
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East 
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji Finland, France, 
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, 
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Honduras, Hong Kong, Hungary, Iceland, India, 
Ireland, Italy, Ivory Coast, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, 
Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, 
Malawi, Malaysia Maldives, Mali, Malta, Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, 
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, 
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New 
Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Qatar, Republic of Moldova, Romania, 
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and 
Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands, Somalia, 
South Africa, South Korea, Spain, Sri Lanka, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, 
Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, United Arab Emirates, United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe for use in 6445b and 6545b models

583219-001 Webcam module

583220-001 15.6-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6545b computer models 
not equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones, 
nameplate, and logo)

583222-001 15.6-in, HD+, LED, AntiGlare display assembly for use only with HP Compaq 6545b computer models 
not equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones, 
nameplate, and logo)

583223-001 15.6-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6545b computer models 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones, 
nameplate, and logo)

583225-001 15.6-in, HD+, LED, AntiGlare display assembly for use only with HP Compaq 6545b computer models 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones, 
nameplate, and logo)

583226-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6445b computer models 
not equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones, 
nameplate, and logo)

583228-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6445b computer models 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, microphones, 
nameplate, and logo)

583230-001 Display Cable Kit for use only with HP Compaq 6545b and 6540b computer models equipped with an 
HD display assembly (includes display panel cable and webcam cable, WLAN antenna transceivers 
and cables, microphones and cables, and WWAN antenna transceivers and cables)

583231-001 Display Cable Kit for use only with HP Compaq 6445b and 6440b computer models equipped with an 
HD display assembly (includes display panel cable and webcam cable, WLAN antenna transceivers 
and cables, microphones and cables, and WWAN antenna transceivers and cables)

583232-001 Display Hinge Kit for use only with HP Compaq 6545b and 6540b computer models (includes left and 
right hinges)

583233-001 Display enclosure for use only with HP Compaq 6545b computer models equipped with 
one microphone (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna 
transceivers and cables)
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583234-001 Display enclosure for use only with HP Compaq 6445b computer models equipped with 
one microphone (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna 
transceivers and cables)

583235-001 Display bezel for use only with HP Compaq 6545b computer models equipped with a webcam

583236-001 Display bezel for use only with HP Compaq 6545b computer models not equipped with a webcam

583237-001 Display bezel for use only with HP Compaq 6445b computer models equipped with a webcam

583238-001 Display bezel for use only with HP Compaq 6445b computer models not equipped with a webcam

583239-001 Battery Latch Kit (includes battery eject arm, battery eject latch, and battery eject spring)

583243-001 160-GB, 7200-rpm hard drive (includes bracket)

583244-001 250-GB, 7200-rpm hard drive (includes bracket)

583246-001 500-GB, 7200-rpm hard drive (includes bracket)

583247-001 128-GB, 2.5-in solid-state drive (includes bracket)

583248-001 Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive (includes bezel and bracket)

583249-001 DVD-ROM Drive (includes bezel and bracket)

583250-001 DVD±RW and CD-RW SuperMulti Double-Layer Drive (includes bezel and bracket)

583251-001 MultiBay hard drive carrier

583252-001 Optical drive connector board for use only with HP Compaq 6545b computer models

583253-001 Power button board for use only with HP Compaq 6545b and 6445b computer models 
(includes cable)

583257-001 System board for use only with HP Compaq 6545b computer models (includes replacement 
thermal material)

583261-001 System board for use only with HP Compaq 6445b computer models (includes replacement 
thermal material)

583265-001 Heat sink for use only with HP Compaq 6545b and 6445b computer models (includes replacement 
thermal material)

583266-001 Fan

583267-001 Switch cover for use only with HP Compaq 6445b computer models (includes capacitive board 
and cable)

583268-001 Switch cover for use only with HP Compaq 6545b computer models (includes capacitive board 
and cable)

583271-001 Top cover for use only with HP Compaq 6545b computer models equipped with a pointing stick

583272-001 Top cover for use only with HP Compaq 6545b computer models not equipped a pointing stick

583273-001 Top cover for use only with HP Compaq 6445b computer models equipped with a pointing stick

583274-001 Top cover for use only with HP Compaq 6445b computer models not equipped with a pointing stick

583275-001 TouchPad for use only with HP Compaq 6545b computer models (includes TouchPad board cable 
and TouchPad button board cable)

583276-001 TouchPad for use only with HP Compaq 6445b computer models (includes TouchPad board cable 
and TouchPad button board cable)

583277-001 Serial connector for use only with HP Compaq 6545b and 6445b computer models (includes cable)

583278-001 Display enclosure for use only with HP Compaq 6545b computer models equipped with 
two microphones (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna 
transceivers and cables)
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583279-001 Plastics Kit for use only with HP Compaq 6545b computer models

✎ See “Plastics Kit” on page 3-23 for more Plastics Kit spare part information.

583280-001 Rubber Kit (includes 7 rubber feet, 2 base enclosure screw covers, and 8 display bezel screw covers)

583281-001 Screw Kit

583282-001 Cable Kit for use only with HP Compaq 6545b computer models

✎ See “Cable Kit” on page 3-18 for more Cable Kit spare part information.

583283-001 Speaker assembly for use only with HP Compaq 6545b and 6540b computer models (includes cable)

583284-001 Speaker assembly for use only with HP Compaq 6445b and 6440b computer models (includes cable)

583285-001 Palm rest for use only with HP Compaq 6545b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

583286-001 Palm rest for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
fingerprint reader

583287-001 Palm rest for use only with HP Compaq 6445b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

583288-001 Palm rest for use only with HP Compaq 6440b computer models not equipped with a 
fingerprint reader

583289-001 RTC battery for use only with HP Compaq 6545b and 6445b computer models (includes cable and 
double-sided tape)

583290-001 ExpressCard assembly for use only with HP Compaq 6545b computer models

583291-001 ExpressCard assembly for use only with HP Compaq 6445b computer models

583292-001 Keyboard for use only with HP Compaq 6445b and 6440b computer models not equipped with a 
pointing stick in the United States (includes keyboard cable)

583292-031 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
the United Kingdom (includes keyboard cable)

583292-041 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Germany (includes keyboard cable)

583292-051 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
France (includes keyboard cable)

583292-061 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Italy (includes keyboard cable)

583292-071 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Spain (includes keyboard cable)

583292-081 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Denmark (includes keyboard cable)

583292-091 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Norway (includes keyboard cable)

583292-121 Keyboard for use only with HP Compaq 6445b and 6440b computer models not equipped with a 
pointing stick in French Canada (includes keyboard cable)

583292-131 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Portugal (includes keyboard cable)

583292-141 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Turkey (includes keyboard cable)

583292-161 Keyboard for use only with HP Compaq 6445b and 6440b computer models not equipped with a 
pointing stick in Latin America (includes keyboard cable)
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583292-171 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Saudi Arabia (includes keyboard cable)

583292-201 Keyboard for use only with HP Compaq 6445b and 6440b computer models not equipped with a 
pointing stick in Brazil (includes keyboard cable)

583292-211 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Hungary (includes keyboard cable)

583292-221 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Slovakia (includes keyboard cable)

583292-251 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Russia (includes keyboard cable)

583292-261 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Bulgaria (includes keyboard cable)

583292-281 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Thailand (includes keyboard cable)

583292-291 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Japan (includes keyboard cable)

583292-A41 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Belgium (includes keyboard cable)

583292-AB1 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Taiwan (includes keyboard cable)

583292-AD1 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
South Korea (includes keyboard cable)

583292-B31 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
the Netherlands (includes keyboard cable)

583292-B71 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Sweden and Finland (includes keyboard cable)

583292-BA1 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Slovenia (includes keyboard cable)

583292-BB1 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Israel (includes keyboard cable)

583292-BG1 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Switzerland (includes keyboard cable)

583292-DD1 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Iceland (includes keyboard cable)

583292-DJ1 Keyboard for use only with HP Compaq 6440b computer models not equipped with a pointing stick in 
Greece (includes keyboard cable)

583293-001 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in the United States (includes keyboard cable)

583293-031 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in the United Kingdom (includes keyboard cable)

583293-041 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Germany (includes keyboard cable)

583293-051 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in France (includes keyboard cable)

583293-061 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Italy (includes keyboard cable)
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583293-071 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Spain (includes keyboard cable)

583293-081 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Denmark (includes keyboard cable)

583293-091 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Norway (includes keyboard cable)

583293-121 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in French Canada (includes keyboard cable)

583293-131 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Portugal (includes keyboard cable)

583293-141 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Turkey (includes keyboard cable)

583293-161 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Latin America (includes keyboard cable)

583293-171 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Saudi Arabia (includes keyboard cable)

583293-201 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Brazil (includes keyboard cable)

583293-211 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Hungary (includes keyboard cable)

583293-251 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Russia (includes keyboard cable)

583293-261 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Bulgaria (includes keyboard cable)

583293-281 Keyboard for use only with HP Compaq 6540b computer models not equipped with a pointing stick in 
Thailand (includes keyboard cable)

583293-291 Keyboard for use only with HP Compaq 6540b computer models not equipped with a pointing stick in 
Japan (includes keyboard cable)

583293-A41 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Belgium (includes keyboard cable)

583293-A81 Keyboard for use only with HP Compaq 6540b computer models not equipped with a pointing stick in 
Slovenia (includes keyboard cable)

583293-AB1 Keyboard for use only with HP Compaq 6540b computer models not equipped with a pointing stick in 
Taiwan (includes keyboard cable)

583293-AD1 Keyboard for use only with HP Compaq 6540b computer models not equipped with a pointing stick in 
South Korea (includes keyboard cable)

583293-B31 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in the Netherlands (includes keyboard cable)

583293-B71 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Sweden and Finland (includes keyboard cable)

583293-BA1 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Slovenia (includes keyboard cable)

583293-BB1 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Israel (includes keyboard cable)

583293-BG1 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Switzerland (includes keyboard cable)
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583293-DD1 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Iceland (includes keyboard cable)

583293-DJ1 Keyboard for use only with HP Compaq 6545b and 6540b computer models not equipped with a 
pointing stick in Greece (includes keyboard cable)

583954-001 Plastics Kit for use only with HP Compaq 6445b computer models

✎ See “Plastics Kit” on page 3-23 for more Plastics Kit spare part information.

583955-001 Display enclosure for use only with HP Compaq 6445b computer models equipped with 
two microphones (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna 
transceivers and cables)

583956-001 Display Cable Kit for use only with computer models equipped with a 15.6-in HD+ display assembly 
(includes display panel cable and webcam cable, WLAN antenna transceivers and cables, 
microphones and cables, and WWAN antenna transceivers and cables)

583957-001 Cable Kit for use only with HP Compaq 6445b computer models

✎ See “Cable Kit” on page 3-18 for more Cable Kit spare part information.

583959-001 Display Hinge Kit for use only with HP Compaq 6445b and 6440b computer models (includes left and 
right hinges)

583960-001 Card reader/USB board for use only with HP Compaq 6545b computer models (includes cable)

583961-001 Card reader/USB board for use only with HP Compaq 6445b computer models (includes cable)

584227-001 15.6-in, HD, LED, WVA display assembly for use only with HP Compaq 6545b computer models not 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna 
transceivers and cables, microphones, nameplate, and logo)

584228-001 15.6-in, HD, LED, WVA display assembly for use only with HP Compaq 6545b computer models 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna 
transceivers and cables, microphones, nameplate, and logo)

584229-001 15.6-in, HD+, LED, WVA display assembly for use only with HP Compaq 6545b computer models not 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna 
transceivers and cables, microphones, nameplate, and logo)

584230-001 15.6-in, HD+, LED, WVA display assembly for use only with HP Compaq 6545b computer models 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna 
transceivers and cables, microphones, nameplate, and logo)

584231-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6445b computer models 
not equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna 
transceivers and cables, microphones, nameplate, and logo)

584232-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6445b computer models 
equipped with a webcam (includes 3 WLAN antenna transceivers and cables, 2 WWAN antenna 
transceivers and cables, microphones, nameplate, and logo)

584233-001 Keyboard for use only with HP Compaq 6445b and 6440b computer models equipped with a 
pointing stick in the United States (includes keyboard cable)

584233-031 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in the 
United Kingdom (includes keyboard cable)

584233-041 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Germany (includes keyboard cable)

584233-051 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
France (includes keyboard cable)

584233-061 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Italy (includes keyboard cable)

(Continued)

Spare part number Description
Maintenance and Service Guide 3–33



Illustrated parts catalog
584233-071 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Spain (includes keyboard cable)

584233-081 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Denmark (includes keyboard cable)

584233-091 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Norway (includes keyboard cable)

584233-121 Keyboard for use only with HP Compaq 6445b and 6440b computer models equipped with a 
pointing stick in French Canada (includes keyboard cable)

584233-131 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Portugal (includes keyboard cable)

584233-141 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Turkey (includes keyboard cable)

584233-161 Keyboard for use only with HP Compaq 6445b and 6440b computer models equipped with a 
pointing stick in Latin America (includes keyboard cable)

584233-171 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Saudi Arabia (includes keyboard cable)

584233-201 Keyboard for use only with HP Compaq 6445b and 6440b computer models equipped with a 
pointing stick in Brazil (includes keyboard cable)

584233-211 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Hungary (includes keyboard cable)

584233-221 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Slovakia (includes keyboard cable)

584233-251 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Russia (includes keyboard cable)

584233-261 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Bulgaria (includes keyboard cable)

584233-281 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Thailand (includes keyboard cable)

584233-291 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Japan (includes keyboard cable)

584233-A41 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Belgium (includes keyboard cable)

584233-AB1 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Taiwan (includes keyboard cable)

584233-AD1 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
South Korea (includes keyboard cable)

584233-B31 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
the Netherlands (includes keyboard cable)

584233-B71 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Sweden and Finland (includes keyboard cable)

584233-BA1 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Slovenia (includes keyboard cable)

584233-BB1 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Israel (includes keyboard cable)

584233-BG1 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Switzerland (includes keyboard cable)
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584233-DD1 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Iceland (includes keyboard cable)

584233-DJ1 Keyboard for use only with HP Compaq 6440b computer models equipped with a pointing stick in 
Greece (includes keyboard cable)

584234-001 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in the United States (includes keyboard cable)

584234-031 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in the United Kingdom (includes keyboard cable)

584234-041 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Germany (includes keyboard cable)

584234-051 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in France (includes keyboard cable)

584234-061 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Italy (includes keyboard cable)

584234-071 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Spain (includes keyboard cable)

584234-081 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Denmark (includes keyboard cable)

584234-091 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Norway (includes keyboard cable)

584234-121 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in French Canada (includes keyboard cable)

584234-131 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Portugal (includes keyboard cable)

584234-141 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Turkey (includes keyboard cable)

584234-161 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Latin America (includes keyboard cable)

584234-171 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Saudi Arabia (includes keyboard cable)

584234-201 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Brazil (includes keyboard cable)

584234-211 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Hungary (includes keyboard cable)

584234-251 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Russia (includes keyboard cable)

584234-261 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Bulgaria (includes keyboard cable)

584234-281 Keyboard for use only with HP Compaq 6540b computer models equipped with a pointing stick in 
Thailand (includes keyboard cable)

584234-291 Keyboard for use only with HP Compaq 6540b computer models equipped with a pointing stick in 
Japan (includes keyboard cable)

584234-A41 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Belgium (includes keyboard cable)

584234-A81 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Slovakia (includes keyboard cable)
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584234-AB1 Keyboard for use only with HP Compaq 6540b computer models equipped with a pointing stick in 
Taiwan (includes keyboard cable)

584234-AD1 Keyboard for use only with HP Compaq 6540b computer models equipped with a pointing stick in 
South Korea (includes keyboard cable)

584234-B31 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in the Netherlands (includes keyboard cable)

584234-B71 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Sweden and Finland (includes keyboard cable)

584234-BA1 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Slovenia (includes keyboard cable)

584234-BB1 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Israel (includes keyboard cable)

584234-BG1 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Switzerland (includes keyboard cable)

584234-DD1 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Iceland (includes keyboard cable)

584234-DJ1 Keyboard for use only with HP Compaq 6545b and 6540b computer models equipped with a 
pointing stick in Greece (includes keyboard cable)

585984-001 Intel Wi-Fi Link 1000, 802.11b/g WLAN module for use only with Russia and Ukraine for use in HP 
Compaq 6440b and 6540b computer models

586031-001 9-cell, 93-WH battery

587255-001 AMD Athlon II M340 2.2-GHz processor for use only with HP Compaq 6545b and 6445b computer 
models (35W, 1-MB L2 cache, includes replacement thermal material)

587256-001 AMD Sempron M120 2.1-GHz processor for use only with HP Compaq 6545b and 6445b computer 
models (25W, 512-KB L2 cache, includes replacement thermal material)

587257-001 AMD Turion II M540 2.4-GHz processor for use only with HP Compaq 6545b and 6445b computer 
models (35W, 1-MB L2 cache, includes replacement thermal material)

591698-001 Smart Card Reader for use only with HP Compaq 6545b and 6445b computer models 
(factory-installed on select models only)

592144-001 14.0-in, HD, LED, SVA, LVDS BrightView display assembly for use only with HP Compaq 6440b 
computer models

593838-001 Power button board for use only with HP Compaq 6540b and 6440b computer models 
(includes cable)

593839-001 System board for use only with HP Compaq 6540b computer models equipped with discrete graphics 
subsystem memory in all countries and regions except the People’s Republic of China and Russia 
(includes 64-MB of graphics subsystem memory and replacement thermal material)

593840-001 System board for use only with HP Compaq 6540b computer models equipped with UMA graphics 
subsystem memory in all countries and regions except the People’s Republic of China and Russia 
(includes 64-MB of graphics subsystem memory and replacement thermal material)

593841-001 System board for use only with HP Compaq 6440b computer models equipped with discrete graphics 
subsystem memory in all countries and regions except the People’s Republic of China and Russia 
(includes 64-MB of graphics subsystem memory and replacement thermal material)

593842-001 System board for use only with HP Compaq 6440b computer models equipped with UMA graphics 
subsystem memory in all countries and regions except the People’s Republic of China and Russia 
(includes 64-MB of graphics subsystem memory and replacement thermal material)

593843-001 Display enclosure for use only with HP Compaq 6540b computer models equipped with two 
microphones (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers 
and cables)
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593844-001 Display enclosure for use only with HP Compaq 6540b computer models equipped with one 
microphone (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers 
and cables)

593845-001 Display enclosure for use only with HP Compaq 6440b computer models equipped with two 
microphones (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers 
and cables)

593846-001 Display enclosure for use only with HP Compaq 6440b computer models equipped with 
one microphone (includes 3 WLAN antenna transceivers and cables, and 2 WWAN antenna 
transceivers and cables)

593847-001 Display bezel for use only with HP Compaq 6540b computer models equipped with a webcam

593848-001 Display bezel for use only with HP Compaq 6540b computer models not equipped with a webcam

593849-001 Display bezel for use only with HP Compaq 6440b computer models equipped with a webcam

593850-001 Display bezel for use only with HP Compaq 6440b computer models not equipped with a webcam

593851-001 Plastics Kit for use only with HP Compaq 6540b computer models

593852-001 Plastics Kit for use only with HP Compaq 6440b computer models

593853-001 Cable Kit for use only with HP Compaq 6540b computer models

593854-001 Cable Kit for use only with HP Compaq 6440b computer models

593860-001 Switch cover for use only with HP Compaq 6540b computer models (includes capacitive board 
and cable)

593861-001 Switch cover for use only with HP Compaq 6440b computer models (includes capacitive board 
and cable)

593862-001 Top cover for use only with HP Compaq 6540b computer models equipped with a pointing stick

593863-001 Top cover for use only with HP Compaq 6540b computer models not equipped with a pointing stick

593864-001 Top cover for use only with HP Compaq 6440b computer models equipped with a pointing stick

593865-001 Top cover for use only with HP Compaq 6540b computer models not equipped with a pointing stick

593866-001 TouchPad for use only with HP Compaq 6540b computer models (includes TouchPad board cable 
and TouchPad button board cable)

593867-001 TouchPad for use only with HP Compaq 6440b computer models (includes TouchPad board cable 
and TouchPad button board cable)

593868-001 ExpressCard assembly for use only with HP Compaq 6540b computer models

593869-001 ExpressCard assembly for use only with HP Compaq 6440b computer models

593870-001 Card reader/USB board for use only with HP Compaq 6540b computer models (includes cable)

593871-001 Card reader/USB board for use only with HP Compaq 6440b computer models (includes cable)

593872-001 Serial connector for use only with HP Compaq 6540b and 6440b computer models (includes cable)

593873-001 Optical drive connector board for use only with HP Compaq 6540b computer models

593874-001 Palm rest for use only with HP Compaq 6540b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

593876-001 Palm rest for use only with HP Compaq 6440b computer models equipped with a fingerprint reader 
(includes fingerprint reader board and cable)

593878-001 Heat sink for use only with HP Compaq 6540b and 6440b computer models equipped with UMA 
graphics subsystem memory (includes replacement thermal material)

593879-001 Heat sink for use only with HP Compaq 6540b and 6440b computer models equipped with discrete 
graphics subsystem memory (includes replacement thermal material)
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593990-001 Display Cable Kit for use only with HP Compaq 6440b and 6445b computer models equipped with an 
HD+ display assembly

593995-001 15.6-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6540b computer models 
not equipped with a webcam or with WWAN functionality

593996-001 15.6-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6540b computer models 
equipped with a webcam but not equipped with WWAN functionality

593997-001 15.6-in, HD, LED, BrightView display assembly for use only with HP Compaq 6540b computer models 
not equipped with a webcam or with WWAN functionality

593998-001 15.6-in, HD, LED, BrightView display assembly for use only with HP Compaq 6540b computer models 
equipped with a webcam but not equipped with WWAN functionality

593999-001 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6540b computer 
models not equipped with a webcam or with WWAN functionality

594000-001 15.6-in, HD, LED, BrightView display assembly for use only with HP Compaq 6540b computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers 
and cables)

594001-001 15.6-in, HD, LED, BrightView display assembly for use only with HP Compaq 6540b computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)

594002-001 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6540b computer 
models equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594003-001 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6540b computer 
models equipped with a webcam but not equipped with WWAN functionality

594004-001 15.6-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6540b computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers 
and cables)

594005-001 15.6-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6540b computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)

594006-001 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6540b computer 
models equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)

594007-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6440b computer models 
not equipped with a webcam or with WWAN functionality

594008-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6440b computer models 
equipped with a webcam but not equipped with WWAN functionality

594009-001 14.0-in, HD, LED, BrightView display assembly for use only with HP Compaq 6440b computer models 
not equipped with a webcam or with WWAN functionality

594010-001 14.0-in, HD, LED, BrightView display assembly for use only with HP Compaq 6440b computer models 
equipped with a webcam but not equipped with WWAN functionality

594011-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6440b computer 
models not equipped with a webcam or with WWAN functionality

594012-001 14.0-in, HD, LED, BrightView display assembly for use only with HP Compaq 6440b computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers 
and cables)

594013-001 14.0-in, HD, LED, BrightView display assembly for use only with HP Compaq 6440b computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)
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594014-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6440b computer 
models equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna 
transceivers and cables)

594015-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6440b computer 
models equipped with a webcam but not equipped with WWAN functionality

594016-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6440b computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers 
and cables)

594017-001 14.0-in, HD, LED, AntiGlare display assembly for use only with HP Compaq 6440b computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)

594018-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6440b computer 
models equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)

594645-001 Intel Core i5 520M 2.40-GHz processor for use only with HP Compaq 6540b and 6440b computer 
models (turbo up to 2.93-GHz; 3-MB L3 cache, 4 threads, 35W)

594646-001 Intel Core i5 540M 2.53-GHz processor for use only with HP Compaq 6540b and 6440b computer 
models (turbo up to 3.06-GHz; 3-MB L3 cache, 4 threads, 35W)

595585-001 Intel Core i5 430M 2.26-GHz processor for use only with HP Compaq 6540b and 6440b computer 
models (turbo up to 2.53-GHz; 3-MB L3 cache, 4 threads, 35W)

595586-001 Intel Core i3 350M 2.26-GHz processor for use only with HP Compaq 6540b and 6440b computer 
models (turbo up to 2.40-GHz; 3-MB L3 cache, 4 threads, 35W)

595587-001 Intel Core i3 330M 2.13-GHz processor for use only with HP Compaq 6540b and 6440b computer 
models (turbo up to 2.33-GHz; 3-MB L3 cache, 4 threads, 35W)

598089-001 160-GB, 2.5-in solid-state drive for use only with HP Compaq 6540b and 6440b computer models 
(includes solid-state drive bracket)

598205-001 Base enclosure for use only with HP Compaq 6540b and 6545b computer models (includes 7 rubber 
feet)

598206-001 Base enclosure for use only with HP Compaq 6440b and 6445b computer models (includes 7 rubber 
feet)

598855-001 4096-MB memory module for use only with HP Compaq 6545b and 6445b computer models 
(1333-MHz, DDR3)

598858-001 2048-MB memory module for use only with HP Compaq 6545b and 6445b computer models 
(1333-MHz, DDR3)

598859-002 2048-MB memory module for use only with HP Compaq 6540b and 6440b computer models 
(1333-MHz, DDR3)

598859-002 1024-MB memory module for use only with HP Compaq 6540b and 6440b computer models 
(1333-MHz, DDR3)

598861-001 1024-MB memory module for use only with HP Compaq 6545b and 6445b computer models 
(1333-MHz, DDR3)

599092-002 4096-MB memory module for use only with HP Compaq 6540b and 6440b computer models 
(1333-MHz, DDR3)

600753-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6445b computer 
models not equipped with a webcam

600754-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6445b computer 
models equipped with a webcam
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603010-001 Intel Core i7 620M 2.66-GHz processor for use only with HP Compaq 6540b and 6440b computer 
models (turbo up to 3.33-GHz; 4-MB L3 cache, 4 threads, 35 W; includes thermal 
replacement material)

603011-001 Intel Core i7 720QM 1.60-GHz processor for use only with HP Compaq 6540b and 6440b computer 
models (turbo up to 2.80-GHz; 6-MB L3 cache, 8 threads, 45W; includes thermal 
replacement material)

603189-001 System board for use only with HP Compaq 6545b and 6540b computer models equipped with UMA 
graphics subsystem memory in the People’s Republic of China and Russia (includes 64-MB of 
graphics subsystem memory; includes replacement thermal material)

603190-001 System board for use only with HP Compaq 6540b computer models equipped with discrete graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of graphics 
subsystem memory; includes replacement thermal material)

603191-001 System board for use only with HP Compaq 6440b computer models equipped with discrete graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of graphics 
subsystem memory; includes replacement thermal material)

603192-001 System board for use only with HP Compaq 6540b computer models equipped with UMA graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of graphics 
subsystem memory; includes replacement thermal material)

603193-001 System board for use only with HP Compaq 6440b computer models equipped with UMA graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of graphics 
subsystem memory; includes replacement thermal material)

613152-001 65-W AC adapter (RC/V) for use in only HP Compaq 6440b and 6540b models with UMA graphics

613153-001 90-W Slimline PFC AC adapter (RC/V) for use in computers with discrete graphics

613160-001 65-W AC adapter (RC/V EM) for use in only HP Compaq 6440b and 6540b models with UMA 
graphics

613161-001 65-W AC adapter (RC/V) for use in only HP Compaq 6440b and 6540b models with UMA graphics in 
the Asia/Pacific region 

614947-001 MultiBay hard drive carrier - halogen free

614952-001 500-GB, 7200-rpm hard drive for use only in HP Compaq 6445b and 6545b models (includes 
bracket)

614953-001 500-GB, 7200-rpm hard drive for use only in HP Compaq 6440b and 6540b models (includes 
bracket)

615595-001 320-GB, 7200-rpm hard drive for use only in HP Compaq 6440b and 6540b models (includes 
bracket)

617448-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6445b computer 
models with WWAN functionality but not a webcam

617449-001 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with HP Compaq 6445b computer 
models equipped with a webcam and WWAN functionality

623176-001 14.0-in, HD, LED, SVA, LVDS AntiGlare display assembly for use only with HP Compaq 6440b 
computer models

623181-001 15.6-in, HD, LED, SVA, LVDS AntiGlare display assembly for use only with HP Compaq 6540b 
computer models

623182-001 15.6-in, HD, LED, LVDS BrightView display assembly for use only with HP Compaq 6540b computer 
models

624236-001 14.0-in, HD+, LED, LVDS AntiGlare display assembly for use only with HP Compaq 6440b computer 
models

624643-001 15.6-in, HD+, LED, WVA, LVDS AntiGlare display assembly for use only with HP Compaq 6540b 
computer models

Spare part number Description
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Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures: 

■ Flat-bladed screwdriver

■ Phillips P0 screwdriver

■ Phillips P1 screwdriver

■ Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and 
assembly procedures. 

✎ As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) 
away from the work area to prevent damage. 

Plastic parts

Ä
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the 
plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

Ä
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the reassembly 
process. Improper cable placement can damage the computer. 

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the 
cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid 
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or 
snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily. 
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Drive handling

Ä
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the computer, damage to a 
drive, or loss of information, observe these precautions:
■ Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off or in 

Hibernation, turn the computer on, and then shut it down through the operating system. 
■ Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid touching the 

connector.
■ Handle drives on surfaces covered with at least one inch of shock-proof foam. 
■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers. 
■ Avoid exposing a drive to temperature extremes or liquids. 
■ If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging and label 

the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD 
contains enough power to alter device parameters or melt silicon junctions. 

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred. 

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal cycle. 
Or, the device may function normally for a while, and then degrade in the internal layers, reducing its life 
expectancy. 

Ä
CAUTION: To prevent damage to the computer when you are removing or installing internal components, observe these 
precautions:
■ Keep components in their electrostatic-safe containers until you are ready to install them.
■ Use nonmagnetic tools. 
■ Before touching an electronic component, discharge static electricity by using the guidelines described in this section.
■ Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
■ If you remove a component, place it in an electrostatic-safe container.
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The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

Ä
CAUTION: A product can be degraded by as little as 700 V. 

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment: 

■ To avoid hand contact, transport products in static-safe tubes, bags, or boxes. 

■ Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging. 

■ Keep ESD-sensitive parts in their containers until they arrive at static-free workstations. 

■ Place items on a grounded surface before them from their containers. 

■ Always be properly grounded when touching a component or assembly. 

■ Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam. 

■ Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment 
used for moving materials is wired to ground, and that proper materials are selected to avoid static charging. 
When grounding is not possible, use an ionizer to dissipate electric charges. 

Typical electrostatic voltage levels 

Relative humidity 

Event 10% 40% 55% 

Walking across carpet 35,000 V 15,000 V 7,500 V 

Walking across vinyl floor 12,000 V 5,000 V 3,000 V 

Motions of bench worker 6,000 V 800 V 400 V 

Removing DIPS from plastic tube 2,000 V 700 V 400 V 

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V 

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V 

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V 

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V 
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Workstation guidelines

Follow these workstation grounding guidelines: 

■ Cover the workstation with approved static-shielding material. 

■ Use a wrist strap connected to a properly grounded work surface, and use properly grounded tools and 
equipment. 

■ Use conductive field service tools, such as cutters, screwdrivers, and vacuums. 

■ When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials. 

■ Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam. 

■ Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items 
only at static-free workstations. 

■ Avoid contact with pins, leads, or circuitry. 

■ Turn off power and input signals before inserting or removing connectors or test equipment. 

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation. 

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly 
against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a 
wrist strap. 

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at 
standing workstations and are compatible with most types of shoes or boots. On conductive floors or 
dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the 
operator and ground. To be effective, the conductive strips must be worn in contact with the skin. 

The following grounding equipment is recommended to prevent electrostatic damage: 

■ Antistatic tape 

■ Antistatic smocks, aprons, and sleeve protectors 

■ Conductive bins and other assembly or soldering aids 

■ Nonconductive foam 

■ Conductive tabletop workstations with ground cords of one megohm resistance 

■ Static-dissipative tables or floor mats with hard ties to the ground 

■ Field service kits 

■ Static awareness labels 

■ Material-handling packages 

■ Nonconductive plastic bags, tubes, or boxes 

■ Metal tote boxes 

■ Electrostatic voltage levels and protective materials 

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level 

Antistatic plastic Bags 1,500 V 

Carbon-loaded plastic Floor mats 7,500 V 

Metallized laminate Floor mats 5,000 V 
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Component replacement procedures

This chapter provides removal and replacement procedures. 

There are as many as 92 screws and screw locks, in 11 different sizes, that must be removed, replaced, or loosened 
when servicing the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n) This number provides specific information about the product’s 
hardware components. The part number helps a service 
technician determine what components and parts are needed.

(4) Model description This is the alphanumeric identifier used to locate documents, 
drivers, and support for the computer.

(5) Warranty period This number describes the duration of the warranty period for 
the computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part number 
583280-001. There are 7 rubber feet that attach to the base enclosure in the locations shown in the following 
illustration.
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Battery

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

Remove the battery:

1. Turn the computer upside down on a flat surface, with the front toward you.

2. Slide the battery release latch 1 to release the battery.

3. Remove the battery 2.

Insert the battery into the battery bay until it is seated. The battery release latch automatically locks the battery 
into place.

Description Spare part number

9-cell, 93-WH battery for use with all computer models 586031-001

6-cell, 55-WH battery for use only with HP Compaq 6545b and 6445b computer models 482962-001

For use only with HP Compaq 6540b and 6440b computer models:

■ 6-cell, 55-WH battery 486296-001

■ 6-cell, 47-WH battery 486295-001
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SIM

✎ The SIM is provided by the end user as a security measure for the WWAN module. The SIM should be removed, 
placed into a static-dissipative container, and then replaced when the computer is reassembled.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7). 

Remove the SIM:

1. Press in on the SIM 1 to release it from the SIM slot.

2. Remove the SIM 2 from the SIM slot.

Insert the SIM into the SIM slot, and gently push the SIM into the slot until it is firmly seated.
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Bluetooth module

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module cable is 
included in the Cable Kit, using the following spare part numbers:
■ 583282-001—for use only with HP Compaq 6545b computer models
■ 593853-001—for use only with HP Compaq 6540b computer models
■ 583957-001—for use only with HP Compaq 6445b computer models
■ 593854-001—for use only with HP Compaq 6440b computer models

Before removing the Bluetooth module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the accessory cover (see “Mass storage device” on page 4-11).

Remove the Bluetooth module:

1. Loosen the Phillips PM2.0×6.0 captive screw 1 that secures the Bluetooth module compartment cover to 
the computer.

2. Lift the Bluetooth module compartment cover 2 straight up to remove it. The Bluetooth module compartment 
cover is included in the Plastics Kit, spare part numbers 583279-001 (for use only with HP Compaq 6545b and 
6540b computer models) and 583954-001 (for use only with HP Compaq 6445b and 6440b computer models).

Description Spare part number

Bluetooth module 537921-001
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3. Release the Bluetooth module 1 by lifting the right side of the module out of the Bluetooth 
module compartment.

4. Disconnect the Bluetooth module cable 2 from the Bluetooth module.

5. Remove the Bluetooth module 3.

Reverse this procedure to install the Bluetooth module.
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Mass storage device

✎ The mass storage device spare part kit includes a bracket.

Before removing the mass storage device, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

Remove the mass storage device:

1. Position the computer with the front toward you.

Description Spare part number

Hard drive:

■ 500-GB, 7200-rpm 583246-001

■ 500-GB, 7200-rpm for use only with HP Compaq 6545b and 6445b models 614952-001

■ 500-GB, 7200-rpm for use only with HP Compaq 6540b and 6440b models 614953-001

■ 320-GB, 7200-rpm for use only with HP Compaq 6540b and 6440b models 615595-001

■ 250-GB, 7200-rpm 583244-001

■ 160-GB, 7200-rpm 583243-001

Solid-state drive (includes bracket):

■ 160-GB, 2.5-in solid-state drive—for use only with HP Compaq 6540b and 6440b models 598089-001

■ 128-GB, 2.5-in solid-state drive—for use with all models 583247-001
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2. Loosen the two Phillips PM2.0×6.0 captive screws 1 that secure the mass storage device cover to 
the computer.

3. Lift the left side of the cover 2 to detach it from the computer.

4. Remove the mass storage device cover 3. The mass storage device cover is included in the Plastics Kit, spare 
part numbers 583279-001 (for use only with HP Compaq 6545b and 6540b computer models) and 583954-001 
(for use only with HP Compaq 6445b and 6440b computer models).

5. Loosen the Phillips PM2.5×13.0 captive screw 1 that secures the mass storage device in the mass storage 
device bay.

6. Grasp the Mylar tab 2 on the mass storage device bracket, and slide the mass storage device 3 to the right to 
disconnect it from the system board.

7. Remove the mass storage device 4 from the mass storage device bay. 
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8. If it is necessary to replace the mass storage device bracket, follow these steps:

a. Remove the four Phillips PM3.0×3.0 screws 1 that secure the mass storage device bracket to the mass 
storage device.

b. Lift the bracket 2 straight up to remove it from the mass storage device. 

Reverse this procedure to reassemble and install the mass storage device. 
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Expansion memory module

Before removing the expansion memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

Remove the expansion memory module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×6.0 captive screw 1 that secures the memory module compartment cover to 
the computer.

3. Lift the left side of the cover 2 to detach it from the computer.

4. Remove the memory module compartment cover 3. The memory module compartment cover is included in the 
Plastics Kit, spare part numbers 583279-001 (for use only with HP Compaq 6545b and 6540b computer 
models) and 583954-001 (for use only with HP Compaq 6445b and 6400 computer models).

Description Spare part number

For use only with HP Compaq 6545b and 6445b computer models:

■ 4096-MB (800-MHz, DDR2) 598855-001

■ 2048-MB (800-MHz, DDR2) 598858-001

■ 1024-MB (800-MHz, DDR2) 598861-001

For use only with HP Compaq 6540b and 6440b computer models:

■ 4096-MB (1333-MHz, DDR3) 599092-002

■ 2048-MB (1333-MHz, DDR3) 598856-002

■ 1024-MB (1333-MHz, DDR3) 598859-002
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5. Pull away the retention clips 1 on each side of the memory module to release the memory module. 
(The memory module tilts up.)

Ä
CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch the components on the 
memory module.

6. Grasp the edge of the memory module 2, and then pull it out of the memory module slot.

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory 
module slot.

Reverse this procedure to install the expansion memory module.
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WLAN module

Description Spare part number

802.11 a/g/n WLAN module:

■ Broadcom 43224 802.11 a/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, 
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, 
and the United States

518434-001

■ Broadcom 43224 802.11 a/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, 
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, 
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, 
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, 
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, 
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, 
Indonesia, Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, 
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, 
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, 
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, 
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, 
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, 
Panama, Papua New Guinea, Paraguay, the People’s Republic of China, Peru, the Philippines, 
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, 
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, 
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, 
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, 
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-002

802.11 b/g WLAN module:

■ Broadcom 4312G 802.11 b/g WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

■ Broadcom 4312G 802.11 b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, 
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, 
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, 
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, 
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, 
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, 
Indonesia, Ireland, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, 
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, 
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, 
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, 
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, 
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, 
Panama, Papua New Guinea, Paraguay, the People’s Republic of China, Peru, the Philippines, 
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, 
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent, Suriname, Swaziland, 
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Tunisia, Turkey, 
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, 
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

(Continued)
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WLAN module (continued):

■ Intel Wi-Fi Link 1000, 802.11b/g WLAN module for use in Russia and Ukraine for use only in HP 
Compaq 6440b and 6540b computer models

585984-001

802.11 a/g/n WLAN modules for use only in HP Compaq 6440b and 6540b models:

■ Intel Centrino Advanced-N 6200 AGN WLAN module for use in Andorra, Antigua and Barbuda, 
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, 
Bermuda, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, 
Chile, the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, 
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French 
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Honduras, 
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan, 
Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique, Liechtenstein, Lithuania, 
Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the 
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan, 
Panama, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San 
Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, 
Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, 
Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin 
Islands, Venezuela, and Vietnam

572509-001

■ Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Antigua and Barbuda, Aruba, 
the Bahamas, Barbados, Belize, Canada, Guam, Guinea, Haiti, Jamaica, the Nether Antilles, 
Puerto Rico, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, the US 
Virgin Islands, and the United States

582564-001

■ Broadcom 43224AGN 802.11a/b/g/draft-n WiFi Adapter for use in Albania, Algeria, Andorra, 
Angola, Argentina, Armenia, Australia, Austria, Azerbaijan, Bahrain, Belarus, Belgium, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, 
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Cayman 
Islands, Central African Republic, Chad, Chile, People's Republic of China, Colombia, Comoros, 
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the 
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, 
Ethiopia, Fiji Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, 
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Honduras, Hong 
Kong, Hungary, Iceland, India, Ireland, Italy, Ivory Coast, Japan, Jordan, Kazakhstan, Kenya, 
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, 
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia Maldives, Mali, Malta, Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria, 
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, Peru, Philippines, Poland, 
Portugal, Qatar, Republic of Moldova, Romania, Rwanda, Samoa, San Marino, Sao Tome and 
Principe, Saudi Arabia, Senegal, Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, 
Slovakia, Slovenia, Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, 
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad 
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, United Arab Emirates, United 
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and 
Zimbabwe

582564-002

802.11 a/b/g WLAN module for use only in HP Compaq 6440b and 6540b models:

■ Intel Centrino Advanced-N 6200 ABG WLAN module for use in Pakistan, Russia, and Ukraine 572510-001

(Continued)

Description Spare part number
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Removal and replacement procedures
Before removing the WLAN module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

Remove the WLAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore computer functionality, and then contact technical support 
through Help and Support.

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×6.0 captive screws 1 that secure the wireless module compartment cover to 
the computer.

3. Lift the rear edge of the cover 2 to detach it from the computer.

WLAN module (continued):

802.11 b/g/n WLAN module for use only in HP Compaq 6440b and 6540b models:

■ Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, 
Argentina, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados, Belgium, Bolivia, 
Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, 
Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, the Dominican Republic, 
Ecuador, Egypt, El Salvador, Estonia, Finland, France, French Guiana, Guadeloupe, Guam, 
Georgia, Germany, Ghana, Greece, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, 
India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, 
Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, 
Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the 
Netherlands, New Zealand, Nicaragua, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the 
Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal, 
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden, 
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, United Arab Emirates, the 
United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam

572520-001

Description Spare part number
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Removal and replacement procedures
4. Remove the wireless module compartment cover 3. The wireless module compartment cover is included in the 
Plastics Kit, spare part numbers 583279-001 (for use only with HP Compaq 6545b and 6540b computer 
models) and 583954-001 (for use only with HP Compaq 6445b and 6440b computer models).

5. Disconnect the WLAN antenna cables 1 from the terminals on the WLAN module.

✎The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The white WLAN 
antenna cable is connected to the WLAN module “Aux” terminal. If the computer is equipped with an 
802.11a/g/n WLAN module, the yellow WLAN antenna cable 2 is connected to the middle terminal on 
the WLAN module.

6. Remove the two Phillips PM2.5×6.0 screws 3 that secure the WLAN module to the system board. 
(The WLAN module tilts up.)

7. Remove the WLAN module 4 by pulling it away from the slot at an angle.

✎WLAN modules are designed with a notch 5 to prevent incorrect insertion of the WLAN module into 
the WLAN module slot.
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Removal and replacement procedures
✎ If the WLAN antennas are not connected to the terminals on the WLAN module, the protective sleeves must be 
installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module. 
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Removal and replacement procedures
WWAN module

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the wireless module compartment cover (see “WLAN module” on page 4-16).

Remove the WWAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore computer functionality, and then contact technical support 
through Help and Support.

1. Position the computer with the front toward you.

2. Disconnect the WWAN antenna cables 1 from the terminals on the WWAN module.

✎The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue WWAN 
antenna cable is connected to the WWAN module “Aux” terminal. 

3. Remove the two Phillips PM2.5×6.0 screws 2 that secure the WWAN module to the system board. 
(The WWAN module tilts up.)

4. Remove the WWAN module 3 by pulling it away from the slot at an angle. 

✎WWAN modules are designed with a notch 4 to prevent incorrect insertion of the WWAN module into 
the WWAN module slot.

Description Spare part number

HSPA EV-DO WWAN module 531993-001
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Removal and replacement procedures
✎ If the WWAN antennas are not connected to the terminals on the WWAN module, the protective sleeves must be 
installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module. 
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Removal and replacement procedures
Optical drive

✎ The optical drive spare part kit includes an optical drive bezel and bracket.

Before removing the optical drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Remove the optical drive:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.5×11.0 captive screw 1 that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access 2 and press the tab to the left to 
release the optical drive from the computer.

4. Remove the optical drive 3 from the optical drive bay.

Description Spare part number

Blu-ray ROM with LightScribe DVD±RW SuperMulti Double-Layer Drive 583248-001

DVD±RW and CD-RW SuperMulti Double-Layer Drive 583250-001

DVD-ROM Drive 583249-001

MultiBay hard drive carrier - halogen free 614947-001

MultiBay hard drive carrier 583251-001
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Removal and replacement procedures
5. If it is necessary to replace the optical drive bracket, follow these steps:

a. Position the optical drive with the rear toward you. 

b. Remove the three Phillips PM2.0×3.0 screws 1 that secure the optical drive bracket to the optical drive. 

c. Remove the optical drive bracket 2. 

Reverse this procedure to reassemble and install the optical drive. 
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Removal and replacement procedures
Keyboard

✎ The keyboard spare part kit includes a keyboard cable.

Keyboard for use in country 
or region Spare part number

Keyboard for use in country 
or region Spare part number

For use only with HP Compaq 6545b and 6540b computer models equipped with a pointing stick:

■ For use in Belgium 584234-A41 ■ For use in Latin America 584234-161

■ For use in Brazil 584234-201 ■ For use in the Netherlands 584234-B31

■ For use in Bulgaria 584234-261 ■ For use in Norway 584234-091

■ For use in Denmark 584234-081 ■ For use in Portugal 584234-131

■ For use in the Czech Republic 
and Slovakia

584234-A81 ■ For use in Russia 584234-251

■ For use in France 584234-051 ■ For use in Saudi Arabia 584234-171

■ For use in French Canada 584234-121 ■ For use in Slovenia 584234-BA1

■ For use in Germany 584234-041 ■ For use in Spain 584234-071

■ For use in Greece 584234-DJ1 ■ For use in Sweden and Finland 584234-B71

■ For use in Hungary 584234-211 ■ For use in Switzerland 584234-BG1

■ For use in Iceland 584234-DD1 ■ For use in Turkey 584234-141

■ For use in Israel 584234-BB1 ■ For use in the United Kingdom 584234-031

■ For use in Italy 584234-061 ■ For use in the United States 584234-001

For use only with HP Compaq 6540b computer models equipped with a pointing stick:

■ For use in Japan 584234-291 ■ For use in Thailand 584234-AB1

■ For use in Slovakia 584234-A81 ■ For use in the Czech Republic 
and Slovakia

584234-281

■ For use in South Korea 584234-AD1

For use only with HP Compaq 6545b computer models not equipped with a pointing stick:

■ For use in Belgium 583293-A41 ■ For use in Latin America 583293-161

■ For use in Brazil 583293-201 ■ For use in the Netherlands 583293-B31

■ For use in Bulgaria 583293-261 ■ For use in Norway 583293-091

■ For use in Denmark 583293-081 ■ For use in Portugal 583293-131

■ For use in the Czech Republic 
and Slovakia

583293-A81 ■ For use in Russia 583293-251

■ For use in France 583293-051 ■ For use in Saudi Arabia 583293-171

■ For use in French Canada 583293-121 ■ For use in Slovenia 583293-BA1

■ For use in Germany 583293-041 ■ For use in Spain 583293-071

■ For use in Greece 583293-DJ1 ■ For use in Sweden and Finland 583293-B71

■ For use in Hungary 583293-211 ■ For use in Switzerland 583293-BG1

■ For use in Iceland 583293-DD1 ■ For use in Turkey 583293-141

■ For use in Israel 583293-BB1 ■ For use in the United Kingdom 583293-031

■ For use in Italy 583293-061 ■ For use in the United States 583293-001

(Continued)
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Removal and replacement procedures
For use only with HP Compaq 6540b computer models equipped with a pointing stick:

■ For use in Japan 583293-291 ■ For use in Thailand 583293-AB1

■ For use in Slovakia 583293-A81 ■ For use in the Czech Republic 
and Slovakia

583293-281

■ For use in South Korea 583293-AD1

For use only with HP Compaq 6445b and 6440b computer models equipped with a pointing stick:

■ For use in Brazil 584233-201 ■ For use in Latin America 584233-161

■ For use in French Canada 584233-121 ■ For use in the United States 584233-001

For use only with HP Compaq 6440b computer models equipped with a pointing stick:

■ For use in Belgium 584233-A41 ■ For use in Portugal 584233-131

■ For use in Bulgaria 584233-261 ■ For use in Russia 584233-251

■ For use in Denmark 584233-081 ■ For use in Saudi Arabia 584233-171

■ For use in France 584233-051 ■ For use in Slovakia 584233-221

■ For use in Germany 584233-041 ■ For use in Slovenia 584233-BA1

■ For use in Greece 584233-DJ1 ■ For use in South Korea 584233-AD1

■ For use in Hungary 584233-211 ■ For use in Spain 584233-071

■ For use in Iceland 584233-DD1 ■ For use in Sweden and Finland 584233-B71

■ For use in Israel 584233-BB1 ■ For use in Switzerland 584233-BG1

■ For use in Italy 584233-061 ■ For use in Taiwan 584233-AB1

■ For use in Japan 584233-291 ■ For use in Thailand 584233-281

■ For use in the Netherlands 584233-B31 ■ For use in Turkey 584233-141

■ For use in Norway 584233-091 ■ For use in the United Kingdom 584233-031

For use only with HP Compaq 6445b and 6440b computer models not equipped with a pointing stick:

■ For use in Brazil 583292-201 ■ For use in Latin America 583292-161

■ For use in French Canada 583292-121 ■ For use in the United States 583292-001

(Continued)

Keyboard for use in country 
or region Spare part number

Keyboard for use in country 
or region Spare part number
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Removal and replacement procedures
For use only with HP Compaq 6540b computer models equipped with a pointing stick:

■ For use in Japan 583293-291 ■ For use in Thailand 583293-AB1

■ For use in Slovakia 583293-A81 ■ For use in the Czech Republic 
and Slovakia

583293-281

■ For use in South Korea 583293-AD1

For use only with HP Compaq 6445b and 6440b computer models equipped with a pointing stick:

■ For use in Brazil 584233-201 ■ For use in Latin America 584233-161

■ For use in French Canada 584233-121 ■ For use in the United States 584233-001

For use only with HP Compaq 6440b computer models equipped with a pointing stick:

■ For use in Belgium 584233-A41 ■ For use in Portugal 584233-131

■ For use in Bulgaria 584233-261 ■ For use in Russia 584233-251

■ For use in Denmark 584233-081 ■ For use in Saudi Arabia 584233-171

■ For use in France 584233-051 ■ For use in Slovakia 584233-221

■ For use in Germany 584233-041 ■ For use in Slovenia 584233-BA1

■ For use in Greece 584233-DJ1 ■ For use in South Korea 584233-AD1

■ For use in Hungary 584233-211 ■ For use in Spain 584233-071

■ For use in Iceland 584233-DD1 ■ For use in Sweden and Finland 584233-B71

■ For use in Israel 584233-BB1 ■ For use in Switzerland 584233-BG1

■ For use in Italy 584233-061 ■ For use in Taiwan 584233-AB1

■ For use in Japan 584233-291 ■ For use in Thailand 584233-281

■ For use in the Netherlands 584233-B31 ■ For use in Turkey 584233-141

■ For use in Norway 584233-091 ■ For use in the United Kingdom 584233-031

For use only with HP Compaq 6445b and 6440b computer models not equipped with a pointing stick:

■ For use in Brazil 583292-201 ■ For use in Latin America 583292-161

■ For use in French Canada 583292-121 ■ For use in the United States 583292-001

(Continued)

Keyboard for use in country 
or region Spare part number

Keyboard for use in country 
or region Spare part number
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Removal and replacement procedures
Before removing the keyboard, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

Remove the keyboard:

1. Position the computer with the front toward you.

2. Loosen the three Phillips PM2.5×11.0 captive screws that secure the keyboard to the computer.

For use only with HP Compaq 6440b computer models not equipped with a pointing stick:

■ For use in Belgium 583292-A41 ■ For use in Portugal 583292-131

■ For use in Bulgaria 583292-261 ■ For use in Russia 583292-251

■ For use in Denmark 583292-081 ■ For use in Saudi Arabia 583292-171

■ For use in France 583292-051 ■ For use in Slovakia 583292-221

■ For use in Germany 583292-041 ■ For use in Slovenia 583292-BA1

■ For use in Greece 583292-DJ1 ■ For use in South Korea 583292-AD1

■ For use in Hungary 583292-211 ■ For use in Spain 583292-071

■ For use in Iceland 583292-DD1 ■ For use in Sweden and Finland 583292-B71

■ For use in Israel 583292-BB1 ■ For use in Switzerland 583292-BG1

■ For use in Italy 583292-061 ■ For use in Taiwan 583292-AB1

■ For use in Japan 583292-291 ■ For use in Thailand 583292-21

■ For use in the Netherlands 583292-B31 ■ For use in Turkey 583292-141

■ For use in Norway 583292-091 ■ For use in the United Kingdom 583292-031

■ For use in French Canada 583292-121 ■ For use in the United States 583292-001

Keyboard for use in country 
or region Spare part number

Keyboard for use in country 
or region Spare part number
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Removal and replacement procedures
3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Slide the four keyboard tabs 1 forward.

6. Lift the rear edge of the keyboard 2, and then swing it up and forward until it rests upside down on the 
palm rest.

7. Release the zero insertion force (ZIF) connector to which the pointing stick cable 1 is attached, and then 
disconnect the pointing stick cable from the system board.

8. Release the ZIF connector to which the keyboard cable 2 is attached, and then disconnect the keyboard cable 
from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Removal and replacement procedures
Primary memory module

Before removing the primary memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the keyboard (see “Keyboard” on page 4-25).

Description Spare part number

For use only with HP Compaq 6545b and 6445b computer models:

■ 4096-MB (800-MHz, DDR2) 598855-001

■ 2048-MB (800-MHz, DDR2) 598858-001

■ 1024-MB (800-MHz, DDR2) 598861-001

For use only with HP Compaq 6540b and 6440b computer models:

■ 4096-MB (1333-MHz, DDR3) 599092-002

■ 2048-MB (1333-MHz, DDR3) 598856-002

■ 1024-MB (1333-MHz, DDR3) 598859-002
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Removal and replacement procedures
Remove the primary memory module:

1. Position the computer with the front toward you.

2. Pull away the retention clips 1 on each side of the memory module to release the memory module. 
(The memory module tilts up.)

Ä
CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch the components on the 
memory module.

3. Grasp the edge of the memory module 2, and then pull it out of the memory module slot.

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory 
module slot.

Reverse this procedure to install a memory module.
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Removal and replacement procedures
RTC battery

Before removing the RTC battery, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the keyboard (see “Keyboard” on page 4-25).

Remove the RTC battery:

1. Disconnect the RTC battery cable 1 from the system board.

2. Detach the RTC battery 2 from the clip built into the top cover. (The RTC battery is attached to the top cover 
with double-sided tape.)

Reverse this procedure to install the RTC battery.

Description Spare part number

For use only with HP Compaq 6545b computer models 583268-001

For use only with HP Compaq 6540b computer models 593860-001

For use only with HP Compaq 6445b computer models 583268-001

For use only with HP Compaq 6440b computer models 593861-001
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Removal and replacement procedures
Switch cover

✎ The switch cover spare part kit includes the capacitive board and cable.

Before removing the switch cover, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the keyboard (see “Keyboard” on page 4-25).

Remove the switch cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the three Phillips PM2.0×3.0 screws that secure the switch cover to the computer.

Description Spare part number

For use only with HP Compaq 6545b computer models 583268-001

For use only with HP Compaq 6540b computer models 593860-001

For use only with HP Compaq 6445b computer models 583268-001

For use only with HP Compaq 6440b computer models 593861-001
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Removal and replacement procedures
3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Release the ZIF connector to which the LED board cable 1 is attached, and then disconnect the LED board 
cable from the system board.

6. Lift the left and right sides of the switch cover 2 until it detaches from the computer.

7. Remove the switch cover.

Reverse this procedure to install the switch cover.
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Removal and replacement procedures
Power button board

Before removing the power button board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the switch cover (see “Switch cover” on page 4-33).

Remove the power button board:

1. Turn the switch cover upside down, with the rear toward you.

2. Release the ZIF connector to which the power button board cable is attached, and then disconnect the power 
button board cable 1 from the capacitive board.

3. Remove the two Phillips PM2.0×3.0 screws 2 that secure the power button board to the switch cover.

4. Remove the power button board 3 and cable.

Reverse this procedure to install the power button board.

Description Spare part number

For use only with HP Compaq 6545b computer models 583268-001

For use only with HP Compaq 6445b computer models 583267-001

For use only with HP Compaq 6540b and 6440b computer models 593838-001
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Removal and replacement procedures
Palm rest

Before removing the palm rest, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the mass storage device (see “Mass storage device” on page 4-11).

Remove the palm rest:

1. Turn the computer upside down, with the front toward you.

2. Remove the two rubber screw covers 1. The rubber screw covers are included in the Rubber Kit, spare part 
number 583280-001.

3. Remove the four slotted Torx T8M2.5×7.0 screws 2 that secure the palm rest to the computer.

Description Spare part number

For use only with HP Compaq 6545b computer models equipped with a fingerprint reader (includes 
fingerprint reader board and cable)

583285-001

For use only with HP Compaq 6545b and 6540b computer models not equipped with a 
fingerprint reader

583286-001

For use only with HP Compaq 6540b computer models equipped with a fingerprint reader (includes 
fingerprint reader board and cable)

593874-001

For use only with HP Compaq 6445b computer models equipped with a fingerprint reader (includes 
fingerprint reader board and cable)

583287-001

For use only with HP Compaq 6445b and 6440b computer models not equipped with a 
fingerprint reader

583288-001

For use only with HP Compaq 6440b computer models equipped with a fingerprint reader (includes 
fingerprint reader board and cable)

593876-001
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Removal and replacement procedures
4. Turn the computer display-side up, with the front toward you.

5. Open the computer as far as possible.

6. If the computer is equipped with a fingerprint reader, release the ZIF connector to which the fingerprint reader 
board cable 1 is attached, and then disconnect the fingerprint reader board cable2 from the system board.

7. Lift the front edge of the palm rest 3 until it rests at an angle, and then slide the palm rest forward 4 until it 
detaches from the computer.

8. If the computer is equipped with a fingerprint reader, remove the fingerprint reader board cable from the 
opening 5 in the top cover.

9. Remove the palm rest.

Reverse this procedure to install the palm rest.
Maintenance and Service Guide 4–37



Removal and replacement procedures
TouchPad

✎ The TouchPad spare part kit includes a TouchPad board cable and TouchPad button board cable.

Before removing the TouchPad, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the mass storage device cover (see “Mass storage device” on page 4-11).

6. Remove the palm rest (see “Palm rest” on page 4-36).

Remove the TouchPad:

1. Lift the rear edge of the TouchPad 1, and swing it up and forward until it rests upside down on the computer.

2. Release the ZIF connector to which the TouchPad button board cable is attached, and then disconnect the 
TouchPad button board cable 2 from the TouchPad board.

3. Release the ZIF connector to which the TouchPad cable is attached, and then disconnect the TouchPad cable 3 
from the system board.

Reverse this procedure to install the TouchPad.

Description Spare part number

For use only with HP Compaq 6545b computer models 583275-001

For use only with HP Compaq 6540b computer models 593866-001

For use only with HP Compaq 6445b computer models 583276-001

For use only with HP Compaq 6440b computer models 593867-001
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Removal and replacement procedures
Fan

✎ To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of the computer. The 
computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to 
turn on automatically when high temperature conditions exist. These conditions are affected by high external 
temperatures, system power consumption, power management/battery conservation configurations, battery fast 
charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side 
of the computer. 

Before removing the fan, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the keyboard (see “Keyboard” on page 4-25).

6. Remove the switch cover (see “Switch cover” on page 4-33).

Remove the fan:

1. Disconnect the fan cable 1 from the system board.

2. Remove the two slotted Torx T8M2.5×7.0 screws 2 that secure the fan to the system board.

3. Remove the fan 3.

Reverse this procedure to install the fan.

Description Spare part number

Fan 583266-001
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Heat sink

✎ The heat sink spare part kit includes replacement thermal material.

Before removing the heat sink, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Keyboard (see “Keyboard” on page 4-25)

b. Switch cover (see “Switch cover” on page 4-33)

c. Fan (see “Fan” on page 4-39)

Description Spare part number

For use only with HP Compaq 6545b and 6445b computer models 583265-001

For use only with HP Compaq 6540b and 6440b computer models equipped with discrete graphics 
subsystem memory

593879-001

For use only with HP Compaq 6540b and 6440b computer models equipped with UMA graphics 
subsystem memory

593878-001
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Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four Phillips PM2.5×9.0 captive 
screws 1 that secure the heat sink to the system board.

✎Due to the adhesive quality of the thermal material located between the heat sink and system board 
components, it may be necessary to move the heat sink from side to side to detach it.

2. Lift the right side of the heat sink 2 until it rests at an angle.

3. Release the heat sink 3 by sliding it up and to the right at an angle.

4. Remove the heat sink.
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✎The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board 
each time the heat sink is removed:
❏ Thermal paste is used on the processor 1 and the heat sink section 2 that services it.
❏ Thermal pads are used on the Northbridge chip 3 and the heat sink section 4 that services it.
❏ Thermal pads are used on the Southbridge chip 5 and the heat sink section 6 that services it.

Replacement thermal material is included with all system board and heat sink spare part kits.

Reverse this procedure to install the heat sink.
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Processor

✎ The processor spare part kit includes replacement thermal material.

Before removing the processor, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Keyboard (see “Keyboard” on page 4-25)

b. Switch cover (see “Switch cover” on page 4-33)

c. Fan (see “Fan” on page 4-39)

d. Heat sink (see “Heat sink” on page 4-40)

Description Spare part number

For use only with HP Compaq 6545b and 6445b computer models:

■ AMD Turion II Ultra M620 2.5-GHz processor (35W, 2-MB L2 cache) 576255-001

■ AMD Turion II Ultra M600 2.3-GHz processor (35W, 2-MB L2 cache) 576254-001

■ AMD Turion II M540 2.4-GHz processor (35W, 1-MB L2 cache) 587257-001

■ AMD Turion II M520 2.2-GHz processor (35W, 1-MB L2 cache) 576253-001

■ AMD Athlon II M340 2.2-GHz processor (35W, 1-MB L2 cache) 587255-001

■ AMD Athlon II M320 2.1-GHz processor (35W, 1-MB L2 cache) 576252-001

■ AMD Sempron M120 2.1-GHz processor (25W, 512-KB L2 cache) 587256-001

■ AMD Sempron M100 1.9-GHz processor (25W, 512-KB L2 cache) 576251-001

For use only with HP Compaq 6540b and 6440b computer models:

■ Intel Core i7 720QM 1.60-GHz processor (turbo up to 2.80-GHz; 45W, 6-MB L3 cache, 8 threads) 603011-001

■ Intel Core i7 620M 2.66-GHz processor (turbo up to 3.33-GHz; 35W, 4-MB L3 cache, 4 threads) 603010-001

■ Intel Core i5 540M 2.53-GHz processor (turbo up to 3.06-GHz; 35W, 3-MB L3 cache, 4 threads) 594646-001

■ Intel Core i5 520M 2.40-GHz processor (turbo up to 2.93-GHz; 35W, 3-MB L3 cache, 4 threads) 594645-001

■ Intel Core i5 430M 2.26-GHz processor (turbo up to 2.53-GHz; 35W, 3-MB L3 cache, 4 threads) 595585-001

■ Intel Core i3 350M 2.26-GHz processor (turbo up to 2.40-GHz; 35W, 3-MB L3 cache, 4 threads) 595586-001

■ Intel Core i3 330M 2.13-GHz processor (turbo up to 2.33-GHz; 35W, 3-MB L3 cache, 4 threads) 595587-001
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Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw 1 one-half turn counterclockwise, until you 
hear a click. 

2. Lift the processor 2 straight up and remove it. 

✎When you install the processor, the gold triangle 3 on the processor must be aligned with the triangle 4 
embossed on the processor socket. 

Reverse this procedure to install the processor.
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Display assembly

✎ The display assembly spare part kit includes 3 WLAN antenna transceivers and cables, microphones, nameplate, 
and logo.

Description Spare part number

For use only with HP Compaq 6545b computer models:

■ 15.6-in, HD+, LED, WVA display assembly for use only with computer models equipped with a 
webcam and WWAN functionality (includes 2 WWAN antenna transceivers and cables)

584230-001

■ 15.6-in, HD+, LED, WVA display assembly for use only with computer models equipped with 
WWAN functionality but not equipped with a webcam (includes 2 WWAN antenna transceivers 
and cables)

584229-001

■ 15.6-in, HD+, LED, AntiGlare display assembly for use only with computer models equipped with 
a webcam

583225-001

■ 15.6-in, HD+, LED, AntiGlare display assembly for use only with computer models not equipped 
with a webcam

583222-001

■ 15.6-in, HD, LED, WVA display assembly for use only with computer models equipped with a 
webcam (includes 2 WWAN antenna transceivers and cables)

584228-001

■ 15.6-in, HD, LED, WVA display assembly for use only with computer models not equipped with a 
webcam (includes 2 WWAN antenna transceivers and cables)

584227-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with 
a webcam

583223-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models not equipped 
with a webcam

583220-001

For use only with HP Compaq 6540b computer models:

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with a 
webcam and WWAN functionality (includes 2 WWAN antenna transceivers and cables)

594005-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with 
WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers and cables)

594004-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with a 
webcam but not equipped with WWAN functionality

593996-001

■ 15.6-in, HD, LED, AntiGlare display assembly for use only with computer models not equipped 
with a webcam or with WWAN functionality

593995-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models not 
equipped with a webcam or with WWAN functionality

593999-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers 
and cables)

594002-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

594003-001

■ 15.6-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers 
and cables)

594006-001

■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models equipped with 
a webcam and WWAN functionality (includes 2 WWAN antenna transceivers and cables)

594001-001

■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models equipped with 
WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers and cables)

594000-001

(Continued)
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■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models equipped with 
a webcam but not equipped with WWAN functionality

593998-001

■ 15.6-in, HD, LED, BrightView display assembly for use only with computer models not equipped 
with a webcam or with WWAN functionality

593997-001

■ 15.6-in, HD, LED, LVDS BrightView display assembly 623182-001

■ 15.6-in, HD, LED, SVA, LVDS AntiGlare display assembly 623181-001

■ 15.6-in, HD+, LED, WVA, LVDS AntiGlare display assembly 624643-001

For use only with HP Compaq 6445b computer models:

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with a 
webcam (includes 2 WWAN antenna transceivers and cables)

584232-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models not equipped 
with a webcam (includes 2 WWAN antenna transceivers and cables)

584231-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with a 
webcam

583228-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models not equipped 
with a webcam

583226-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models not 
equipped with a webcam

600753-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam

600754-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models with 
WWAN functionality but not a webcam

617448-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality

617449-001

For use only with HP Compaq 6440b computer models:

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam and WWAN functionality (includes 2 WWAN antenna transceivers and 
cables)

594018-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers 
and cables)

594014-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models 
equipped with a webcam but not equipped with WWAN functionality

594015-001

■ 14.0-in, HD+, LED, WVA, AntiGlare display assembly for use only with computer models not 
equipped with a webcam or with WWAN functionality

594011-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with a 
webcam and WWAN functionality (includes 2 WWAN antenna transceivers and cables)

594017-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with 
WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers and cables)

594016-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models equipped with a 
webcam but not equipped with WWAN functionality

594008-001

■ 14.0-in, HD, LED, AntiGlare display assembly for use only with computer models not equipped 
with a webcam or with WWAN functionality

594007-001

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models equipped with 
a webcam and WWAN functionality (includes 2 WWAN antenna transceivers and cables)

594013-001

(Continued)

Description Spare part number
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Before removing the display assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Disconnect the antenna cables from the WLAN (see “WLAN module” on page 4-16) and WWAN modules 
(see “WWAN module” on page 4-21).

6. Remove the keyboard (see “Keyboard” on page 4-25).

7. Remove the switch cover (see “Switch cover” on page 4-33).

Remove the display assembly:

1. Close the computer.

2. Position the computer with the rear panel toward you.

3. Remove the four slotted Torx T8M2.5×11.0 screws that secure the display assembly to the computer.

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models equipped with 
WWAN functionality but not a webcam (includes 2 WWAN antenna transceivers and cables)

594012-001

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models equipped with 
a webcam but not equipped with WWAN functionality

594010-001

■ 14.0-in, HD, LED, BrightView display assembly for use only with computer models not equipped 
with a webcam or with WWAN functionality

594009-001

■ 14.0-in, HD, LED, SVA, LVDS BrightView display assembly 592144-001

■ 14.0-in, HD, LED, SVA, LVDS AntiGlare display assembly for use only with HP Compaq 6440b 
computer models

623176-001

■ 14.0-in, HD, LED, SVA, LVDS AntiGlare display assembly 624236-001

Description Spare part number
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4. Turn the computer display-side up, with the front toward you.

5. Open the computer as far as possible.

6. Disconnect the microphone cable 1 from the system board.

7. Remove the microphone cable from the clips and routing channel 2 built into the top cover.

8. Disconnect the display panel cable 3 from the system board.
4–48 Maintenance and Service Guide



Removal and replacement procedures
9. Release the wireless antenna cables from the opening in the top cover 1.

10. Remove the wireless antenna cables from the clips 2 and routing channel built into the top cover.

Ä
CAUTION: Support the display assembly when removing the following screws. Failure to support the display assembly can 
result in damage to the display assembly and other computer components.

11. Remove the two slotted Torx T8M2.5×11.0 screws 1 that secure the display assembly to the base enclosure.

12. Lift the display assembly 2 straight up and remove it.
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13. If it is necessary to replace the display bezel or any of the display assembly internal components:

a. Remove the eight rubber screw covers 1. The rubber screw covers are included in the Rubber Kit, spare 
part number 583280-001.

b. Remove the eight Phillips PM2.5×6.0 screws 2 that secure the display bezel to the display assembly.

c. Slide and hold the display release latch 1 to the right.

d. Flex the inside edges of the top edge 2, the left and right sides 3, and the bottom edge 4 of the display 
bezel until the bezel disengages from the display enclosure.

e. Remove the display bezel 5. The display bezel is available using the following spare part numbers:

◆ 583235-001—for use only with HP Compaq 6545b computer models equipped with a webcam

◆ 583236-001—for use only with HP Compaq 6545b computer models not equipped with a webcam

◆ 593847-001—for use only with HP Compaq 6540b computer models equipped with a webcam

◆ 593848-001—for use only with HP Compaq 6540b computer models not equipped with a webcam

◆ 583237-001—for use only with HP Compaq 6445b computer models equipped with a webcam

◆ 583238-001—for use only with HP Compaq 6445b computer models not equipped with a webcam

◆ 593849-001—for use only with HP Compaq 6440b computer models equipped with a webcam

◆ 593850-001—for use only with HP Compaq 6440b computer models not equipped with a webcam
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✎When installing the display bezel, it may be necessary to replace the double-sided tape that secures 
the bezel to the display enclosure. The tape should be installed in the locations shown in the 
following illustration.

14. If it is necessary to replace the webcam module:

a. Release the webcam module 1 as far from the display enclosure as the webcam module cable allows. 
(The webcam module is attached to the display enclosure with double-sided tape.)

b. Disconnect the webcam module cable 2 from the webcam module.

c. Remove the webcam module 3. The webcam module is available using spare part number 583219-001.
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15. If it is necessary to replace the display panel cable or display hinges:

a. Remove the two Phillips PM2.5×6.0 screws that secure the display panel to the display enclosure.

b. Lift the top edge of the display panel 1, and then swing it up and forward until it rests upside down in front 
of the display enclosure.

c. Release the support strip 2 and locking bar 3 that secure the display panel cable to the display panel.

d. Disconnect the display panel cable 4 from the display panel.

e. Remove the display panel.
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f. Release the tabs 1 built into the display enclosure shielding that secure the display panel cable to the 
display enclosure.

g. Release the display panel cable from the clips 2 and routing channel built into the bottom edge of the 
display enclosure.

h. Remove the display panel cable 3. The display panel cable is included in the Display Cable Kit, using the 
following spare part numbers:

◆ 583956-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD+ 
display assembly

◆ 583230-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD 
display assembly

◆ 593990-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD+ 
display assembly

◆ 583231-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD 
display assembly

✎Substeps i and j apply only to HP Compaq 6545b and 6540b computer models.
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i. Remove the eight Phillips PM2.0×3.0 screws 1 that secure the display hinges to the display panel.

j. Remove the display hinges 2. The display hinges are available in the Display Hinge Kit, spare part 
numbers 583232-001 (for use only with HP Compaq 6545b and 6540b computer models) and 583959-001 
(for use only with HP Compaq 6445b and 6440b computer models).

✎Substeps k and l apply only to HP Compaq 6445b and 6440b computer models.

k. Remove the six Phillips PM2.0×3.0 screws 1 that secure the display hinges to the display panel.

l. Remove the display hinges 2. The display hinges are available in the Display Hinge Kit, spare part 
numbers 583232-001 (for use only with HP Compaq 6545b and 6540b computer models) and 583959-001 
(for use only with HP Compaq 6445b and 6440b computer models).
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m. Remove the two Phillips PM2.0×3.0 screws 1 that secure the display hinge covers to the display hinges.

n. Remove the display hinge covers 2 by sliding them off of the display hinges. The display hinge covers are 
available in the Display Hinge Kit, spare part numbers 583232-001 (for use only with HP Compaq 6545b 
and 6540b computer models) and 583959-001 (for use only with HP Compaq 6445b and 6440b computer 
models).
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16. If it is necessary to replace the WLAN antenna transceivers and cables:

a. Release the tabs 1 built into the display enclosure shielding that secure the WLAN antenna cables.

b. Detach the WLAN antenna transceivers 2 from the display enclosure. (The transceivers are attached to the 
enclosure with double-sided tape.)

c. Remove the WLAN antenna transceivers and cables 3. The WLAN antenna transceivers and cables are 
included in the Display Cable Kit, using the following spare part numbers:

◆ 583956-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD+ 
display assembly

◆ 583230-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD 
display assembly

◆ 593990-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD+ 
display assembly

◆ 583231-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD 
display assembly
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17. If it is necessary to replace the WWAN antenna transceivers and cables:

a. Release the tabs 1 built into the display enclosure shielding that secure the WWAN antenna cables.

b. Detach the WWAN antenna transceivers 2 from the display enclosure. (The transceivers are attached to the 
enclosure with double-sided tape.)

c. Remove the WWAN antenna transceivers and cables 3. The WWAN antenna transceivers and cables are 
included in the Display Cable Kit, using the following spare part numbers:

◆ 583956-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD+ 
display assembly

◆ 583230-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD 
display assembly

◆ 593990-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD+ 
display assembly

◆ 583231-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD 
display assembly
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18. If it is necessary to replace the microphones and cables:

a. Release the tabs 1 built into the display enclosure shielding that secure the microphone cables.

b. Release the microphone receivers from the clips 2 built into the display enclosure.

c. Release the microphone cables from the clips and routing channel 3 built into the bottom edge of the 
display enclosure.

d. Remove the microphones and cables 4. The microphones and cables are included in the Display Cable Kit, 
using the following spare part numbers:

◆ 583956-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD+ 
display assembly

◆ 583230-001—for use only with HP Compaq 6545b and 6540b computer models equipped with an HD 
display assembly

◆ 593990-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD+ 
display assembly

◆ 583231-001—for use only with HP Compaq 6445b and 6440b computer models equipped with an HD 
display assembly

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Palm rest (see “Palm rest” on page 4-36)

g. TouchPad (see “TouchPad” on page 4-38)

h. Display assembly (see “Display assembly” on page 4-45)

Description Spare part number

For use only with HP Compaq 6545b computer models equipped with a pointing stick 583271-001

For use only with HP Compaq 6545b computer models not equipped with a pointing stick 583272-001

For use only with HP Compaq 6540b computer models equipped with a pointing stick 593862-001

For use only with HP Compaq 6540b computer models not equipped with a pointing stick 593863-001

For use only with HP Compaq 6445b computer models equipped with a pointing stick 583273-001

For use only with HP Compaq 6545b computer models not equipped with a pointing stick 583274-001

For use only with HP Compaq 6440b computer models equipped with a pointing stick 593864-001

For use only with HP Compaq 6540b computer models not equipped with a pointing stick 593865-001
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Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the five slotted Torx T8M2.5×7.0 screws 1 (in the mass storage device bay) and the five Phillips 
PM2.0×3.0 screws 2 (in the optical drive and battery bays) that secure the top cover to the base enclosure.

3. Turn the computer right-side up, with the front toward you.

✎Step 4 applies only to HP Compaq 6545b and 6540b computer models.

4. Remove the nine slotted Torx T8M2.5×7.0 screws 1 and the two slotted Torx T8M2.5×11.0 screws 2 that 
secure the top cover to the base enclosure.
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✎Step 5 applies only to HP Compaq 6445b and 6440b computer models.

5. Remove the six slotted Torx T8M2.5×7.0 screws 1 and the two slotted Torx T8M2.5×11.0 screws 2 that 
secure the top cover to the base enclosure.

6. Lift the rear edge 1 of the top cover until it detaches from the base enclosure.

7. Remove the top cover 2 by lifting it straight up.

Reverse this procedure to install the top cover. 
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Smart Card Reader

Before removing the Smart Card Reader, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Palm rest (see “Palm rest” on page 4-36)

g. TouchPad (see “TouchPad” on page 4-38)

h. Display assembly (see “Display assembly” on page 4-45)

i. Top cover (see “Top cover” on page 4-59)

Remove the Smart Card Reader:

1. Use a flat-bladed screwdriver 1 to release the hooks 2 on each side of the Smart Card Reader from the edges 
of the base enclosure.

2. Press in on the Smart Card Reader 3 to release it from the ExpressCard assembly.

3. Remove the Smart Card Reader 4 from the ExpressCard assembly.

Reverse this procedure to install the Smart Card Reader.

Description Spare part number

Smart Card Reader (factory-installed on select models only) 591698-001
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ExpressCard assembly

Before removing the ExpressCard assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Palm rest (see “Palm rest” on page 4-36)

g. TouchPad (see “TouchPad” on page 4-38)

h. Display assembly (see “Display assembly” on page 4-45)

i. Top cover (see “Top cover” on page 4-59)

j. Speaker assembly (only on HP Compaq 6445b and 6440b computer models, see “Speaker assembly” on 
page 4-68)

Description Spare part number

For use only with HP Compaq 6545b computer models 583290-001

For use only with HP Compaq 6540b computer models 593868-001

For use only with HP Compaq 6445b computer models 583291-001

For use only with HP Compaq 6440b computer models 593869-001
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Remove the ExpressCard assembly:

✎ Steps 1 through 3 apply only to HP Compaq 6545b and 6540b computer models. See steps 4 and 5 for 
information on removing the ExpressCard assembly on HP Compaq 6445b and 6440b computer models.

1. Disconnect the speaker cable 1 from the ExpressCard assembly.

2. Lift the right side 2 of the ExpressCard assembly to disconnect it from the system board.

3. Remove the ExpressCard assembly 3 by sliding it up and to the right.
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✎Steps 4 and 5 apply only to HP Compaq 6445b and 6440b computer models.

4. Lift the right side 1 of the ExpressCard assembly to disconnect it from the system board.

5. Remove the ExpressCard assembly 2 by sliding it up and to the right.

Reverse this procedure to install the ExpressCard assembly.
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Modem module

✎ The modem module spare part kit does not include a modem module cable. The modem module cable is 
included in the Cable Kit, spare part numbers 583282-001 (for use only with HP Compaq 6545b and 6540b 
computer models) and 583957-001 (for use only with HP Compaq 6445b and 6440b computer models).

Before removing the modem module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Palm rest (see “Palm rest” on page 4-36)

g. TouchPad (see “TouchPad” on page 4-38)

h. Display assembly (see “Display assembly” on page 4-45)

i. Top cover (see “Top cover” on page 4-59)

Description Spare part number

For use in all countries and regions except Australia and New Zealand 510100-001

For use only in Australia and New Zealand 510100-011
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Remove the modem module:

1. Remove the Phillips PM2.0×5.0 screw 1 that secures the modem module to the system board.

2. Lift the right side 2 of the modem module to disconnect it from the system board.

3. Disconnect the modem module cable 3 from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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Speaker assembly

✎ The speaker assembly spare part kit includes a cable.

Before removing the speaker assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Palm rest (see “Palm rest” on page 4-36)

g. TouchPad (see “TouchPad” on page 4-38)

h. Display assembly (see “Display assembly” on page 4-45)

i. Top cover (see “Top cover” on page 4-59)

j. ExpressCard assembly (only on HP Compaq 6545b and 6540b computer models, see “ExpressCard 
assembly” on page 4-63)

Description Spare part number

For use only with HP Compaq 6545b and 6540b computer models 583283-001

For use only with HP Compaq 6445b and 6440b computer models 583284-001
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Remove the speaker assembly:

✎ Steps 1 and 2 apply only to HP Compaq 6545b and 6540b computer models. See steps 3 through 5 for speaker 
assembly removal information for HP Compaq 6445b and 6440b computer models.

1. Remove the slotted Torx T8M2.5×7.0 screw 1 that secures the speaker assembly to the base enclosure.

2. Remove the speaker assembly 2.

✎ Steps 3 through 5 apply only to HP Compaq 6445b and 6440b computer models.

3. Disconnect the speaker cable 1 from the ExpressCard assembly.

4. Remove the slotted Torx T8M2.5×7.0 screw 2 that secures the speaker assembly to the base enclosure.

5. Remove the speaker assembly 3.

Reverse this procedure to install the speaker assembly.
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Bluetooth module cable

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module cable is 
included in the Cable Kit, using the following spare part numbers:
■ 583282-001—for use only with HP Compaq 6545b computer models
■ 593853-001—for use only with HP Compaq 6540b computer models
■ 583957-001—for use only with HP Compaq 6445b computer models
■ 593854-001—for use only with HP Compaq 6440b computer models

Before removing the Bluetooth module cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Palm rest (see “Palm rest” on page 4-36)

g. TouchPad (see “TouchPad” on page 4-38)

h. Display assembly (see “Display assembly” on page 4-45)

i. Top cover (see “Top cover” on page 4-59)
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Remove the Bluetooth module cable:

1. Disconnect the Bluetooth module cable 1 from the system board.

2. Remove the Bluetooth module cable from the clips and routing channel 2 built into the base enclosure.

Reverse this procedure to install the Bluetooth module cable.
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Card reader/USB board

✎ The card reader/USB board spare part kit includes a cable.

Before removing the card reader/USB board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Palm rest (see “Palm rest” on page 4-36)

g. TouchPad (see “TouchPad” on page 4-38)

h. Display assembly (see “Display assembly” on page 4-45)

i. Top cover (see “Top cover” on page 4-59)

Description Spare part number

For use only with HP Compaq 6545b computer models 583960-001

For use only with HP Compaq 6540b computer models 593870-001

For use only with HP Compaq 6445b computer models 583961-001

For use only with HP Compaq 6440b computer models 593871-001
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Remove the card reader/USB board:

1. Release the ZIF connector to which the card reader/USB board cable is attached, and then disconnect the card 
reader/USB board cable 1 from the system board.

2. Remove the slotted Torx T8M2.5×7.0 screw 2 that secures the card reader/USB board to the base enclosure.

3. Lift the left side 3 of the card reader/USB board to release the connectors from the openings in the base 
enclosure.

4. Remove the card reader/USB board by sliding it up and to the left 4.

Reverse this procedure to install the card reader/USB board.
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System board

✎ The system board spare part kit includes replacement thermal material.

Before removing the system board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

Description Spare part number

For use only with HP Compaq 6545b computer models 583257-001

For use only with HP Compaq 6445b computer models 583261-001

For use only with HP Compaq 6540b computer models equipped with discrete graphics subsystem 
memory in all countries and regions except the People’s Republic of China and Russia (includes 
64-MB of graphics subsystem memory)

593839-001

For use only with HP Compaq 6545b and 6540b computer models equipped with UMA graphics 
subsystem memory in the People’s Republic of China and Russia (includes 64-MB of graphics 
subsystem memory; includes replacement thermal material)

603189-001

For use only with HP Compaq 6540b computer models equipped with discrete graphics subsystem 
memory in the People’s Republic of China and Russia (includes 64-MB of graphics subsystem 
memory)

603190-001

For use only with HP Compaq 6540b computer models equipped with UMA graphics subsystem 
memory in all countries and regions except the People’s Republic of China and Russia (includes 
64-MB of graphics subsystem memory)

593840-001

For use only with HP Compaq 6540b computer models equipped with UMA graphics subsystem 
memory in the People’s Republic of China and Russia (includes 64-MB of graphics subsystem 
memory)

603192-001

For use only with HP Compaq 6440b computer models equipped with discrete graphics subsystem 
memory in all countries and regions except the People’s Republic of China and Russia (includes 
64-MB of graphics subsystem memory)

593841-001

For use only with HP Compaq 6440b computer models equipped with discrete graphics subsystem 
memory in the People’s Republic of China and Russia (includes 64-MB of graphics 
subsystem memory)

603191-001

For use only with HP Compaq 6440b computer models equipped with UMA graphics subsystem 
memory in all countries and regions except the People’s Republic of China and Russia (includes 
64-MB of graphics subsystem memory)

593842-001

For use only with HP Compaq 6440b computer models equipped with UMA graphics subsystem 
memory in the People’s Republic of China and Russia (includes 64-MB of graphics 
subsystem memory)

603193-001
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f. Fan (see “Fan” on page 4-39)

g. Heat sink (see “Heat sink” on page 4-40)

h. Palm rest (see “Palm rest” on page 4-36)

i. TouchPad (see “TouchPad” on page 4-38)

j. Display assembly (see “Display assembly” on page 4-45)

k. Top cover (see “Top cover” on page 4-59)

l. ExpressCard assembly (see “ExpressCard assembly” on page 4-63)

m. Speaker assembly (see “Speaker assembly” on page 4-68)

n. Card reader/USB board (see “Card reader/USB board” on page 4-72)

When replacing the system board, be sure that the following additional components are removed from the defective 
system board and installed on the replacement system board: 

■ SIM (see “SIM” on page 4-8)

■ Expansion and primary memory modules (see “Expansion memory module” on page 4-14 and “Primary 
memory module” on page 4-30)

■ WLAN module (see “WLAN module” on page 4-16)

■ WWAN module (see “WWAN module” on page 4-21)

■ RTC battery (see “RTC battery” on page 4-32)

■ Processor (see “Processor” on page 4-43)

■ Modem module (see “Modem module” on page 4-66)

■ Bluetooth module cable (see “Bluetooth module cable” on page 4-70)
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Remove the system board:

1. Disconnect the following cables:

❏ Bluetooth module cable 1 from the system board

❏ Modem module cable 2 from the modem module

❏ External monitor cable 3 from the system board

2. Remove the three slotted Torx T8M2.5×7.0 screws 1 and 2 that secure the system board to the base 
enclosure. The front-most screw 2 is present only on HP Compaq 6545b and 6540b computer models.
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3. Use the middle of the system board 1 to lift the right side 2 of the system board until it rests at an angle.

4. Remove the system board 3 by sliding it away from the base enclosure at an angle.

Ä
CAUTION: Do not attempt to remove the optical drive connector board from the system board until after the system board has 
been removed from the base enclosure. Failure to follow this caution can result in damage to the system board and the optical 
drive connector board.

5. If it is necessary to replace the optical drive connector board, slide the board off of the system board. The 
optical drive connector board is available using spare part numbers 583252-001 (for use only with HP Compaq 
6545b computer models) and 593873-001 (for use only with HP Compaq 6540b computer models).

Reverse this procedure to install the system board.
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Serial connector and cable

Before removing the serial connector and cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Fan (see “Fan” on page 4-39)

g. Heat sink (see “Heat sink” on page 4-40)

h. Palm rest (see “Palm rest” on page 4-36)

i. TouchPad (see “TouchPad” on page 4-38)

j. Display assembly (see “Display assembly” on page 4-45)

k. Top cover (see “Top cover” on page 4-59)

l. ExpressCard assembly (see “ExpressCard assembly” on page 4-63)

m. Speaker assembly (see “Speaker assembly” on page 4-68)

Description Spare part number

For use only with HP Compaq 6545b and 6445b computer models 583277-001

For use only with HP Compaq 6540b and 6440b computer models 593872-001
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Remove the serial connector and cable:

1. Disconnect the serial connector cable 1 from the system board.

2. Remove the two Hex HM5.0×10.0 screw locks 2 that secure the serial connector to the base enclosure.

3. Remove the serial connector 3.

Reverse this procedure to install the serial connector and cable.
Maintenance and Service Guide 4–79



Removal and replacement procedures
Modem module cable

✎ The modem module cable is included in the Cable Kit, using the following spare part numbers:
■ 583282-001—for use only with HP Compaq 6545b computer models
■ 593853-001—for use only with HP Compaq 6540b computer models
■ 583957-001—for use only with HP Compaq 6445b computer models
■ 593854-001—for use only with HP Compaq 6440b computer models

Before removing the modem module cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Fan (see “Fan” on page 4-39)

g. Heat sink (see “Heat sink” on page 4-40)

h. Palm rest (see “Palm rest” on page 4-36)

i. TouchPad (see “TouchPad” on page 4-38)

j. Display assembly (see “Display assembly” on page 4-45)

k. Top cover (see “Top cover” on page 4-59)

l. ExpressCard assembly (see “ExpressCard assembly” on page 4-63)

m. Speaker assembly (see “Speaker assembly” on page 4-68)

n. Card reader/USB board (see “Card reader/USB board” on page 4-72)

o. System board (see “System board” on page 4-74)
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Remove the modem module cable:

1. Release the RJ-11 connector 1 from the clip built into the base enclosure.

2. Release the modem module cable from the clips 2 and routing channel built into the base enclosure.

3. Remove the modem module cable 3.

Reverse this procedure to install the modem module cable.
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Battery eject latch

✎ The battery eject latch is included in the Battery Latch Kit, spare part number 583239-001. The Battery Latch 
Kit also includes the battery eject spring and the battery eject arm.

Before removing the battery eject latch, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Bluetooth module (see “Bluetooth module” on page 4-9)

b. Mass storage device (see “Mass storage device” on page 4-11)

c. Optical drive (see “Optical drive” on page 4-23)

d. Keyboard (see “Keyboard” on page 4-25)

e. Switch cover (see “Switch cover” on page 4-33)

f. Fan (see “Fan” on page 4-39)

g. Heat sink (see “Heat sink” on page 4-40)

h. Palm rest (see “Palm rest” on page 4-36)

i. TouchPad (see “TouchPad” on page 4-38)

j. Display assembly (see “Display assembly” on page 4-45)

k. Top cover (see “Top cover” on page 4-59)

l. ExpressCard assembly (see “ExpressCard assembly” on page 4-63)

m. Speaker assembly (see “Speaker assembly” on page 4-68)

n. Card reader/USB board (see “Card reader/USB board” on page 4-72)

o. System board (see “System board” on page 4-74)
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Remove the battery eject latch:

1. Remove the battery eject spring from the retention pins 1 and 2 built onto the the battery eject arm.

2. Press on the tabs 1 to release the battery eject latch.

3. Remove the battery eject latch 2.
Maintenance and Service Guide 4–83



Removal and replacement procedures
4. Slide the battery eject arm right hook 1 out of the opening in the base enclosure.

5. Rotate the battery eject arm 2 up and toward the back of the base enclosure until the battery ejeect arm middle 
hook disengages from the base enclosure.

6. Release the right half of the battery eject arm 3 from the base enclosure.

7. Slide the battery eject arm 1 to the right until the arm notch 2 clears the docking connector well built into the 
base enclosure.

8. Lift the right half of the battery eject arm 3 until it clears the screw standoff.

9. Slide the battery eject arm 3 forward until the left hook disengages from the base enclosure.

10. Remove the battery eject arm.
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To replace the battery eject arm, latch, and spring, follow these steps:

1. Install the battery eject arm left hook 1 into the opening in the base enclosure.

2. Position the notch 2 so that it rests just to the left of the docking connector well built into the base enclosure.

3. Slide the battery eject arm 3 to the left.

4. Install the right side of the battery eject arm 4 behind the standoff.

5. Toe the battery eject arm into the base enclosure so that the middle hook 1 and right hook 2 install into the 
openings in the base enclosure.
Maintenance and Service Guide 4–85



Removal and replacement procedures
6. Install the battery eject latch.

7. Install the battery eject spring onto the two retention pins 1 and 2 built onto the battery eject arm.
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5
Computer Setup

Computer Setup in Windows 7

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to 
navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:
■ To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the 

screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the 
on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File menu

Select To do this

System Information ■ View identification information for the computer and the 
batteries in the system.

■ View specification information for the processor, cache and 
memory size, system ROM, video revision, and keyboard 
controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

■ System Information

❐ Identification information for the computer and the 
batteries in the system.

❐ Specification information for the processor, cache and 
memory size, system ROM, video revision, and 
keyboard controller version.

■ Start-up Test—Verifies the system components needed for 
starting the computer.

■ Run-In Test—Runs a comprehensive check on 
system memory.

■ Hard Disk Test—Runs a comprehensive self-test on any 
hard drive in the system.

■ Memory Test—Runs a comprehensive test on any memory 
installed in the computer.

■ Battery Test—Runs a comprehensive test on any batteries 
installed in the computer.

■ Error Log—Displays a log file if any errors have occurred.

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Restore defaults Replace the configuration settings in Computer Setup with 
the original factory settings. (Hard drive mode, password 
settings, and security settings are not changed when you 
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then 
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then 
exit and restart the computer. Your changes go into effect 
when the computer restarts.
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Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models 
only; disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security 
questions and answers used if you forget your password.

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive 
(enabled by default).

■ Change a DriveLock user password or master password.

✎ DriveLock settings are accessible only when you enter 
Computer Setup by turning on (not restarting) 
the computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) 
Embedded Security, which protects the computer from 
unauthorized access to owner functions available in 
Embedded Security for ProtectTools. For more information, 
refer to the ProtectTools software Help.

✎ You must have a setup password to change 
this setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary 
hard drive or the drive in the upgrade bay.

Ä If you run Disk Sanitizer, the data on the selected drive 
is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and 
ownership tag.
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System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds).

■ Enable/disable MultiBoot (enabled by default).

■ Set the Express Boot Popup delay in seconds.

■ Enable/disable Custom Logo (disabled by default).

■ Enable/disable Display Diagnostic URL (enabled 
by default).

■ Enable/disable CD-ROM boot (disabled by default).

■ Enable/disable SD Card boot (enabled by default).

■ Enable/disable floppy boot (enabled by default).

■ Enable/disable PXE Internal NIC boot (enabled by default).

■ Enable/Disable Unified Extensible Firmware Interface 
(UEFI) Boot Mode (disabled by default).

■ Set the Legacy Boot Order.

Device Configurations ■ Enable/disable USB legacy support (enabled by default). 
When enabled, USB legacy support allows the following:

❐ Use of a USB keyboard in Computer Setup even when a 
Windows operating system is not running

❐ Startup from bootable USB devices, including a hard 
drive, diskette drive, or optical drive connected by a USB 
port to the computer

■ Select a parallel port mode: ECP (Enhanced 
Capabilities Port), standard, bidirectional, or EPP 
(Enhanced Parallel Port).

■ Enable/disable fan always on while connected to an 
AC outlet (disabled by default).

■ Enable/disable Data Execution Prevention (select models 
only). When enabled, the processor can disable some 
virus code execution, which helps to improve computer 
security (disabled by default).

■ SATA (Serial Advanced Technology Attachment) 
device mode. The following options are available:

❐ AHCI (Advanced Host Controller Interface)
❐ IDE (Integrated Drive Electronics)

❐ RAID (select models only)

✎ Availability of these options varies by computer model.

■ Enable/disable secondary battery fast charge (enabled 
by default).

■ Enable/disable HP QuickLook (enabled by default).

■ Enable/disable Preboot Authentication on HP QuickLook 
Boot (enabled by default).

■ Enable/disable HP QuickWeb (enabled by default).

■ Enable/disable HP QuickWeb Elevated Security 
(disabled by default).

(Continued)
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System Configuration menu (continued)

Device Configurations (continued) ■ Enable/disable Virtualization Technology (select models 
only; disabled by default).

■ Enable/disable Wake on USB (enabled by default).

■ Enable/disable Num lock state at boot (disabled 
by default).

■ Enable/disable TXT (Intel® Trusted Execution Technology) 
(select models only; disabled by default).

Built-In Device Options ■ Enable/disable the wireless button state (enabled 
by default).

■ Enable/disable embedded WLAN device radio (select 
models only; enabled by default).

■ Enable/disable the Network Interface Controller (LAN) 
(enabled by default).

■ Enable/disable the embedded Bluetooth device radio 
(enabled by default).

■ Enable/disable LAN/WLAN switching (disabled by default).

■ Enable/disable LAN Power Save (select models only). 
When enabled, saves power by turning off the LAN when 
not in use (enabled by default).

■ Set the wake on LAN state. Options include the following:

❐ Disabled
❐ Boot to Network

❐ Follow Boot Order

■ Enable/disable the Notebook Upgrade Bay device (enabled 
by default).

■ Enable/disable the Power Monitor Circuit (enabled 
by default).

■ Enable/disable the audio devices (enabled by default).

■ Enable/disable the fingerprint device (enabled by default).

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the microphone (enabled by default).

■ Enable/disable the internal speakers (enabled by default).

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the serial port.

■ Enable/disable the parallel port.

■ Enable/disable the flash media reader.

■ Enable/disable the USB port.

Ä Disabling the USB port also disables MultiBay devices 
and ExpressCard devices on the advanced 
port replicator.

■ Enable/disable the 1394 port.

■ Enable/disable the ExpressCard slot.

■ Enable/disable the Smart Card slot.

■ Enable/disable the eSATA port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this
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Computer Setup
Computer Setup in Windows Vista

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to 
navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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Computer Setup
To exit Computer Setup menus, choose one of the following methods:
■ To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the 

screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the 
on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.
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Computer Setup
Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File menu

Select To do this

System Information ■ View identification information for the computer and the 
batteries in the system.

■ View specification information for the processor, cache and 
memory size, system ROM, video revision, and keyboard 
controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

■ System Information

❐ Identification information for the computer and the 
batteries in the system.

❐ Specification information for the processor, cache and 
memory size, system ROM, video revision, and 
keyboard controller version.

■ Start-up Test—Verifies the system components needed for 
starting the computer.

■ Run-In Test—Runs a comprehensive check on 
system memory.

■ Hard Disk Test—Runs a comprehensive self-test on any 
hard drive in the system.

■ Memory Test—Runs a comprehensive test on any memory 
installed in the computer.

■ Battery Test—Runs a comprehensive test on any batteries 
installed in the computer.

■ Error Log—Displays a log file if any errors have occurred.

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Restore defaults Replace the configuration settings in Computer Setup with 
the original factory settings. (Hard drive mode, password 
settings, and security settings are not changed when you 
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. 
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then 
exit and restart the computer. Your changes go into effect 
when the computer restarts.
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Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models 
only; disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security 
questions and answers used if you forget your password.

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive 
(enabled by default).

■ Change a DriveLock user password or master password.

✎ DriveLock settings are accessible only when you enter 
Computer Setup by turning on (not restarting) 
the computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) 
Embedded Security, which protects the computer from 
unauthorized access to owner functions available in 
Embedded Security for ProtectTools. For more information, 
refer to the ProtectTools software Help.

✎ You must have a setup password to change 
this setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary 
hard drive or the drive in the upgrade bay.

Ä If you run Disk Sanitizer, the data on the selected drive 
is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and 
ownership tag.
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Computer Setup
System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds).

■ Enable/disable MultiBoot (enabled by default).

■ Set the Express Boot Popup delay in seconds.

■ Enable/disable Custom Logo (disabled by default).

■ Enable/disable Display Diagnostic URL (enabled 
by default).

■ Enable/disable CD-ROM boot (disabled by default).

■ Enable/disable SD Card boot (enabled by default).

■ Enable/disable floppy boot (enabled by default).

■ Enable/disable PXE Internal NIC boot (enabled by default).

■ Enable/Disable Unified Extensible Firmware Interface 
(UEFI) Boot Mode (disabled by default).

■ Set the Legacy Boot Order.

Device Configurations ■ Enable/disable USB legacy support (enabled by default). 
When enabled, USB legacy support allows the following:

❐ Use of a USB keyboard in Computer Setup even when a 
Windows operating system is not running

❐ Startup from bootable USB devices, including a hard 
drive, diskette drive, or optical drive connected by a USB 
port to the computer

■ Select a parallel port mode: ECP (Enhanced Capabilities 
Port), standard, bidirectional, or EPP (Enhanced 
Parallel Port).

■ Enable/disable fan always on while connected to an 
AC outlet (disabled by default).

■ Enable/disable Data Execution Prevention (select 
models only). When enabled, the processor can disable 
some virus code execution, which helps to improve 
computer security (disabled by default).

■ SATA (Serial Advanced Technology Attachment) 
device mode. The following options are available:

❐ AHCI (Advanced Host Controller Interface)

❐ IDE (Integrated Drive Electronics)
❐ RAID (select models only)

✎ Availability of these options varies by computer model.

■ Enable/disable secondary battery fast charge (enabled 
by default).

■ Enable/disable HP QuickLook (enabled by default).

■ Enable/disable Preboot Authentication on HP QuickLook 
Boot (enabled by default).

■ Enable/disable HP QuickWeb (enabled by default).

(Continued)
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Computer Setup
System Configuration menu (continued)

Device Configurations (continued) ■ Enable/disable HP QuickWeb Elevated Security (disabled 
by default).

■ Enable/disable Virtualization Technology (select 
models only; disabled by default).

■ Enable/disable Wake on USB (enabled by default).

■ Enable/disable Num lock state at boot (disabled 
by default).

■ Enable/disable TXT (Intel Trusted Execution Technology) 
(select models only; disabled by default).

Built-In Device Options ■ Enable/disable the wireless button state (enabled 
by default).

■ Enable/disable embedded WLAN device radio (select 
models only; enabled by default).

■ Enable/disable the Network Interface Controller (LAN) 
(enabled by default).

■ Enable/disable the embedded Bluetooth device radio 
(enabled by default).

■ Enable/disable LAN/WLAN switching (disabled by default).

■ Enable/disable LAN Power Save (select models only).

■ When enabled, saves power by turning off the LAN when 
not in use (enabled by default).

■ Set the wake on LAN state. Options include the following:

❐ Disabled
❐ Boot to Network

❐ Follow Boot Order

■ Enable/disable the Notebook Upgrade Bay device (enabled 
by default).

■ Enable/disable the Power Monitor Circuit (enabled 
by default).

■ Enable/disable the audio devices (enabled by default).

■ Enable/disable the fingerprint device (enabled by default).

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the microphone (enabled by default).

■ Enable/disable the internal speakers (enabled by default).

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the serial port.

■ Enable/disable the parallel port.

■ Enable/disable the flash media reader.

■ Enable/disable the USB port.

Ä Disabling the USB port also disables MultiBay devices 
and ExpressCard devices on the advanced 
port replicator.

■ Enable/disable the 1394 port.

■ Enable/disable the ExpressCard slot.

■ Enable/disable the Smart Card slot.

■ Enable/disable the eSATA port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this
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Computer Setup
Computer Setup in Windows XP

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, and System Configuration 
menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎ You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to 
navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:
■ To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the 

screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the 
on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.
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Computer Setup
Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File menu

Select To do this

System Information ■ View identification information for the computer and the 
batteries in the system.

■ View specification information for the processor, cache and 
memory size, system ROM, video revision, and keyboard 
controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

■ System Information

❐ Identification information for the computer and the 
batteries in the system

❐ Specification information for the processor, cache and 
memory size, system ROM, video revision, and 
keyboard controller version

■ Start-up Test—Verifies the system components needed for 
starting the computer.

■ Run-In Test—Runs a comprehensive check on system 
memory.

■ Hard Disk Test—Runs a comprehensive self-test on any 
hard drive in the system.

■ Memory Test—Runs a comprehensive test on any memory 
installed in the computer.

■ Battery Test—Runs a comprehensive test on any batteries 
installed in the computer.

■ Error Log—Displays a log file if any errors have occurred.

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Restore defaults Replace the configuration settings in Computer Setup with 
the original factory settings. (Hard drive mode, password 
settings, and security settings are not changed when you 
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. 
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. 
Then exit and restart the computer. Your changes go into 
effect when the computer restarts.
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Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models 
only; disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security 
questions and answers used if you forget your password.

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive 
(enabled by default).

■ Change a DriveLock user password or master password.

✎ DriveLock settings are accessible only when you enter 
Computer Setup by turning on (not restarting) 
the computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) 
Embedded Security, which protects the computer from 
unauthorized access to owner functions available in 
Embedded Security for ProtectTools. For more information, 
refer to the ProtectTools software Help.

✎ You must have a setup password to change 
this setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary 
hard drive or the drive in the upgrade bay.

Ä If you run Disk Sanitizer, the data on the selected drive 
is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and 
ownership tag.
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System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds).

■ Enable/disable MultiBoot (enabled by default).

■ Set the Express Boot Popup delay in seconds.

■ Enable/disable Custom Logo (disabled by default).

■ Enable/disable Display Diagnostic URL (enabled 
by default).

■ Enable/disable CD-ROM boot (disabled by default).

■ Enable/disable SD Card boot (enabled by default).

■ Enable/disable floppy boot (enabled by default).

■ Enable/disable PXE Internal NIC boot (enabled by default).

■ Enable/Disable Unified Extensible Firmware Interface 
(UEFI) Boot Mode (disabled by default).

■ Set the Legacy Boot Order.

Device Configurations ■ Enable/disable USB legacy support (enabled by default). 
When enabled, USB legacy support allows the following:

❐ Use of a USB keyboard in Computer Setup even when a 
Windows operating system is not running.

❐ Startup from bootable USB devices, including a hard 
drive, diskette drive, or optical drive connected by a USB 
port to the computer.

■ Select a parallel port mode: ECP (Enhanced Capabilities 
Port), standard, bidirectional, or EPP (Enhanced 
Parallel Port).

■ Enable/disable fan always on while connected to an 
AC outlet (disabled by default).

■ Enable/disable Data Execution Prevention (select models 
only). When enabled, the processor can disable some 
virus code execution, which helps to improve computer 
security (disabled by default).

■ SATA (Serial Advanced Technology Attachment) 
device mode. The following options are available:

❐ AHCI (Advanced Host Controller Interface)

❐ IDE (Integrated Drive Electronics)
❐ RAID (select models only)

✎ Availability of the options above varies by 
computer model.

■ Enable/disable secondary battery fast charge (enabled 
by default).

■ Enable/disable HP QuickLook (enabled by default).

■ Enable/disable Preboot Authentication on HP QuickLook 
Boot (enabled by default).

■ Enable/disable HP QuickWeb (enabled by default).

(Continued)
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System Configuration menu (continued)

Device Configurations (continued) ■ Enable/disable HP QuickWeb Elevated Security (disabled 
by default).

■ Enable/disable Virtualization Technology (select models 
only; disabled by default).

■ Enable/disable Wake on USB (enabled by default).

■ Enable/disable Num lock state at boot (disabled 
by default).

■ Enable/disable TXT (Intel Trusted Execution Technology) 
(select models only; disabled by default).

Built-In Device Options ■ Enable/disable the wireless button state (enabled 
by default).

■ Enable/disable embedded WLAN device radio (select 
models only; enabled by default).

■ Enable/disable the Network Interface Controller (LAN) 
(enabled by default).

■ Enable/disable the embedded Bluetooth device radio 
(enabled by default).

■ Enable/disable LAN/WLAN switching (disabled by default).

■ Enable/disable LAN Power Save (select models only). 
When enabled, saves power by turning off the LAN when 
not in use (enabled by default).

■ Set the wake on LAN state. Options include the following:

❐ Disabled
❐ Boot to Network

❐ Follow Boot Order

■ Enable/disable the Notebook Upgrade Bay device (enabled 
by default).

■ Enable/disable the Power Monitor Circuit (enabled 
by default).

■ Enable/disable the audio devices (enabled by default).

■ Enable/disable the fingerprint device (enabled by default).

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the microphone (enabled by default).

■ Enable/disable the internal speakers (enabled by default).

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the serial port.

■ Enable/disable the parallel port.

■ Enable/disable the flash media reader.

■ Enable/disable the USB port.

Ä Disabling the USB port also disables MultiBay devices 
and ExpressCard devices on the advanced 
port replicator.

■ Enable/disable the 1394 port.

■ Enable/disable the ExpressCard slot.

■ Enable/disable the Smart Card slot.

■ Enable/disable the eSATA port.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this
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6
Specifications

Computer specifications

Metric U.S.

Dimensions

HP ProBook 6545b Notebook PC

Depth 24.8 cm 9.76 in

Width 37.1 cm 14.61 in

Height (front to back) 3.5 to 3.9 cm 1.38 to 1.54 in

Weight

With 15.6-in WXGA display assembly, no optical drive, 
320-GB, 7200-rpm hard drive, 2.55-AH battery, 1024-MB 
memory, no modem module, no Bluetooth module, 
no WWAN module, no webcam, and no fingerprint reader

2.51 kg 5.53 lb

With 15.6-in WXGA display assembly, DVD-ROM drive, 
320-GB, 7200-rpm hard drive, 2.55-AH battery, 1024-MB 
memory, no modem module, no Bluetooth module, 
no WWAN module, no webcam, and no fingerprint reader

2.64 kg 5.82 lb

HP ProBook 6445b Notebook PC

Depth 23.6 cm 9.29 in

Width 33.9 cm 13.35 in

Height (front to back) 3.4 to 3.9 cm 1.34 to 1.54 in

Weight

With 14.0-in WXGA display assembly, no optical drive, 
320-GB, 7200-rpm hard drive, 2.55-AH battery, 1024-MB 
memory, no modem module, no Bluetooth module, 
no WWAN module, no webcam, and no fingerprint reader

2.26 kg 4.98 lbs

With 14.0-in WXGA display assembly, DVD-ROM drive, 
320-GB, 7200-rpm hard drive, 2.55-AH battery, 1024-MB 
memory, no modem module, no Bluetooth module, 
no WWAN module, no webcam, and no fingerprint reader

2.39 kg 5.5.27 lb

(Continued)
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Specifications
Input power

Operating voltage 18.5 V dc @ 3.5 A - 65 W or 19.0 V dc @ 4.74 A - 90 W

Operating current 3.5 A or 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

✎ Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this 
range of temperatures.

Metric U.S.
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Specifications
15.6-in display specifications

14.0-in display specifications

Metric U.S. 

Dimensions

Height 19.5 cm 7.68 in

Width 34.1 cm 13.43 in

Diagonal 39.6 cm 15.59 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120°/-40° vertical (typical)

Metric U.S. 

Dimensions

Height 17.6 cm 6.93 in

Width 31.1 cm 12.24 in

Diagonal 35.7 cm 14.06 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120°/-40° vertical (typical)
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Specifications
Hard drive specifications

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive specifications

500-GB* 320-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 1.5 ms 2.0 ms 2.0 ms

Average 12.0 ms 12.0 ms 12.0 ms 12.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms 22.0 ms

Logical blocks 976,785,075 625,142,448 488,397,168 312,581,808

Disc rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive 
specifications may differ slightly.

✎ Certain restrictions and exclusions apply. Contact technical support for details.

Applicable disc Read: Write: 

BD-ROM, BD-ROM-DL, BD-R, 
BD-R-DL, BD-RE, BD-RE-DL, 
DVD-ROM, DVD+R, 
DVD+R-DL, DVD+RW, DVD-R, 
DVD-R-DL, DVD-RW, 
DVD-RAM (Ver.2), CD-DA, 
CD-ROM (mode 1 and 
mode 2), CD-ROM XA 
(mode 2, form 1 and form 2), 
Photo CD (single and multiple 
sessions), CD Extra, CD-R, 
CD-RW, and CD-TEXT

DVD-RAM (Ver.2), DVD+R, 
DVD-R, CD-R, and CD-ROM

Access time BD DVD

Random < 230 ms < 180 ms 

Cache buffer 4.5 MB 

Data transfer rate 

2X BD-RAM 9 MB/sec 

8X DVD 2,400 KB/sec 

16X CD-R 2,400 KB/sec 

16X CD-RW 2,400 KB/sec 
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Specifications
DVD±RW and CD-RW SuperMulti Double-Layer Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CDROM, 
CD-ROM XA, 
MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, 
Video CD), Multisession CD 
(Photo-CD, CD-EXTRA, 
Portfolio, CD-R, CD-RW), 
CD-R, CD-RW, DVD-ROM 
(DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, 
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW DVD+R, 
DVD+RW, DVD-R, DVD-RW, 
DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8x DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA mode
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Specifications
DVD-ROM Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CD-ROM, 
CD-ROM XA, 
MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, 
Video CD), Multisession CD 
(Photo-CD, CDEXTRA, 
Portfolio, CD-R, CD-RW), CDR, 
CD-RW, DVD-ROM (DVD-5, 
DVD-9, DVD-10, DVD-18), 
DVD-R, DVD-RW, DVD+R, 
DVD+RW, DVD-RAM

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec
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Specifications
System DMA specifications

System memory map specifications

Hardware DMA system function 

DMA0 Not applicable 

DMA1* Not applicable 

DMA2* Not applicable 

DMA3 Not applicable 

DMA4 Direct memory access controller 

DMA5* Not applicable 

DMA6 Not assigned 

DMA7 Not assigned 

*ExpressCard controller can use DMA 1, 2, or 5. 

Size Memory address System function 

640 KB 00000000–0009FFFF Base memory 

128 KB 000A0000–000BFFFF Video memory 

64 KB 000C0000–000CFFFF Video BIOS 

64 KB 000E8000–000FFFFF System BIOS 

00100000–XFFFFFFF Extended memory (based on 
memory installed)

(X+1)0000000–FEDFFFFF PCI bus

FED00000–FED003FF High-precision event timer

FEE01000–FFFFFFFF PCI bus 
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Specifications
System interrupt specifications

Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-key or Microsoft natural keyboard

IRQ8 System CMOS/real-time clock

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ16 Intel ICH9 family USB universal host controller 2937
Mobile Intel 4 Series express chipset family

IRQ17* High-definition audio controller
Intel ICH9 family USB universal host controller 2938 
Marvell Yukon 88E8072 PCIE-gigabit Ethernet controller

IRQ18 Intel ICH9 family USB universal host controller 2939
Intel ICH9 family USB universal host controller 2936

IRQ19 Intel ICH9 family USB2 enhanced controller 293C

IRQ20 Intel ICH9 family USB2 enhanced controller 293A
Intel ICH9 family USB universal host controller 2934

IRQ21 Intel ICH9M-E/M SATA AHCI controller

IRQ22 Intel ICH9 family USB universal host controller 2935

*Default configuration; other possible audio configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none. 

✎ ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial 
port may assert IRQ3 or IRQ4. 

✎ For operating systems after Windows 2000, APIC (advanced programming interrupt controller) is used.
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Specifications
System I/O address specifications

I/O address (hex) System function (shipping configuration) 

000–01F DMA controller

020–021 Program interrupt controller

024–025 Program interrupt controller

028–029 Program interrupt controller

02C–03D Program interrupt controller

02E–02F Motherboard resources

030–031 Program interrupt controller

034–035 Program interrupt controller

038–039 Program interrupt controller

03C–03D Program interrupt controller

040–043 System timer

04E–04F Motherboard resources

050–053 System timer

060 Standard 101-/102-key or Microsoft natural keyboard

061 Motherboard resources

062 Microsoft ACPI-compliant embedded controller

063 Motherboard resources

064 Standard 101-/102-key or Microsoft natural keyboard

065 Motherboard resources

066 Microsoft ACPI-compliant embedded controller

067 Motherboard resources

070 Motherboard resources

071–077 System CMOS/real-time clock

080 Motherboard resources

081–091 Direct memory access controller

092 Motherboard resources

093–09F Direct memory access controller

0A0–0A1 Program interrupt controller

0A4–0A5 Program interrupt controller

0A8–0A9 Program interrupt controller

0AC–0AD Program interrupt controller

0B0–0B1 Program interrupt controller

0B2–0B3 Motherboard resources

0B4–0B5 Program interrupt controller

0B8–0B9 Program interrupt controller

0BC–0BD Program interrupt controller

(Continued)
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Specifications
0C0–0DF Direct memory access controller

0F0–0F0 Numeric data processor

0200–027F Motherboard resources

3B0–3BB Mobile Intel 4 Series express chipset family

3C0–3DF Mobile Intel 4 Series express chipset family

400–47F Motherboard resources

4D0–4D1 Programmable interrupt controller

500–57F Motherboard resources

1000–1003 Motherboard resources

1010–101F Motherboard resources

2000–20FF Marvell Yukon 88E8072 PCIE-gigabit Ethernet controller

2000–2FFF ICH9 family PCI express root port6-294A

3000–4FFF ICH9 family PCI express root port5-2948

5000–6FFF ICH9 family PCI express root port3-2944

7000–701F ICH9M-E/M SATA AHCI controller

7020–703F ICH9 family USB universal host controller 2936

7040–705F ICH9 family USB universal host controller 2935

7060–707F ICH9 family USB universal host controller 2934

7080–709F ICH9 family USB universal host controller 2939

70A0–70BF ICH9 family USB universal host controller 2938

70C0–70DF ICH9 family USB universal host controller 2937

70E0–70E7 ICH9M-E/M SATA AHCI controller

70E8–70EF ICH9M-E/M SATA AHCI Controller

70F0–70F7 Mobile Intel 4 Series express chipset family

70F8–70FB ICH9M-E/M SATA AHCI controller

70FC–70FF ICH9M-E/M SATA AHCI controller

EF80–EF9F Motherboard resources

FE00–FE0F Motherboard resources

FE80–EF8F Motherboard resources

FFFF Motherboard resources

I/O address (hex) System function (shipping configuration) 
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7
Screw listing

This chapter provides specification and reference information for the screws used in the computer. The screws 
listed in this chapter are available in the Screw Kit, spare part number 583281-001.

Phillips PM2.5×13.0 captive screw

Where used: One captive screw that secures the mass storage device to the computer (screw is secured to the mass 
storage device bracket)

Color Quantity Length Thread Head diameter 

Black 1 13.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM2.0×6.0 captive screw

Where used:

1 One captive screw that secures the Bluetooth module compartment cover to the computer (screw is secured to 
the cover by a C-clip)

2 Two captive screws that secure the mass storage device cover to the computer (screws are secured to the cover 
by C-clips)

3 One captive screw that secures the memory module compartment cover to the computer (screw is secured to the 
cover by a C-clip)

4 Two captive screws that secure the wireless module compartment cover to the computer (screws are secured to 
the cover by C-clips)

Color Quantity Length Thread Head diameter 

Black 6 6.0 mm 2.0 mm 5.0 mm
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Screw listing
Phillips PM3.0×3.0 screw

Where used: 4 screws that secure the mass storage device bracket to the mass storage device

Color Quantity Length Thread Head diameter 

Black 4 3.0 mm 3.0 mm 5.0 mm
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Screw listing
Phillips PM2.5×6.0 screw

 

Where used:

1 Two screws that secure the WLAN module to the system board

2 Two screws that secure the WWAN module to the system board

Color Quantity Length Thread Head diameter 

Black 14 6.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: 8 screws that secure the display bezel to the display assembly

Where used: 2 screws that secure the display panel to the display enclosure
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Screw listing
Phillips PM2.5×11.0 captive screw

Where used:

1 One captive screw that secures the optical drive to the computer (screw is secured to the computer by an O-ring)

2 Three captive screws that secure the keyboard to the computer (screws are secured to the computer by O-rings)

Color Quantity Length Thread Head diameter 

Black 4 11.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM2.0×3.0 screw

 

Where used: 3 screws that secure the optical drive bracket to the optical drive

Where used: 3 screws that secure the switch cover to the computer

Color Quantity Length Thread Head diameter 

Black 23 on computer 
models equipped with 
a 15.6-in display,
21 on computer 
models equipped with 
a 14.0-in display

3.0 mm 2.0 mm 4.5 mm
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Screw listing
Where used: 2 screws that secure the power button board to the switch cover

Where used:

1 Eight screws that secure the display hinges to the display panel on computer models equipped with a 15.6-in 
display assembly

2 Two screws that secure the display hinge covers to the display hinges
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Screw listing
Where used:

1 Six screws that secure the display hinges to the display panel on computer models equipped with a 14.0-in 
display assembly

2 Two screws that secure the display hinge covers to the display hinges

Where used: 5 screws that secure the top cover to the base enclosure
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Screw listing
Slotted Torx T8M2.5×7.0 screw

 

Where used: 4 screws that secure the palm rest to the computer

Color Quantity Length Thread Head diameter 

Black 25 on computer 
models equipped with 
a 15.6-in display,
21 on computer 
models equipped with 
a 14.0-in display

7.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: 2 screws that secure the fan to the system board

Where used: 5 screws that secure the top cover to the base enclosure

Where used: 9 screws that secure the top cover to the base enclosure only on computer models equipped with a 
15.6-in display assembly
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Screw listing
Where used: 6 screws that secure the top cover to the base enclosure only on computer models equipped with a 
14.0-in display assembly

Where used: One screw that secures the speaker assembly to the base enclosure
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Screw listing
Where used: One screw that secures the card reader/USB board to the base enclosure

Where used:

1 Two screws that secure the system board to the base enclosure

2 One screw that secures the system board to the base enclosure only on computer models equipped with a 15.6-in 
display assembly
Maintenance and Service Guide 7–13



Screw listing
Phillips PM2.5×9.0 captive screw

Where used: 4 captive screws that secure the heat sink to the system board (screws are secured to the computer by 
O-rings)

Color Quantity Length Thread Head diameter 

Black 4 9.0 mm 2.5 mm 5.0 mm
7–14 Maintenance and Service Guide



Screw listing
Slotted Torx T8M2.5×11.0 screw

Where used: 4 screws that secure the display assembly to the computer

Color Quantity Length Thread Head diameter 

Black 8 11.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: 2 screws that secure the display assembly to the computer

Where used: 2 screws that secure the top cover to the base enclosure
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Screw listing
Phillips PM2.0×5.0 screw

Where used: One screw that secures the modem module to the system board

Color Quantity Length Thread Head diameter 

Black 1 5.0 mm 2.0 mm 5.0 mm
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Screw listing
Hex HM5.0×10.0 screw lock

 

Where used: 2 screw locks that secure the serial connector to the base enclosure

Color Quantity Length Thread Head diameter 

Silver 2 10.0 mm 5.0 mm 5.0 mm
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8
Backup and recovery

Backup and recovery in Windows 7

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders, back up 
your entire hard drive (select models only), or create system restore points. In case of system failure, you can use 
the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

■ Backing up individual files and folders

■ Backing up the entire hard drive (select models only)

■ Scheduling automatic backups (select models only)

■ Creating system restore points

■ Recovering individual files

■ Restoring the computer to a previous state

■ Recovering information using recovery tools

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup. You can back up your information to an optional 
external hard drive, a network drive, or discs.

Note the following when backing up:

■ Store personal files in the Documents folder, and back it up regularly.

■ Back up templates that are stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.
Maintenance and Service Guide 8–1



Backup and recovery
3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type of 
optical drive installed in your computer.

✎ DVDs and DVDs with double-layer (DL) support store more information than CDs, so using them for 
backup reduces the number of recovery discs required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

✎Windows includes the User Account Control feature to improve the security of your computer. You may 
be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support for more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools: You can use the Backup and Restore Center to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows 
from starting correctly.

■ f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image 
includes the Windows operating system and software programs installed at the factory.

✎ If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. For additional information, refer to the “Using a Windows 
Vista operating system DVD (purchased separately)” section in this chapter.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.
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Backup and recovery
To recover your information using Startup Repair, follow these steps:

Ä
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive. All files you have created 
and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process 
restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find the 
partitions, select Start > Computer.

✎ If the Windows partition and the HP Recovery partition have been deleted, you must recover your 
operating system and programs using the Windows Vista operating system DVD and the Driver 
Recovery disc (both purchased separately). For additional information, refer to the “Using a Windows 
Vista operating system DVD (purchased separately)” section in this chapter.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

✎ For additional information on recovering information using the Windows tools, perform a search for these topics 
in Help and Support.

Using f11 recovery tools

Ä
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you have created and any 
software installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and 
HP programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled. Personal files 
must be restored from a backup.

✎ If your computer includes a solid-state drive (SSD), you may not have a recovery partition. Recovery discs have 
been included for computers that do not have a partition. Use these discs to recover your operating system and 
software. To check for the presence of a recovery partition, select Start > Computer. If the partition is present, 
an HP Recovery drive is listed in the Hard Disk Drives section of the window.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select Start > 
Computer.

✎ If the HP Recovery partition has been deleted, you must recover your operating system and programs 
using the Windows Vista operating system DVD and the Driver Recovery disc (both purchased 
separately). For additional information, refer to the “Using a Windows Vista operating system DVD 
(purchased separately)” section in this chapter.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message 
is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Backup and recovery
Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. Make sure that your most recent backup (stored on discs or on 
an external drive) is easily accessible. To order a Windows Vista operating system DVD, go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions. You can also order the 
DVD by calling technical support. For contact information, refer to the Worldwide Telephone Numbers booklet 
included with the computer.

Ä
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and reformats the hard drive. 
All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, 
the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

✎ This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery
Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders, back up 
your entire hard drive (select models only), or create system restore points. In case of system failure, you can use 
the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

■ Backing up individual files and folders

■ Backing up the entire hard drive (select models only)

■ Scheduling automatic backups (select models only)

■ Creating system restore points

■ Recovering individual files

■ Restoring the computer to a previous state

■ Recovering information using recovery tools

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup. You can back up your information to an optional 
external hard drive, a network drive, or discs.

Note the following when backing up:

■ Store personal files in the Documents folder, and back it up regularly.

■ Back up templates that are stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.
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Backup and recovery
■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type of 
optical drive installed in your computer.

✎ DVDs and DVDs with double-layer (DL) support store more information than CDs, so using them for 
backup reduces the number of recovery discs required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools: You can use the Backup and Restore Center to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows 
from starting correctly.

■ f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image 
includes the Windows operating system and software programs installed at the factory.

✎ If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. For additional information, refer to the “Using a Windows 
Vista operating system DVD (purchased separately)” section in this chapter.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.
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Backup and recovery
To recover your information using Startup Repair, follow these steps:

Ä
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive. All files you have created 
and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process 
restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find the 
partitions, select Start > Computer.

✎ If the Windows partition and the HP Recovery partition have been deleted, you must recover your 
operating system and programs using the Windows Vista operating system DVD and the Driver 
Recovery disc (both purchased separately). For additional information, refer to the “Using a Windows 
Vista operating system DVD (purchased separately)” section in this chapter.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

✎ For additional information on recovering information using the Windows tools, perform a search for these topics 
in Help and Support.

Using f11 recovery tools

Ä
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you have created and any 
software installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP 
programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled. Personal files 
must be restored from a backup.

✎ If your computer includes a solid-state drive (SSD), you may not have a recovery partition. Recovery discs have 
been included for computers that do not have a partition. Use these discs to recover your operating system and 
software. To check for the presence of a recovery partition, select Start > Computer. If the partition is present, 
an HP Recovery drive is listed in the Hard Disk Drives section of the window.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select 
Start > Computer.

✎ If the HP Recovery partition has been deleted, you must recover your operating system and programs 
using the Windows Vista operating system DVD and the Driver Recovery disc (both purchased 
separately). For additional information, refer to the “Using a Windows Vista operating system DVD 
(purchased separately)” section in this chapter.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message 
is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Backup and recovery
Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. Make sure that your most recent backup (stored on discs or on 
an external drive) is easily accessible. To order a Windows Vista operating system DVD, go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions. You can also 
order the DVD by calling technical support. For contact information, refer to the Worldwide Telephone Numbers 
booklet included with the computer.

Ä
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and reformats the hard drive. 
All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, 
the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

✎ This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
8–8 Maintenance and Service Guide



Backup and recovery
Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and folders or 
create recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

■ Backing up individual files and folders

■ Backing up all files and folders

■ Scheduling automatic backups

■ Creating recovery points

■ Recovering information

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup. You can back up individual files or folders to an 
optional external hard drive or to a network drive.

Note the following when backing up:

■ Store personal files in the My Documents folder, and back it up periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.
Maintenance and Service Guide 8–9



Backup and recovery
Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools (select models only): You can use the Windows Backup utility to recover information 
you have previously backed up.

■ Operating System and Driver Recovery discs (included with your computer): You can use the discs to recover 
your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Select Restore files and settings, and then select Next.

4. Follow the on-screen instructions.

✎ For additional information on initiating a recovery in Windows, perform a search for this topic in 
Help and Support.

Recovering the operating system and programs

Ä
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have created and any software 
installed on the computer are permanently removed. The recovery process reinstalls the original operating system as well as 
software and drivers. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be 
restored from a backup.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver 
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9
Connector pin assignments

1394

 

Audio-in (microphone)

 

Pin Signal

1 Power

2 Ground

3 TPB-

4 TPB+

5 TPA-

6 TPA+

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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Connector pin assignments
Audio-out (headphone)

External monitor

 

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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Connector pin assignments
RJ-45 (network)

RJ-11 (modem)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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Connector pin assignments
Serial

Universal Serial Bus

 

Pin Signal

1 1 Data carrier detect

2 Received data

3 Transmitted data

4 Data terminal ready

5 Signal ground

6 Data set ready

7 Request to send

8 Clear to send

9 Ring indicator

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground
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10
Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts AC, 
or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region 
where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where 
the computer is used.

Requirements for all countries and regions

The following requirements are applicable to all countries and regions:

■ The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the 
country or region where the power cord set will be used.

■ The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 125 or 
250 V AC, as required by the power system of each country or region.

■ The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of the computer.
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Power cord set requirements
Requirements for specific countries and regions

Country/region Accredited agency Applicable note number 

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a 
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household waste. 
Follow the local laws and regulations in your area for computer battery disposal.

Display

Å
WARNING: The backlight contains mercury. Caution must be exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this chapter can result in damage to display components. The only components intended for 
recycling purposes are the liquid crystal display (LCD) panel and the backlight. When you remove these components, handle 
them carefully.

✎ Materials Disposal. This HP product contains mercury in the backlight in the display assembly that might 
require special handling at end-of-life. Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact your local authorities, or see the Electronic 
Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be 
disassembled to gain access to the backlight 1 and the liquid crystal display (LCD) panel 2.

✎ The procedures provided in this chapter are general disassembly instructions. Specific details, such as screw 
sizes, quantities, and locations, and component shapes and sizes, can vary from one computer model to another.
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Recycling
Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges 1 and the top and bottom inside edges 2 of the display bezel 
until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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Recycling
4. Disconnect all display panel cables 1 from the display inverter and remove the inverter 2.

5. Remove all screws 1 that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly 2 from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.
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Recycling
9. Use a sharp-edged tool to cut the tape 1 that secures the sides of the display panel to the display panel frame.

10. Remove the display panel frame 2 from the display panel.
 

11. Remove the screws 1 that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover 2 and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the display panel.
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Recycling
16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

Å
WARNING: The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging 
this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
Maintenance and Service Guide 11–5



Recycling
19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the display rear panel.

21. Release the LCD panel 3 from the display rear panel.

22. Release the tape 4 that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

1394 port
connector pinout 9–1
location 2–13, 2–14

A
AC adapter, spare part numbers 3–24, 3–25, 3–26
accessory battery connector 2–18
antennas

disconnecting 4–19, 4–21
illustrated 3–20
locations 2–2
removal 4–56, 4–57

attery eject arm
installation 4–85

audio, product description 1–3
audio-in jack

connector pinout 9–1
location 2–15, 2–16

audio-out jack
connector pinout 9–2
location 2–15, 2–16

B
base enclosure, spare part numbers 3–14, 3–39
battery

removal 4–7
spare part numbers 3–14, 3–25, 3–36, 4–7

battery bay 2–18
battery eject arm

illustrated 3–21
removal 4–84

battery eject latch
illustrated 3–21
installation 4–86
removal 4–83

battery eject spring
illustrated 3–21
installation 4–86
removal 4–83

Battery Latch Kit
components 3–21
spare part number 3–14, 3–21, 3–29, 4–82

battery light 2–9, 2–11, 2–12
battery release latch 2–18

Bluetooth compartment 2–18
Bluetooth module

removal 4–9
spare part number 3–15, 3–26, 4–9

Bluetooth module cable
illustrated 3–18
removal 4–70

Bluetooth module compartment cover
illustrated 3–23
removal 4–9

Blu-ray ROM DVD±RW SuperMulti Double-Layer 
Drive

precautions 4–2
removal 4–23
spare part number 3–14, 3–22, 3–29, 4–23
specifications 6–4

boot options 5–5
boot order 5–5
bottom components 2–17, 2–18
buttons

calculator 2–7
pointing stick 2–5
power 2–6, 2–7
QuickLook 2–6, 2–7
QuickWeb 2–6, 2–8
TouchPad 2–5
volume down 2–7, 2–8
volume mute 2–6, 2–8
volume up 2–7, 2–8
wireless 2–6, 2–8

C
Cable Kit

components 3–18
spare part numbers 3–10, 3–18, 3–30, 3–33, 3–37

cables, service considerations 4–1
calculator button 2–7
calculator light 2–9
caps lock light 2–9, 2–11
card reader/USB board

removal 4–72
spare part numbers 3–13, 3–33, 3–37, 4–72

chipset, product description 1–1
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Index
components
bottom 2–17, 2–18
buttons 2–6
display 2–2
fingerprint reader 2–6
front 2–12
keys 2–3
left-side 2–15
lights 2–8
pointing device 2–5
right-side 2–13

computer feet
locations 4–6
spare part number 4–6

Computer Setup
File menu 5–3, 5–9, 5–15
Security menu 5–4, 5–10, 5–16
System Configuration menu 5–5, 5–11, 5–17

computer specifications 6–1
connector pinout

1394 port 9–1
audio-in jack 9–1
audio-out jack 9–2
external monitor port 9–2
headphone jack 9–2
microphone jack 9–1
modem jack 9–3
monitor port 9–2
network jack 9–3
RJ-11 jack 9–3
RJ-45 jack 9–3
serial port 9–4
USB port 9–4

connectors, service considerations 4–1

D
device configurations 5–5, 5–6
display assembly

removal 4–45
spare part numbers 3–3, 3–4, 3–5, 3–28, 3–33, 

3–36, 3–38, 3–39, 3–40, 4–45
display bezel

illustrated 3–20
removal 4–50
spare part numbers 3–20, 3–29, 3–37, 4–50

Display Cable Kit
illustrated 3–20
spare part numbers 3–20, 3–28, 3–33, 3–38

display components
illustrated 2–2
recycling 11–1
spare part numbers 3–19

display enclosure
illustrated 3–20
spare part numbers 3–20, 3–28, 3–29, 3–33, 3–36, 

3–37
display hinge cover, removal 4–55
Display Hinge Kit, spare part numbers 3–28, 3–33
display hinges

illustrated 3–20
removal 4–54
spare part numbers 3–20, 3–28, 3–33, 4–54

display inverter, removal 11–3
display panel

product description 1–2
removal 4–52

display panel cable
illustrated 3–20
removal 4–53
spare part numbers 4–53

display release latch 2–12
display switch 2–2
DisplayPort 2–15, 2–16
docking connector 2–18
docking, product description 1–5
drive light 2–9, 2–11, 2–12
drives, boot order 5–5
DVD±RW and CD-RW SuperMulti Double-Layer 

Drive
precautions 4–2
removal 4–23
spare part number 3–14, 3–22, 3–29, 4–23
specifications 6–5

DVD-ROM Drive
precautions 4–2
removal 4–23
spare part number 3–14, 3–22, 3–29, 4–23
specifications 6–6

E
electrostatic discharge 4–2
equipment guidelines 4–4
esc key 2–3, 2–4
Ethernet, product description 1–4
ExpressCard assembly

removal 4–63
spare part numbers 3–12, 3–30, 3–37, 4–63

ExpressCard slot 2–15
ExpressCard slot bezel, illustrated 3–23
external media card, product description 1–4
external monitor port

connector pinout 9–2
location 2–17
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F
fan

removal 4–39
spare part number 3–9, 3–29, 4–39

feet
locations 4–6
spare part number 4–6

File menu 5–3, 5–9, 5–15
fingerprint reader 2–7, 2–8
fn key 2–3, 2–4
front components 2–12
function keys 2–3, 2–4

G
graphics, product description 1–2
grounding equipment and methods 4–2

H
hard drive

precautions 4–2
product description 1–3
removal 4–11
spare part numbers 3–14, 3–22, 3–29, 3–40, 4–11
specifications 6–4

hard drive bay 2–18
headphone jack

connector pinout 9–2
location 2–15, 2–16

heat sink
removal 4–40
spare part numbers 3–9, 3–29, 3–37, 4–40

HP Mobile Broadband Module compartment 2–18

J
jacks

audio-in 2–15, 2–16
audio-out 2–15, 2–16
headphone 2–15, 2–16
microphone 2–15, 2–16
modem 2–14, 2–17
network jack 2–17
RJ-11 2–14, 2–17
RJ45 2–17

K
key components 2–3
keyboard

product description 1–5
removal 4–25
spare part numbers 3–5, 3–6, 3–7, 3–8, 3–9, 3–30, 

3–31, 3–32, 3–33, 3–34, 3–35, 3–36, 4–25

keys
esc 2–3, 2–4
fn 2–3, 2–4
function 2–3, 2–4
numeric keypad 2–3, 2–4
Windows applicatons 2–3, 2–4
Windows logo 2–3, 2–4

L
language, changing in Computer Setup 5–5
Latch Kit, spare part number 3–14, 3–29
left-side components 2–15
light components 2–8
lights

battery 2–9, 2–11, 2–12
calculator 2–9
caps lock 2–9, 2–11
drive 2–9, 2–11, 2–12
num lock 2–9, 2–11
power 2–8, 2–10, 2–12
QuickLook 2–9, 2–11
QuickWeb 2–9, 2–11
volume down 2–9, 2–11
volume mute 2–9, 2–11
volume up 2–9, 2–11
webcam 2–2, 2–12
wireless 2–8, 2–10, 2–12

M
mass storage device

precautions 4–2
product description 1–3
removal 4–11
spare part numbers 3–14, 3–22, 4–11

mass storage device cover
illustrated 3–23
removal 4–12

Media Card Reader 2–13, 2–14
memory module

removal 4–14, 4–30
spare part numbers 3–11, 4–14, 4–30

memory module compartment 2–18
memory module compartment cover

illustrated 3–23
removal 4–14

memory, product description 1–3
microphone

illustrated 3–20
locations 2–2
product description 1–3
removal 4–58
spare part number 4–58
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Index
microphone jack
connector pinout 9–1
location 2–15, 2–16

model name 3–1, 4–5
modem jack

connector pinout 9–3
location 2–14, 2–17

modem module
removal 4–66
spare part numbers 3–12, 3–26, 4–66

modem module cable
illustrated 3–18
removal 4–80

modem, product description 1–4
monitor port

connector pinout 9–2
location 2–17

MultiBay hard drive carrier, spare part number 3–14, 
3–22, 3–29, 4–23

N
network jack

connector pinout 9–3
location 2–17

num lock light 2–9, 2–11
numeric keypad keys 2–3, 2–4

O
operating system, product description 1–6
optical drive

precautions 4–2
removal 4–23
spare part numbers 3–14, 3–22, 3–29, 4–23
specifications 6–4, 6–5, 6–6

optical drive bracket, removal 4–24
optical drive connector board

removal 4–77
spare part numbers 3–13, 3–29, 3–37, 4–77

optical drive slot bezel, illustrated 3–23

P
packing guidelines 4–3
palm rest

removal 4–36
spare part numbers 3–9, 3–30, 3–37, 4–36

plastic parts 4–1
Plastics Kit

components 3–23
contents 3–23
spare part numbers 3–10, 3–23, 3–30, 3–33, 3–37

pointing device
components 2–5
illustrated 2–5
product description 1–5

pointing stick 2–5
pointing stick button 2–5
ports

1394 2–13, 2–14
external monitor 2–17
monitor 2–17
product description 1–5
serial 2–13
USB 2–13, 2–14, 2–15, 2–16

power button 2–6, 2–7
power button board

removal 4–35
spare part numbers 3–5, 3–29, 3–36, 4–35

power connector 2–17
power cord

set requirements 10–1
spare part numbers 3–24, 3–25

power light 2–8, 2–10, 2–12
power requirements, product description 1–5
processor

product description 1–1
removal 4–43
spare part numbers 3–10, 3–11, 3–27, 3–36, 3–39, 

3–40, 4–43
product description

audio 1–3
chipset 1–1
display panel 1–2
docking 1–5
Ethernet 1–4
external media card 1–4
graphics 1–2
hard drive 1–3
keyboard 1–5
mass storage device 1–3
memory 1–3
microphone 1–3
modem 1–4
operating system 1–6
pointing device 1–5
ports 1–5
power requirements 1–5
processor 1–1
security 1–5
serviceability 1–7
webcam 1–4
wireless 1–4

product name 3–1, 4–5
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Q
QuickLook button 2–6, 2–7
QuickLook light 2–9, 2–11
QuickWeb button 2–6, 2–8
QuickWeb light 2–9, 2–11

R
recovery, system 8–1
recycling

battery 11–1
display components 11–1

removal/replacement
preliminaries 4–1
procedures 4–5

right-side components 2–13
RJ-11 jack

connector pinout 9–3
location 2–14, 2–17

RJ-45 jack
connector pinout 9–3
location 2–17

RTC battery
removal 4–32
spare part numbers 3–11, 3–25, 3–30, 4–32

Rubber Kit, spare part number 3–14, 3–30, 4–6

S
Screw Kit, spare part number 3–24, 3–30
screw listing 7–1
security cable slot 2–14, 2–17
Security menu 5–4, 5–10, 5–16
security, product description 1–5
serial connector

removal 4–78
spare part numbers 3–13, 3–29, 3–37, 4–78

serial port
connector pinout 9–4
location 2–13

service considerations 4–1
serviceability, product description 1–7
SIM slot 2–18
SIM, removal 4–8
Smart Card Reader

location 2–16
removal 4–62
spare part number 3–12, 3–36, 4–62

solid-state drive
removal 4–11
spare part numbers 3–14, 3–22, 3–29, 3–39, 4–11

speaker assembly
removal 4–68
spare part numbers 3–12, 3–30, 4–68

speakers 2–12

specifications
Blu-ray ROM DVD±RW SuperMulti Double-Layer 

Drive 6–4
computer 6–1
display assembly 6–3
DVD±RW and CD-RW SuperMulti Double-Layer 

Drive 6–5
DVD-ROM Drive 6–6
hard drive 6–4
optical drive 6–4, 6–5, 6–6
system DMA 6–7
system I/O address 6–9
system interrupt 6–8
system memory map 6–7

switch cover
removal 4–33
spare part numbers 3–5, 3–29, 3–37, 4–33

system board
removal 4–74
spare part numbers 3–13, 3–29, 3–36, 3–40, 4–74

System Configuration menu 5–5, 5–11, 5–17
system DMA specifications 6–7
system I/O address specifications 6–9
system interrupt specifications 6–8
system memory map specifications 6–7
system recovery 8–1

T
tools required 4–1
top cover

removal 4–59
spare part numbers 3–12, 3–29, 3–37, 4–59

TouchPad
location 2–5
removal 4–38
spare part numbers 3–11, 3–29, 3–37, 4–38

TouchPad board cable, illustrated 3–18
TouchPad buttons 2–5
TouchPad scroll zone 2–5

U
Universal Serial Bus (USB) port

connector pinout 9–4
location 2–13, 2–14, 2–15, 2–16

Upgrade bay 2–13, 2–14

V
vents 2–15, 2–16, 2–18
volume down button 2–7, 2–8
volume down light 2–9, 2–11
volume mute button 2–6, 2–8
volume mute light 2–9, 2–11
volume up button 2–7, 2–8
volume up light 2–9, 2–11
Maintenance and Service Guide Index–5



Index
W
warranty period 3–1, 4–5
webcam

location 2–2
product description 1–4

webcam cable, illustrated 3–20
webcam light 2–2, 2–12
webcam module

illustrated 3–20
removal 4–51
spare part number 3–20, 3–28, 4–51

Windows applications key 2–3, 2–4
Windows logo key 2–3, 2–4
wireless antennas

disconnecting 4–19, 4–21
illustrated 3–20
locations 2–2
removal 4–56, 4–57

wireless button 2–6, 2–8
wireless light 2–8, 2–10, 2–12
wireless module compartment 2–18
wireless module compartment cover

illustrated 3–23
removal 4–19

wireless, product description 1–4
WLAN module

removal 4–16
spare part numbers 3–15, 3–16, 3–17, 3–25, 3–26, 

4–16, 4–17, 4–18
workstation guidelines 4–4
WWAN module

removal 4–21
spare part number 3–15, 3–26, 4–21
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